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Tutorial: Maintaining an ILE COBOL application: Introducing a
new level of server tool integration for iSeries application
development

About the tutorial

This tutorial through a series of exercises, checkpoints and practices, introduces you to a new level
of tool integration for iSeries application development. The iSeries server development capabilities of
the new integrated development environment (IDE) provides many compelling reasons for you to
upgrade from Application Development Toolset (ADTS) or CoOperative Development Environment
(CODE).

The IDE reduces the learning curve by providing a consistent interface for developing server
applications and e-business applications. This allows you to progress to new levels of application
development. The IDE delivers on the promise of tool integration with best-of-breed tools from IBM
and several partners to support the end-to-end application development life cycle.

The IDE also includes a robust, easy-to-use development environment for creating, building and
maintaining iSeries RPG, COBOL, C, C++ applications, and Web-enabled applications using the
IBM WebFacing Tool.

In this tutorial you will follow the typical iSeries application development life cycle tasks using a
payroll application written in COBOL. You will work through a series of exercises that will teach you
what the new tools are and how to use them.

By the end of this tutorial you will be able to realize significant productivity and usability gains in your
iSeries server application development and be on your way to increasing your skills to make the
transition into new programming models such as Java, Web, Web Services, and XML.

Completing this tutorial should take you about 2 hours.

Work on the exercises in sequence. The pictures in the exercises show similar tasks. Some of the
names and icons may be different from the environment you will be working with when you complete
the exercises.

Following each exercise it is recommended that you take the checkpoint quiz. Taking each quiz will
help you to determine if you have mastered the exercise content and are ready to move on to the
next exercise. The quiz answers are included at the end of this tutorial so you can check your
answers.

Following each exercise checkpoint is a practice section. This section gives you the opportunity to
apply what you have learned in the exercise. Often you will complete different but similar tasks to
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what you have just learned in the exercise. The Development Studio Client for iSeries online help
can assist you in completing the practice tasks.

The tutorial is available in PDF format. You can view the PDF version from the IBM WebSphere
Development Studio Client for iSeries product Web site (ibm.com/software/adwtools/iseries).

Tutorial business problem

You are an iSeries COBOL application developer but you are familiar with basic Microsoft Windows
operations such as working with the desktop and basic mouse operations such as opening folders
and performing drag-and-drop operations. You are currently using the iSeries Application
Development Tools (ADTS) products (PDM, SEU, SDA) or CoOperative Development Environment
(CODE). ADTS has been the traditional method for developing and maintaining server-side iSeries
applications. But now there is a new set of highly integrated and highly extendible tools for iSeries
RPG, COBOL, C, C++, CL and DDS development. These new tools offer you a development
experience that is consistent with the experience for developing Java, Web, Web Services, and XML
applications. The new tools also allow you to leverage the classic CODE tools for extremely rich
editing and DDS design support. These new generation tools offer rich support for exploring the file
system, compiling/building, editing, running, and debugging. They offer significant productivity and
usability gains, support for disconnected and team development, and a common harness for the tight
integration of IBM and partner-supplied tools for server development.

You know this is the place you and your company want to be especially as you both transition to
delivering iSeries applications through the Web. Your first step in modernizing your iSeries
applications is to move to the next generation of iSeries server application development tools. Here
is what you and your company know about these next generation tools.

The first server application development tool is the Remote System Explorer which has its own tools
and views. Remote System Explorer is similar to Programming Development Manager (PDM) in that
it allows you to drill down to the QSYS file system, or use filters to list specific objects within the
QSYS file system.

The Remote Systems Explorer goes well beyond PDM however! It also allows you to explore iSeries
jobs and commands, and the IFS file system. Further, you can also use it to explore the file system
of remote Linux, UNIX and Windows systems.

The Remote System view is the primary drill-down view, similar to PDM. Double-click a member and
you open the Remote Systems LPEX Editor, built right into the IDE and with rich editing functions.
This editor goes well beyond SEU'’s function; it is a superset of SEU! and is getting close to all of the
CODE Editor’s functions. The syntax checker is ported down from SEU, the compilers are imbedded
for verifying errors and the reference manuals are built-in and F1 cursor sensitive. You can see the
program hierarchy in the Outline view. The content assist is a popular feature. There is explicit and
rich iSeries specific support for not only edit, but verify, compile, run and debug of RPG, COBOL, C,
C++, CL and DDS not just from the Remote Systems LPEX Editor but also from the IDE in your very
own Remote System Explorer perspective; the place for views and tools specific for iSeries server
application development.
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Instead of the Remote Systems view which is a tree view, PDM users are use to a table, so there is
an iSeries Table view that shows what the tree shows but in table format. You can sort the columns
when you click on a column heading. The contents of the table are easily replaced when you click on
a file in the Remote Systems view. There are right-click actions that are the same as PDM'’s and a
command line at the bottom of the table just like PDM.

There is no built-in tool for display file and printer file development yet, but you can easily launch the
CODE Designer from the Remote Systems view.

COBOL program debug is easy from the Remote System Explorer interactive debug perspective.
Through this perspective you can debug Java, OPM/ILE, RPG, COBOL, CL, ILE C and C++
programs.

With this information in hand you are ready to move on.

Before you begin
Before you begin, you must install the following:

On iSeries:

¢ 0S/400 Version 5 Release 1 or later. The Remote System Explorer component will need
additional PTFs. The PTF information is available at ibm.com/software/adwtools/iseries.
08S/400 is needed since this tutorial includes programming objects located on the iSeries
server and the applications contain backend code on the iSeries server.

* IBM WebSphere Development Studio for iSeries (5722-WDS)

« IBM WebSphere Development Studio for iSeries requires V5R2M0 0S/400 (5722-SS1)

* RSELAB savf restored on iSeries

* iSeries system servers started with the command STRHOSTSVR *ALL and STRTCPSVR
*DDM.

On the workstation for iSeries server application development:
¢ Intel Pentium Il processor
e 256 MB RAM minimum
« Required hard drive space: 1650 MB
» Additional 700MB of temporary hard drive space is needed during product installation
¢ Windows: VGA graphics card (800 x 600, or higher, recommended, 256 colors)
+ CD-ROM/DVD drive

¢ Mouse or pointing device
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Software
* IBM WebSphere Development Studio Client for iSeries, Version 5.1
¢ Any available PTFs. The PTF information is available at ibm.com/software/adwtools/iseries
» eNetwork Personal Communications Version 5.5 or later
e TCP/IP access to an iSeries system.
«  Windows 2000 Professional, SP2, or higher
*  Microsoft Internet Explorer 5.5, SP1, or higher

To use the library for this tutorial, you must restore it to your iSeries.

On your iSeries, create a save file:
CRTSAVF <library_name>/RSELAB

On your workstation, open a Command Prompt window and go to the directory where
you downloaded the save file and do the following:

ftp <iSeries_name>

<user_name>

<password>

binary

put rselab.sav <library_name>/RSELAB
quit

On your iSeries, restore the RSELAB library:
RSTLIB SAVLIB(RSELAB) DEV(*SAVF) SAVF(<library_name>/RSELAB)

Once you have restored the library, you can delete the save file <library_name>/RSELAB.

Conventions that are used in this tutorial

This tutorial uses typographical conventions in the text to help you distinguish between the names of
controls and text that you type. For example:

* Menu items are in boldface font:
Click Menu = Menu choice

« The names of fields, check boxes, and buttons are also in boldface font:
Type text in the Field field.

» Text that you type is in example font on a new line:

This is the text that you type.
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Related information

This tutorial covers the most common tasks that you can accomplish with the Remote System
Explorer. For more information about related tasks, see the following documents:
WebSphere Development Studio Client for iSeries
* Maintaining and Developing iSeries applications online help
* Remote System Explorer presentation on the Library page
(ibm.com/software/adwtools/iseries)
» Remote System Explorer demo on the Library page (ibm.com/software/adwtools/iseries)
» iSeries Application Development Quick Tour on the Library page
(ibm.com/software/adwtools/iseries)
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Exercise 1: Introducing to WebSphere Development Studio and Remote
System Explorer

In this exercise you are introduced to the IBM WebSphere Development Studio for iSeries
(Development Studio) product and its relationship to IBM WebSphere Development Studio Client for
iSeries. You learn which product makes up the host components and which product makes up the
workstation components. You recognize the server application development tools included with
Development Studio Client for iSeries programmers. You then are introduced to Remote System
Explorer the launching point for iSeries server application development tools.

At the end of the exercise, you should be able to:

e Describe the Development Studio product

» Describe the Development Studio Client product

» Describe how Development Studio Client fits into the WebSphere Studio family of products
» Explain the tools available to iSeries programmers for iSeries application development

Let’s get started by first looking at what makes up the Development Studio and Development Studio
Client products.

Development Studio and Development Studio Client

With Development Studio Client, you can quickly develop and deploy traditional and e-business
applications for your iSeries system. You receive unlimited licenses of this powerful suite of tools
when you use Development Studio for your host development. The following diagram illustrates the
interaction between host and client tools:

WebSphere Development Studio

CIC++ COBOL RPG ADTS

WebSphere Development Studio Client

System iSeries Web Tools
Explorer Projects for iSeries
IBM Classic tools
pava Toows WebFacing (CODE and
risenes Tool VisualAge RPG)

©Copyright IBM Corporation 2003
Course material may not be reproduced in whole or in part
without the prior consent of IBM



Page 8 of 162

Development Studio Client is designed to help you:

1.
2.

3.
4.

Develop and maintain iSeries applications using the Remote System Explorer

Develop Web GUIs for iSeries classic applications using the IBM WebFacing Tool and other
Web Tools

Develop client and server applications for iSeries using Java Tools

Work with other Integrated Site Developer Tools (XML, Web Services, SQL, Relational
Databases)

Now, You know Development Studio Client makes up the workstation tools while Development
Studio makes up the host tools. But there’s more. WebSphere Studio is IBM's solution for
application and Web development. Both versions of our product come with an additional base
WebSphere Studio product.

* IBM WebSphere Development Studio Client for iSeries includes WebSphere Studio Site
Developer. Site Developer includes support for Web services, XML development tools, and
core support for Java and Web development tools.

. IBM WebSphere Development Studio Client Advanced Edition for iSeries includes
WebSphere Studio Application Developer. This base product provides end-to-end support
for the creation and maintenance of J2EE applications and Web services. It also provides
extensive support for Enterprise Java Beans, and for Java Messaging services.

And if you happen to have other WebSphere products installed you can also install either edition of
the product on top of WebSphere Studio Application Developer - Integration Edition or WebSphere
Studio Enterprise Developer. The following diagram illustrates how this product fits into the
WebSphere Studio family of products:
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WebSphere Development Studio Client for iSeries
Remote
Explorer | r es
1BM Classic tools
aava Toos WebFacing (CODE and
res Tool VisualAge RPG)
Advanced Edition i |
WebSphere WebSphera WebSphere Studio WebSphere
Studio Site Studio Application Application Developer Studio Enterprise
Devealoper Developer Integration Edition Developer

iSeries Server Application Development Tools

Now, you know what the two flavors are of Development Studio Client and why you would want to
use each one. Next let’s look at those next generation iSeries server application development tools
mentioned at the beginning of this tutorial. Just what are they and what do they do.

Remote System Explorer

You can manage your development-cycle tasks in the Remote System Explorer. This is an
enhanced and more flexible workstation version of Program Development Manager (PDM). You can
create and manage development projects on your iSeries system from your Windows-based
workstation with the Remote System Explorer and iSeries projects. With these tools, you can
connect to an iSeries remote host, view iSeries libraries, files, and members. You can also launch
the host compilers, the workstation editor, a program verifier and various debuggers all from the
Remote System Explorer. This tool also supports other system types, such as UNIX®, Linux, and
Windows.

LPEX Editor

Your program editing tasks are simplified with the Remote Systems LPEX Editor. This is a powerful
language-sensitive editor that you can customize. Token highlighting of source makes the various
program elements stand out. It has SEU-like specification prompts for COBOL and DDS to help
enter column-sensitive fields. Local syntax checking and semantic verification for your RPG, COBOL
and DDS source makes sure it will compile cleanly on an iSeries system. If there are verification
errors, an Error List lets you locate and resolve problems quickly. On-line programming guides,
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language references, and context-sensitive help make finding the information you need just a
keystroke away.

Shells and Commands in the Remote Command view
You can use the Remote Commands view to run and interact with commands and command shells
on universal systems. A universal system includes Windows, Linux, and UNIX system types.
Specifically, use the view to:
* Run commands in a command shell
» Display and interpret the output of a program
* Enter input to a program
» Display and manage different commands and shells from the same view. Multiple commands
can be run in a single shell (one command at a time per shell), multiple shells may be run on
a single system, and multiple systems may be running shells.
Whenever a command shell is launched or a command is run from the Remote System Explorer, the
Remote Commands view displays the output and provides a way to work with that output.

Program Verifier

One of the most powerful and unique features of the Remote System Explorer is the Program
Verifier. Before you compile your code on an iSeries system, you can ensure that there are no errors
by invoking the Program Verifier. The verifier checks for semantic (compile) errors on your
workstation so that you can guarantee a clean compile on the iSeries. Think of the host cycles you'll
save. It is especially handy when you are writing code but you are disconnected from an iSeries
system. You can do this because Remote System Explorer ported the parsing and checking code
from the iSeries host compilers to the workstation. The Error List window lists the errors that are
found and their severity, inserts the error messages directly into the source and helps you to
navigate between the errors.

CODE Designer

Using an editor to create and maintain DDS source for your display and printer files can be a
frustrating and difficult task. What would be great is a graphical design tool that lets you design your
screens and reports visually and then generate the DDS source for you. Well, that’s exactly what
the CODE Designer does for you.

The CODE Designer interface was designed to help the novice DDS programmer create screens,
reports and databases quickly and easily without worrying about the details of the DDS language,
while at the same time letting the expert DDS programmer get access to all the features and power
of the language. CODE Designer is not fully integrated into the workbench yet, but you can launch it
as a separate tool from the workbench.

iSeries Debugger

With the integrated iSeries debugger you can debug an application that is running on an iSeries
system. It provides an interactive graphical interface that makes it easy to debug and test your
iSeries programs. It is fully integrated into the workbench. You can also set breakpoints before
running the debugger, by inserting breakpoints directly in your source while editing. The integrated
iSeries debugger client user interface also enables you to control program execution. For example,
you can run your program, set line, watch, and service entry point breakpoints, step through program
instructions, examine variables, and examine the call stack. You can also debug multiple
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applications, which may be written in different languages, from a single debug window. Each session
you debug is listed separately in the Debug view.

In this tutorial you are going to learn some of the basic features and functions of each of the
workbench tools. We are confident that Development Studio Client will save you lots of time and
effort in your day-to-day programming tasks. It will make you a more efficient and effective
programmer. At the same time, it will save cycles on your iSeries and better yet it will get you ready
for the next step and that is moving your iSeries applications to the Web.

So, let’s get started! Complete the checkpoint below to determine if you are ready to move on to the
next exercise.

Checkpoint

1. WebSphere Development Studio for iSeries:
A. Includes all four host compilers and all traditional tools (ADTS)
. Includes all four host compilers, all traditional tools (ADTS) and unlimited licenses of the
workstation-based tools named Development Studio Client
. Includes only the workstation-based tools named Development Studio Client
. Includes only the four host compilers
2. WebSphere Development Studio Client for iSeries Version 5 includes:
A. WebSphere Studio Site Developer Version 5 for e-business development
B. Cooperative development environment (CODE)
C. VisualAge RPG
D. Java tools
E. Web tools
F. WebFacing tool
G. All of the above
3. WebSphere Development Studio Client for iSeries Advanced Version 5 includes:
A
B
C
D
E
F.
G.

B
C
D

. WebSphere Studio Application Developer Version 5 for e-business development
. Cooperative development environment (CODE)
. VisualAge RPG
. Java tools
. Web Tools
WebFacing Tool
All of the above
4. WebSphere Studio Application Developer includes support for:
A. Creation and maintenance of J2EE applications
B. Creation and maintenance of Web services
C. Enterprise Java Beans
D. Java Messaging Services
E. All of the above
5. WebSphere Studio Site Developer includes support for:
A. Web services
B. XML development tools
C. Java tools
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10.

11.

12.

13.

D. Web tools

E. All of the above
You can manage your development-cycle tasks in:

A. The Remote System Explorer

B. iSeries Projects

C. The IBM WebFacing tool

D. All of the above
With the Remote System Explorer and iSeries Projects you can view iSeries libraries, files and
members. You can also launch the host compilers, the workstation editor, and various
debuggers. (T, F)
Your program editing tasks are simplified with the:

A. The Remote System Explorer

B. iSeries Projects

C. The IBM WebFacing tool

D. The LPEX Editor

E. All of the above
The editor can access source files on your workstation or on your iSeries system directly. When
a compilation results in errors, you can jump from the compiler messages to an editor containing
the source. The editor opens with the cursor positioned at the offending source statements so
that you can correct them. (T, F)
You can debug your program running on the iSeries system from your workstation using:
The Remote System Explorer
iSeries Projects
The IBM WebFacing tool
The LPEX Editor
The Integrated iSeries Debugger
. All of the above
The graphical design tool that lets you design your screens and reports visually and then
generates DDS source for you is:

A. The Remote System Explorer

B. CODE Designer

C. The IBM WebFacing tool

D. The LPEX Editor

E. The Integrated iSeries Debugger
Before you compile your code on an iSeries system, you can ensure that there are no errors by
invoking the:

A. The Remote System Explorer

B. CODE Designer

C. The IBM WebFacing tool

D

E

Tmoow>

. The LPEX Editor
. The Integrated iSeries Debugger
F. Program Verifier

You can use the Remote Commands view to:
Run commands in a command shell
Display and interpret the output of a program
Enter input to a program
Display and manage different commands and shells from the same view

Cow>
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E. All of the above
14. The integrated iSeries Debugger enables you to run your program, set line, watch, and service
entry point breakpoints, step through program instructions, examine variables, and examine the
call stack. (T, F)

15. If the Advanced Version of the product is not installed on your workstation then you will not see
the word Advanced in the Start menu. (T, F)

What you just did

In this exercise you were introduced to Development Studio and Development Studio Client and how
Development Studio Client fits in the WebSphere Studio family of products, the difference between
Development Studio Client and Development Studio Client Advanced and what iSeries server
application development tools the Development Studio Client workbench provides.

In the next exercise you will start Development Studio Client and open the Remote System Explorer.
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Exercise 2: Starting Development Studio Client and Opening the Remote
System Explorer

In this exercise you are introduced to workbench, the workspace, a perspective and specifically the
Remote System Explorer perspective. You then learn how to start Development Studio Client and
how to open the Remote System Explorer perspective.

At the end of the exercise, you should be able to:

» Explain workspace, workbench and perspectives

» Describe the Remote System Explorer perspective
« Start Development Studio Client

* Open the Remote System Explorer perspective

First let’s start Development Studio Client.

Starting Development Studio
To start Development Studio Client:

1. Click Start on the task bar of your desktop
2. Select Programs-> IBM WebSphere Studio -> Development Studio Client Advanced Edition
for iSeries 5.1

@ Developre

8 Development Studio Client Advanced Edition For iSeties 5,1

Note: If the Advanced Edition Version of the product is not installed on your workstation then you

will not see the word Advanced Edition in the Start menu

A window may appear. Here you specify the name of the workspace where your projects and other
resources such as folders, subfolders and files that you are developing in the workbench will reside.

WebSphere Studio x|

YWiebSphere Studio stares pour wark, in a directon called a workspace. You can change the workzpace each time
woul stark WebSphere Studio. Specity the directory bo uge for this session;

IE:'&DDcuments and Settingzhchng] meikdy Dn:nc:uments"-.IBM'xwds Browse. .. |

[ Use thiz workspace az the default and dao not show this dialog box again
k. I Cancel |

Figure 1: WebSphere Studio window for specifying workspace directory name
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3. (Optional) Change the field in this window and use a unique directory name, for example,
rselabXX (where XX is your unique number). If you use 01 use directory name rselab01 as
shown in Figure 1.

4. Click OK. After a few moments of loading, the workbench appears

# Remote System Explorer - Welcome - WebSphere Development Studio Client Advanced Ediki - |E||l|
File Edit Navigatd Search Project Runm  MWindow Help
|S-BEe\a|%-%-%-[ 7] -
h 1

iz A remoke System\ - X x ] 2= Outline *®
|| & \ = &~ | Development Studio Client Advanc...

=l Mew Connection | B0 outline is not

iSeries TThis page tells yvou what you should know before you start developing applications wit—] Evailable.

P — ,J o Development Studio Client Advanced Edition For iSeries. To get started, read the secti

B4 Windows,., and click on the related links,

_ 3 Get started

| B Local.., Tao know what ta do first, consulk the Product Overview, You should also look at —
E Local the infarmation map in the online help to decide how you can most effectively

skart using the product,

3 Develop iSeries applications
¥ou can create and maintain RPG and COBOL applications with the powerful work:
Learn more about the Remate System Explorer and its built-in editing and compilin

Remote System Explorer
To navigate through vour iSeries objects, use the power of the Remote System—EILI
.4

1 |

] Root Conmections 2% Q§.§ | v X
Mame I Parert profile I Remote sys. ., I Connection. .. I Host name I Default Use. .. I De
E Local Private Local Some subs,..  LOCALHOST msteckh?tp...
Remate Systems | Team
5] Propetties v X
B 5
Propert: | Yalue
arne Mew Connection
Murber ... S 1| | 3
Type An expandable pr...

Remote Systemn Details JTasks |iSeries Table Yiew |i5eries Commands Log

Figure 2: Workbench with Remote System Explorer

The workbench refers to the desktop development environment. The workbench aims to achieve
seamless tool integration and controlled openness by providing a common paradigm for the creation,
management, and navigation of workbench resources. Each workbench window contains one or
more perspectives.

Open Remote System Explorer perspective
1. Check for the name of the perspective, the arrow in Figure 2 indicates where to look for the

perspective name.

©Copyright IBM Corporation 2003
Course material may not be reproduced in whole or in part
without the prior consent of IBM



Page 17 of 162

A perspective defines the initial set and layout of views in the Workbench window. Within the
window, each perspective shares the same set of editors. Each perspective provides a set of
capabilities aimed at accomplishing a specific type of task or working with specific types of
resources. For example, the Java perspective combines views that you would commonly use while
editing Java source files, while the Debug perspective contains views that you would use while
debugging Java programs. Perspectives contain views and editors and control what appears in
certain menus and tool bars.

If you see a different perspective, not the Remote System Explorer open in the workbench or no
perspective:

2. Select Window from the workbench Menu bar

3. Select Open Perspective

4. Select Remote System Explorer

You work in the Remote System Explorer perspective in the workbench. This perspective is for an
iSeries programmer to display the connections that you have already configured, create a new
connection, connect to and disconnect from the connections that you have defined, work with iSeries
files, commands, jobs, and integrated file system files. This perspective will be active when you start
Development Studio Client with a new workspace. If you had used the workspace before then, the
workbench would come up with the perspective that you last opened. You will learn more about the
Remote System Explorer perspective in the coming exercises as this is where you launch the iSeries
programmer tools and views from the workbench.

Complete the checkpoint below to determine if you are ready to move on to the next exercise.

Checkpoint

1. A workspace:

A. Aims to achieve seamless tool integration and controlled openness by providing a
common paradigm for the creation, management, and navigation of workbench
resources.

Defines the initial set and layout of views in the Workbench window.

Refers to the desktop development environment.

Specifies where your projects and other resources such as folders, subfolders and files
that you are developing in the workbench will reside.

2. A workbench:

A. Aims to achieve seamless tool integration and controlled openness by providing a
common paradigm for the creation, management, and navigation of workbench
resources.

Defines the initial set and layout of views in the Workbench window.

Refers to the desktop development environment.

Specifies where your projects and other resources such as folders, subfolders and files
that you are developing in the workbench will reside.

E. AandC
3. A perspective:

Cow

cow
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A. Aims to achieve seamless tool integration and controlled openness by providing a
common paradigm for the creation, management, and navigation of workbench
resources.

Defines the initial set and layout of views in the Workbench window.

Refers to the desktop development environment.

Specifies where your projects and other resources such as folders, subfolders and files
that you are developing in the workbench will reside.

4. Match the perspective with its correct definition.

Combines views that you would commonly use while editing Java source files
Contains views that you would use while debugging Java programs

Contains views that you would use while developing Web applications

Contains views that you would use while maintaining iSeries applications.

ocow

Java perspective

Web perspective

Remote System Explorer perspective

Debug perspective

5. In the Remote System Explorer perspective you can:
Display configured connections

Create a new connection

Connect and disconnect defined connections
Work with iSeries files, commands, jobs, IFS files
All of the above

Cow>» UOW>

moow»

Practice

Given your experience in opening the Remote Systems Explorer perspective, open the Web
perspective. Explore the tools and views available to the Web developer. Next open the Java
perspective. Explore the tools and views available to the Java developer. Now since you are
supposedly in the Java perspective, open the Web perspective. Be careful not to open another Web
perspective.

Tip: Look in the workbench left-frame for the Web perspective icon. Now close both the Java
perspective and the Web perspective.

What you just did

In this exercise you were introduced to workbench, the workspace, a perspective and specifically the
Remote System Explorer perspective. You then learned how to start Development Studio Client and
how to open the Remote System Explorer perspective.

In the next exercise you will configure a connection to an iSeries system and then connect to your
iSeries system.
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Exercise 3: Configure a connection to an iSeries system and Connect to
your iSeries

In this exercise you create a connection to an iSeries server and select objects using the Remote
System Explorer perspective. You will learn the steps to create a connection. You will then learn
how to find a library in your library list. Finally you open a member in the Remote Systems LPEX
Editor. You also learn about several views such as the Remote Systems view, iSeries Table view,
and the Outline view.

At the end of the exercise, you should be able to:

» Explain the Remote Systems view

» Configure a connection to an iSeries system

* Connect to an iSeries system

» Describe what you need to set up a connection

» Describe a profile

* Find an object in the Remote System Explorer perspective

» Explain subsystems

* View and access objects

» Explain the Outline view

« Explain iSeries Table View

» Explain the difference between the iSeries Table View and the Remote Systems view
» Show source physical file members in an iSeries Table view
» Lock and unlock the iSeries Table view

* Open a second source member

* View the outline of a file

Configuring a connection to an iSeries system

When you first open the Remote System Explorer, you are not connected to any system except your
local hard drive on your workstation. To connect to a remote iSeries system, you need to define a
connection. When you define a connection, you specify the name or IP address of the remote
system and you give your connection a unique name that acts as a label in your workspace so that
you can easily connect and disconnect. When you connect to the iSeries system, the workbench
prompts you for your user ID and password on that host.

The first time you connect to an iSeries system, you need to define a profile. All connections, filters,
and filter pools belong to profiles. We will describe filters in a later exercise. We will discuss profiles
when you create your first connection.

Ok, let’s get started. Remember you have already opened the Remote System Explorer perspective
in the previous exercise.
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tﬁ' Remote System Explorer - Welcome

File Edit Mawigate Search Project RL

|8 -BES| B3 - %
E ,!.@Remnte Syskems * X
|| & & B

E|=§ Mew Caonnection

% iSeries. ..
- Windows. ..
.f_'} Lirz, ..

--Unix Unix...
- Local...

EEI---E, Local

Remoke Svystems I Team

Figure 3: Configure a connection

Switch to the Remote System Explorer perspective.

In the Remote Systems view, New Connection is automatically expanded to show the various
remote systems types you can connect to through the Remote System Explorer.

Expand iSeries to configure a connection to an iSeries system

N -~

The Name personal profile page of the New Connection wizard appears:
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x

Mame personal profile

niguely name user profile

Welcome ko Remoke Systems, Conneckions can be sharable by the keam or private to
wal, Enker a prafile name ko uniquely identify wou Fram your beanm members, Yo will
decide far each new conneckion whether it is owned by the team profile or your
profile.

Prafile: I “nsteckh7tp

= Back I Mexk = I FEimist Zancel

Figure 4: New — Name personal profile page
On this page of the New connection wizard and since it is the first time you connect to an iSeries
system, you need to define a profile. All connections, filters, and filter pools belong to profiles.
Profiles offer a way to group connections, share connections, or keep them private, and they help
you partition data if you have a lot of connections or filter pools. Your first profile will be for your local
workstation. This is your personal profile. You use this profile as you want to keep your connection
private. You do not want to share resources and information with other people.
3. Leave the Profile information as is. Click Next

The Remote iSeries System Connection page of the New connection wizard shows:

©Copyright IBM Corporation 2003
Course material may not be reproduced in whole or in part
without the prior consent of IBM



Page 22 of 162

x

Remote iSeries System Connection

Define connection infarmation !

Parent praofile: Imsteckh?tp j

Connection name:

De=scription: I

¥ Yerify hosk name

Hosk name:

< Back | Mexk = | Einish I Zancel

Figure 5: The Define connection information page

On this second page you specify the information for your connection. The cursor on this page is

positioned in the Host Name field.

4. Enter the name of your host system in the Host name field
The Connection name is automatically filled with the host name. Leave it this way. This name
displays in your Remote Systems view and must be unique to the profile.

5. Leave the Parent profile as is. You don’t need to change it. As the files will be kept private the
parent profile defaults to the default profile shown on the previous page of the wizard. If you
were sharing resources you would select a team profile that you would have created earlier.

6. Leave the Verify host name check box checked

Click Finish to define your system.
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Connecting to your iSeries system
After you configure a connection to an iSeries system, you can easily connect and expand your new
connection to reveal your subsystems. Subsystems are a function grouping of the various types of
remote resources that can be explored in the remote system. There are four subsystems:

» iSeries Objects is a PDM-like group, allowing access to libraries, objects and members

» iSeries Commands allow you to predefine command sets each of which contain one or more
often used commands. When run, all commands in a command set are sent to the remote
system and executed, and the results are logged in the Commands view

» iSeries Jobs allow you to see various jobs, subset by job attributes, and to perform a limited
number of operations on those jobs.

» IFS Files allow you to explore folders and files in the Integrated File System of the remote

iSeries system

# Remote System Explorer - Welcom

File Edit Mavigate Search Project  Ri
RERIE-AE.
w

B
=% Mew Connection |-
EI% iSeries, .,
. Ll Connection create
A5 windows,
Q Linuz, .
Unix Unix,,.
+-B Local,..
EEI---E Local
-y s400a
BB ¥ i=ries Chiects
: _'ﬁ{> Work, with libraries
}:? Work with objects,
}:? Work with member
€T areLibrary list
#-giis User libraries
&% iSeries Commands
g iSeries Jobs

[ T IFS Files hd
4 3

Remoke Systems I Team

Figure 6: Remote Systems view with iSeries connection
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To connect to an iSeries system:

1.

x

In the Remote Systems view, your new connection is expanded to reveal your subsystems. The
iSeries Objects subsystem is the subsystem you will use most often! It is very similar to PDM, in
that it allows you to access objects in the QSYS file system, and perform actions on those
objects.

Notice the first three entries under the iSeries Objects subsystem are named after the PDM
options, because they have similar capabilities:
*  Work with libraries (similar to WRKLIBPDM)

*  Work with objects (similar to WRKOBJPDM)
*  Work with members (similar to WRKMBRPDM)

In addition there are entries for working with library lists and user libraries:
» Library list (to simulate PDMs STRPDM option 12 you can start with the pre-defined Library

list filter, that when expanded lists all libraries in your library list.)
* User libraries

You also have more entries to work with under the connection itself and you can see from these
entries that Remote System Explorer goes well beyond PDM! It allows you to explore iSeries
jobs and commands and the IFS file system.

Now let’s work with a library in our library list.

Click the plus sign beside Library list.

Now the connection will be activated and you will be prompted for a user ID and password.

System bype: I iSeries

Hosk name: I TORASOFM

Iser ID: L widsclabin

Figure 7: Enter password window

4. Enter your user ID and password.

©Copyright IBM Corporation 2003
Course material may not be reproduced in whole or in part
without the prior consent of IBM



Page 25 of 162

5. Check the check box Permanently change user ID
6. Check the check box Save password
7. Click OK.

Make sure that your user ID has been setup, so that your library has been added to the library list
automatically. You can use the properties of iSeries Commands to set connection information such
as adding a library to a library list.

Note: if you do not see RSELABXxx in your library list you can right click on the Library list and use
the Library List Entry window to add RSELABXxx to your library list.

Back in the workbench in the Remote System Explorer perspective you will see the libraries in your
job’s library list.

tﬁv Remote System Explorer - Welcome - WebSp

Eile Edit Mawigate Search Project Run  window

5 -HE85[ 0] % -%-
EE Remaote S w X
|| e® EXs
- #-E Local.., -
E, Local _I
-l 54003
EIED iSeries Objects

_'ﬁ€> Whark, with libraries, ..

:%:? Work, with objects, ..

:%:? Work, with members, .,

EIW Library list

i]':., 055, ¥ib.prod-sys

i]':., 0552 b, prod-sys

&l QHLPSYS, Mlib.prod-sys
=i, QUSRSYS.*ib.prod-sys
G RIELABLD. *ib.test-cur
-y, RSELAB10,*iib, kest-usr
H-Jl YARLAB1D.*ib test-usr
-y, WFLABLD, *ib, test-usy

-, WSSLAB 10, *libkest-usr
-2 User IiI:uraIries _ILI

1

Remoke Systems I Team

Figure 8: Remote Systems view with libraries in library list
Notice that the s400a node now has a small green arrow in the icon to indicate it is an active
connection.

Also your RSELABXxx library should have a small green star that indicates it is the current library.
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For each library, you can right-click and select from a number of actions. There is an action to create
a new source file within the selected library, to refresh the contents of the library if it is expanded, to

rename the library, copy the library or delete the library.

Viewing and accessing objects in the Remote System Explorer perspective
Now you are ready to view and access objects in your current library RSELABxx.

To view an object:

1. Expand library RSELABXX.

You will see all objects in this library appear in the Remote Systems view. For each object you can
right-click and select from a number of actions also. The list of actions depends on the object
selected and whether you selected one or multiple objects. For a source file the pop-up menu has
an action to create a new member within the selected file, to refresh the contents of a file if it is
expanded, to rename the file, copy the file and delete the file. These actions remotely run the

appropriate iSeries command and you will see it logged in the Commands view.

2. Drill-down through the files in the Remote Systems view until you find QCBLLESRC source file
and then expand it.
3. Drill-down through the files in QCBLLESRC until you find QDDSSRC source file and expand it as

well.
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Figure 9: Remote Systems view with expanded source files

Now you can see and access the members in these two source files. For each member you can
right-click and select from a number of actions. The exact list of actions depends on whether the
member is a data file or source file and whether you select one or multiple members. For a member,
the popup menu actions are edit, rename, copy, move, delete, and compile.

©Copyright IBM Corporation 2003
Course material may not be reproduced in whole or in part
without the prior consent of IBM



Page 28 of 162

Pew ]
ITrE Remate Sy Go Tao 9

=

_ | S é.ff‘? Refresh
=g RSELAELD.*ib, b
[ [F] CLCL.*pgm.
CLR1.*pam.
MYCOMPILE 1 Rename
PAYROLL *p
PAYROLLC.* o= SORY

- [ PAYROLLD * [ Paste
] PATROLLG® g 0,
=5y compare
EMPMST, *Fil, ¥
=[5 EvFEVENG
-6 MaTDSR, R
-6 MSTDERZ, #F
- PRIMST il

Expand
Collapse

w in Table

ChangedB). ..
E B oceuEsRe, AR

[h PAYROL Restare...
Iy payROoLl ser Ackions k
Iy PAYROLI

Add To iSeries Project...
Make Available Offline

L.y PaYROL
33 E] QCLSRC #fil

erties(Fl

Py MSTOSP.dspf
@y PRIMST.pf
Py REFMST.pf
LMy RSMMST.pf
I—I E‘I ORPGLESRC, *file.of-src ll Remate Syste

Figure 10: Select Show in table for ODDSSRC file
Before you go ahead and work with these members, let's see the members in the iSeries Table view
as well because that is more similar to the view you are used to from PDM. You use this view to
display a list of items, for example, members or objects, in a table format similar to PDM. You can
also perform actions against these items such as editing and compiling.
4. Right-click the QDDSSRC file and select Show in Table.
The iSeries Table view takes the selected object in the Remote Systems view as input, and displays
the contents in the table. For source physical files, this step displays the members inside, their

names, types, attributes, text descriptions, and status.
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Figure 11: Table view with lock/unlock button

The top of the iSeries Table view contains a lock icon *B that controls the correlation between the
Remote Systems view and the iSeries Table view.

If the lock is disabled then whenever you click an object or library in the Remote Systems view, the
associated contents of that item automatically populate the iSeries Table view.

If the lock is enabled then when you click on various items in the Remote Systems view, this view
does not change the input to the iSeries Table view.

To enable or disable the lock, you can click it once to change its state.

Tip: Click on the columns heading to sort the view by column.

You can unlock this iSeries Table view. It then switches to the selected object in the Remote
Systems view, as you select objects in the Remote Systems view.

5. In the iSeries Table view toolbar make sure the lock/unlock button ﬁ is in the unlock position.
This means now the table will automatically be updated when a different object is selected in the
Remote Systems view. This is a shortcut to bring up the pop-up menu for an object in the
Remote Systems view and then select Show in Table.

6. Inthe Remote Systems view, select QCBLLESRC. The table shows the members in
QCBLLESRC
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Figure 12: iSeries Table view for QCBLLEESRC

To get to the iSeries Table view from the maximized Editor window without bringing the size of
the Editor window down, you can position the iSeries Table view on the left task bar as a Fast
view.

Right-click on the iSeries Table view window heading

Select Fast View from the pop-up menu

You will see the iSeries Table view icon on the task bar on the left hand side of the workbench.

9. Maximize the Welcome window
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10. Click the iSeries Table view icon on the task bar to see this view. Click the icon again to close

this view.

@ Remote System Explorer - Welcome - Websphere Development Studio Client Advanced Edition for iSeries - |EI|5|
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Now you are ready to use the Remote Systems LPEX Editor to edit the member MSTDSP found
in QDDSSRC.
11. Double click the Welcome window.
12. From the Remote Systems view double-click member MSTDSP in the QDDSSRC source file.
Tip: You can do this in the Remote Systems view or in the iSeries Table view.

The Remote Systems LPEX Editor opens. It is built right into the workbench, with rich editing
functions and is iSeries aware! It is a superset of SEU! The syntax checker is ported down from
SEU, the compilers embedded for verifying errors and the reference manuals are built-in and F1
cursor sensitive. The Outline view will show the program hierarchy. There is explicit and rich iSeries
support for verify, compile, run and debug of RPG, COBOL, C, C++, CL and DDS from the Remote
Systems LPEX Editor.

Many of the editing features offered in the CODE Editor for RPG, COBOL, CL, and DDS source,
such as syntax checking, automatic uppercasing, program verification, and so on, are now available
in the Remote Systems LPEX Editor.
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tﬁ: Remote System Explorer - MSTDSP - WebSphere Development Studio Client Advanced Edition for iSeries = |EI|5|
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Figure 13: Source Editor with DDS member

13. Double click the MSTDSP tab to maximize the Editor window, as shown by the arrow in Figure
13. Double click the MSTDSP tab again to return the window to its original size.

Opening a second source member
Next let's open a second member in the editor. Back in the Remote Systems view:

1. Double-click member PAYROLLC in the QCBLLESRC source file.

This member will be loaded into the editor as well. Your Editor window will look something like
Figure 14. Notice the two tabs in the editor pane. Click on each tab to switch from one edit
session to another edit session.

©Copyright IBM Corporation 2003
Course material may not be reproduced in whole or in part
without the prior consent of IBM



Page 33 of 162

tﬁ: Remole System Explorer - PAYROLLC - WebSphere Development Studio Client Advanced Edition for iSeries - IEIIﬂ
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Figure 14: Editor with COBOL source member

Displaying an outline of a structured file

Next let’s look at the Outline view. This view displays an outline of a structured file that is currently
open in the editor area, and lists structural elements. The contents of the Outline view and toolbar
are editor-specific.

To open the outline view:
Select Window > Show View > Other
2. Expand Basic

1.
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3. Select Outline

x
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4. Click OK.

You can see the Outline view contains your source program in a tree view without the lines

containing logic.
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Now you want to see more details of your source member.
Expand ENVIRONMENT DIVISION

Expand the CONFIGURATION SECTION

Expand the DATA DIVISION

1.
2.
3.
4.

CL——_I}IL

SOURCE-COMPUTER.,
L QBIECT-COMPUTER,

- INPUT-CUTPUT SECTION,

& T DIVISION,

: E SECTICN,

-FD MSTDSP-FILE,

--01 MSTDSP-REC,

- COPY DDS-ALL-FORME

--FD EMPMST-FILE,

--01 EMPMST-REC,

- COPY DDS-ALL-FORME

--FD PRIMST-FILE,

--01 PRIMST-REC,

Figure 15: Outline view with file and record format expanded

Expand the FILE SECTION

Double click on any of the entries in the Outline view. This will position the source editor accordingly.

Now if you want to switch to a different member loaded in the source editor just click on its tab and

the Source Editor window with the corresponding member comes into focus.
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tﬁ’ Remole System Explorer - PAYROLLC - WebSphere Development Studio Client Advanced Edition for iSeries
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Figure 16: Click the tab to give focus to the edit session
Now you want to switch back to the DDS source member.
5. Click the MSTDSP tab.

6. Click the PAYROLLC tab to get the PAYROLLC Editor window in focus for the next exercise.

Complete the checkpoint below to determine if you are ready to move on to the next exercise.

Checkpoint

1. When you first open Remote System Explorer, you are not connected to any system except your
local workstation. To connect to a remote iSeries system, you need to:
A. Start Remote System Explorer communication server
B. Start a 5250 session
C. Define a connection. Specify the name or IP address of a remote system
D. Define a profile
2. The first time you connect to an iSeries system, you need to define a:

A. Profile
B. Filter
C. Filter pool

D. Connection
E. All of the above

3. Profiles:
A. Help partition data when you have a lot of connections or filter pools
B. Include all connections, filters, and filter pools
C. Group connections
D. Share connections
E. Keep connections private
F. All of the above

4. There are several type of profiles:
A. Team
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10.

11.

12.

13.

14.

B. Personal
C. Both
A team profile is used to share resources and information with other people. (T, F)
Subsystems include:
A. iSeries Objects
B. iSeries Jobs
C. IFS Files
D. iSeries Commands
E. All of the above
iSeries objects include:
A. Work with libraries
B. Work with objects
C. Work with members
D. Library list
E. All of the above
The iSeries Table view is used to:
A. Display a list of items, for example, members or objects in a table format similar to PDM
B. Perform actions against a list of items, such as editing and compiling
C. Both
The lock icon controls the correlation between the Remote Systems view and the iSeries Table
view. (T, F)
A disabled lock means when you click on an object or library in the Remote Systems view
A. The associated contents of that item automatically populate the iSeries Table view
B. Only the Remote Systems view is updated
C. Only the iSeries Table view is updated
D. None of the above
An enabled lock means when you click on an various items in the Remote Systems view
A. The associated contents of that item automatically populate the iSeries Table view
B. The iSeries Table view input does not change
C. Only the Remote Systems view is updated
D. Only the iSeries Table view is updated
E. None of the above
You can maximize the Editor window by double clicking on its window heading. You can get
back to its original size, by double-clicking on the heading again (T, F).
The outline view:
A. Displays an outline of a structured file currently open in the editor
B. Lists structural elements
C. Contents and toolbar are editor specific
D. All of the above
views are hidden views, which can be quickly made visible. They work identical to
normal views, the only difference being that when hidden they do not take up screen space on
your workbench window.
Remote Systems
Navigator
Outline
Fast

oCow>
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Practice

Given that you have access to your own iSeries systems, configure a new connection and connect
to this iSeries system. Now rename the connection, move the connection up or change the
attributes of the connection. Then use the iSeries objects subsystem to list the libraries in your
library list. Use the iSeries Tables view to see the objects in your library. Subset objects in the
iSeries Table view. Open the Remote Systems LPEX Editor from the iSeries Table view. Use the
Development Studio Client for iSeries online help to assist you in these tasks.

What you just did

In this exercise you were introduced to profiles, subsystems, and the iSeries Tables view. You
defined connection information for an iSeries server, selected the iSeries Objects subsystem and
viewed the libraries in the library list. You then expanded the current library and looked at the
iSeries Table view of QDDSSRC. You locked and unlocked the iSeries Table view. You then
opened several source members with the Remote System LPEX Editor. You maximized the Editor
window, opened an Outline view and switched from the Outline view to the member ready for edit.

In the next exercise you will continue to work with the source members you just opened and learn
how to simplify your editing tasks with the Remote Systems LPEX Editor. Remember you are editing
right from the Remote Systems view! And keep in mind you can use SEU like format line rules, SEU
specification prompting and SEU style commands in the Remote Systems LPEX Editor.
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Exercise 4: Editing ILE COBOL

In this exercise you edit ILE COBOL source and using some of the Remote Systems LPEX Editor’s
language features right from the Remote Systems view.

At the end of the exercise, you should be able to:

* Describe the features of the Remote Systems LPEX Editor
* Invoke SEU commands in the prefix area

¢ Undo and redo edit changes

¢ Display COBOL types of lines

* Filter source

* Invoke program language help

* Find a string in multiple files with the search utility
* Compare two files with the compare utility

¢ Identify lines with syntax errors

¢ Correct syntax errors

¢ Switch automatic syntax checking off

Your program editing tasks are simplified with the Remote Systems LPEX Editor. The editor can
access source files on your workstation or your iSeries system directly. When a compilation results
in errors, you can jump from the compiler messages to an editor containing the source. The editor
opens with the cursor positioned at the offending source statements so that you can correct them.

Here is a list of the some of the basic editor features that you would expect in a workstation editor:

» Cut, copy, and paste

» Block marking of lines, characters, or rectangles with copy, move, and delete operations

» Powerful find and replace function

*  Unlimited undo and redo

In addition there are a few more functions that you may not have seen in a workstation editor:

» Token highlighting where different language constructs are highlighted using different colors and
fonts to help identify them in a program

» SEU-like format-line rulers to show the purpose of each column for column-sensitive languages
like RPG and DDS. These rulers can automatically update themselves to reflect the current
specification.

» SEU-like specification prompting for RPG and DDS

» Sequence numbers, which allow SEU-style commands in the prefix area

» Intelligent tabbing between columns for column-sensitive languages

» Automatic uppercasing for languages that expect uppercase
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» Settings for column-sensitive languages simplify text insertions and deletions

* On-line language reference help

Now let's take a minute to try a few of these features.

Working with the COBOL source member PAYROLLC, which should be already open, try some of
these features by following the instructions below. You might want to maximize the Editor window
during this exercise.

Entering SEU Commands

You can configure the LPEX Editor to adopt the keyboard and command personalities of many
popular editors. Most editor profiles differ only in the keys and commands used to perform various
editor tasks. Some base editor profiles, listed below, also add prefix information and command area
at the start of each line:

o ispf
» seu
+ Xxedit

The editor recognizes prefix commands used by these editor profiles. Depending on which profile
you are using, you can enter SEU, XEDIT, or ISPF commands when the prefix area is active.
If you are an SEU expert you will appreciate the ability to use SEU commands:
1. Move the cursor into the gray sequence number area to the left of the edit area.
2. On any sequence number type dd
3. Go down a few lines and type dd again and press Enter.
Notice that the lines have been deleted.
Now type i 5 in the sequence number area.
Make sure the cursor is within the sequence number area.
Press Enter.

Five new lines are inserted.

©Copyright IBM Corporation 2003
Course material may not be reproduced in whole or in part
without the prior consent of IBM



Page 41 of 162

Requesting Undo and Redo operations

The editor records each set of changes you make to a file in the Editor window. The number of
changes made since the last file save is displayed on the status line. If you want to undo a set of
changes made to a file you use the Undo operation. You can also cancel the effects of an Undo
operation by using the Redo operation.

Now you are going to undo some of the changes you just made to the file. Then you will cancel the
changes by using the Redo operation. Finally you will reload the source so that it is back to its
original form.

To undo and redo edit changes:

1. Select Edit > Undo from the workbench menu bar.
Notice that the 5 new lines disappear.

2. Do another undo action by pressing Ctrl+Z.
Notice that the deleted lines reappear.

3. Select Edit > Redo from the workbench menu bar

Notice that the lines are deleted again.
At this point you will reload the source from the iSeries to make sure that it is back in its original
form. To do this:

4. Select File > Close option on the workbench menu bar
A Save Resources wi ndow wi || appear asking you to save the |atest changes.
Click No.

Go back to the workbench to the Remote System Explorer perspective and reload the
PAYROLLC member in the QCBLLESRC file.

Invoking Language-Sensitive Help

Inside the editor, there is cursor-sensitive language-reference help available. This help is invaluable
if you cannot remember the syntax of certain statements. This help is available from the LPEX Editor
window.

To receive language sensitive help, press F1 in an Edit window. If the cursor is on an operation
code, you receive help for that operation code; otherwise, you receive help for the current
specification.

To access language sensitive help:

1. Position the cursor over the word MOVE in line 231 of the ILE COBOL source.
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2. Press F1.
Language-sensitive help for the MOVE operation code appears in a Help window.
#Help - Websphere Development Studio Client Advanced Edition for iSeries - |EI|5|
search: | |m Search scope! All topics —
Contents C%;. iseries programming information E= = (ﬁ I a
Nt

T S TS0 = LTSI
-

L3 procedure Division
=1 03 Procedure Division Stat

Development Studio: ILE COBOL Reference

2 AcCEPT Statemen
Bl ACQUIRE Stateme

03 ADD Statement MOVE Statement

003 ITIALIZE Statem
02 INSPECT Statemer
02 MERGE Statement
= State

&|%$|;’éf|ﬂw

q

L2 aLTER Statement
05 AL Statement The MOWE staterment transfers data between areas of storage.
03 cancEL statemen! The MOWE statement has two formats:
"8 o |+ Eomst1-vove
« Format 2 - MOYE COREESPOMDIMNG
(2 coMPUTE Stateme
Bl COMTIMUE Statem Related Information:
greTE st | yoVE Sigtement Rules
e Elementary Moves
LB pIvIDE Statement « Groun Moves
B DROP Statement o WHEN-COMPILED Special Register
E1 ENTER Statement
[ EvALUATE Statern
B EXIT Statement [ Top of Page | Previous Page | Hext Page | Tahle of Contents ]
03 ExIT PROGRAM 3. Copyright IBM Corporstion 1892, 2003, A1l Rights Reserved.
Bl GOBACK Statemen
02 0 TO Statement
02 1F Statement

Figure 17: Help for MOVE and synchronize button

Text marked in blue in the Help window contains the link to detailed information about the topic in

blue.

3. Click Show in Table of Contents on the Help window toolbar.

This will synchronize the topics in the Contents pane on the left to the help topic you are viewing in

the main help pane.

Play around in the Help window to see what else is available.

Minimize the Help window.

Select Help > Help contents on the workbench menu bar to see a list of all help that is available

in the product.
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& Help - webSphere Development Studio Client Advanced Edition for iSeries i ] |
Search: | |m Search scope: All topics
Contents C.%}

@ websphere Applica
@ J25E SDK 1.3.1 API=

@ Application developer information

Using Eclipse help system

Browse topics in the Contents frame (@) on the left. Click on topics to display them. Use the

@ Tool developer information . P . -
Back and Forward buttons to navigate within history of viewed topics.

@ JZ2EE 5DK 1.3.1 APIs

@ Remote System Explorer User Guide R
Searching

L Support information

Figure 18: Main Help window
Here you will find the table of contents and you can select the topic you are interested in.

7. Select iSeries programming information from the topic list in the Contents pane.

& Help - webSphere Development Studio Client Advanced Edition for iSeries i ] |
Search: | |m Search scope: All topics
Contents t%;) iSeries programming information L= = E% I a

@ iseries application developer inform—= Development Studio: ILE COBOL Programmer's

iSeries programming information

==} High-level languages G u id e
Bl PDOF wersions of the books
& crotq
2] Gk e About This Guide
= 3 1E copoL
® (B Language Reference This guide describes how to write, compile, bind, run, debug, and maintain Integrated Language
= L3 programming Guids Ervironment (ILE) COBOL compiler programs on the Operating Systemd/400 (05/400). It provides

=8 contents programming information on how to call other ILE COBOL and non-ILE COBOL programs, share
EMEFTSNOTEn data with other programs, use pointers, and handle exceptions. It also describes how to perform
] inputfoutput operations on extermally attached devices, database files, display files, and ICF files.

() Compling, s mtey

Using this book, wou will be able to:

Figure 19: Finding the COBOL manuals
8. Expand High level languages
9. Expand ILE COBOL
10. Expand Programming Guide
11. Expand Contents.
12. Click About This Guide.

Having the latest version of the manuals at your fingertips makes it easier to find programming
information. There is also an option to search the help by specifying a search string. By default, the
complete help will be searched. To limit the search to specific documents, select the Search scope
option.

13. Click Search scope.

14. Select the Search only the following topics radio button in the Select Search Scope window.
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15. Click New.
b Help - WebSphere Development Studio

Search: |

Contents t’_"@ iSeries programming information T E’% I a

g‘5‘“‘“a""““‘“"“"“e'“"‘“‘"“'"'; Development Studio: ILE COBOL Programmer's

iSeries programming information

El High-level languages ;lglll
B PDF versions of the backs et
8 cjcts e b :
15} COBOLJ400 AI * Foearch only the Following bopics:
=03 1E copoL — iSeries programming
1 L3 Language Reference This ug, and maintain Integrated Language
=1 LB programming Guide Env ating Systems400 (05/400). It provides
=1 68 canterts prog and non-ILE COBOL programs, share
B what's New dat: tions. It also describes how to perform
= [T i3 inpL tabase files, display files, and ICF filas.
V2] Compiling, Running, and De Usir
03 11E coBoL Programming Ce

E@ ILE COBOL Input-Cutpuk ©

l:Q.\lppencli)ces Ed'—tl ml

B Java
(8 ppaja00
Eneres Not o | _cancel |
L3 pata Definition documentation this guide before proceeding to the other
&1 LB mrntend lanouans infremakinn —_ CTTEpTETS.

Figure 20: Setting the search scope
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2} New Search List - Microsoft =100 x]

List pames

. liseries programming
Topics to search:
iSeries application developer information
©
™ Remate System Explorer Developer Guide

(I WihSphere Application Server Mebwork
Deployment

™ 125E 50K 1.3.1 APIs

jSeries programming informakion:

r application developer information

[+

™ Tol developer inFarmatian

[T 312EE SDK 1.3.1 APIs

™ remote Syster Explarer User Guide
r Support information

“i Cancel |

———

Figure 21: Search List set up

In the New Search List window:
17. Enter a list name, i Seri es pr ogramm ng, for example

18. Select the check box beside the document you would like to search
19. Click OK.
20. Click OK in the Select Search Scope window.

Finding and Replacing text

The LPEX Editor also has a powerful find and replace text feature. You use the Find and Replace
window to search for an item. You can search for a word, a partial word, or a sequence of such. You
can also enter a pattern you want to match, provided that the pattern follows the rules of regular
expression. You can replace the found search item. If the entered text or pattern is found, the cursor
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moves to either the next or previous occurrence of the search item, according to your chosen search

direction, and replaces the found text according to your selections.

To find and replace text in the Payroll Editor window:

1. Press Ctrl+Home to go to the top of the file.

Tip: When you press Ctrl+Home to get to the top or Ctrl+End to get to the bottom, a quick mark

is set at your cursor position. This allows you to get back to that line by pressing Alt+Q. Ctrl+Q

will set a quick mark.

2. Select Edit > Find/Replace from the workbench menu bar or press Ctri+F.

The Find /Replace window appears at the bottom of the Editor window.

tﬁ: Remote System Explorer - PAYROLLC - WebSphere Development Studio Client Advanced Edition for iSeries - IEIIﬂ
File Edit Source Compile Mavigate Search Project Run  Window Help
|I¥-gralgs-%-a-]¢lce-2-[[es | amr|Ay "
|| welcome | #msTDsp x]
’% Row 240 Column 18 Replace
LS f-*h-1-E-—+—--2 } 3- } 4 } 5- } I } 7--
|| ooozzs N
I-—ih 000229 * Housekeeping, clear display fields and reset indicators.
000230
000231 HOVE SPALCE ToO EMESS OF SELECT-0O.
000z3a SET IND-OFF (IND-ERRCR) TO TRUE.
000233
000234 * The following IF AND OF combination checks the application
00o0z35 * zgelection fields to ensure that only one application has been =
000236 * selected.
O00z37
000238 * THE EUG I3 HERE
Q00239 FEE T FEFEELT LT REESL
0o00z40
000z41 IF ((EMPAPL OF 3ELECT-I = 'X') LND
000z 42 (I OF SELECT-I = 'X')) OF
oo0z43 ((EMPAPL OF SELECT-I = 'X') AND
000z 44 (RSNAPL OF SELECT-I = 'X'))
000245 SET IND-CM(IND-ERROE) TO TRUE
00246 MOWE ERRM3G(Z) TO EMESS OF SELECT-0O
000247 ELSE =
Eincq PRSP Y { Nextr Previous | ﬂ
Reglace@ Replace all |
[ Case sensitive [ Regular expression W wrap W Select found text [ Restrict search ko selection
[V Restrict search to columns  Start calumn | 1 End colurmn l?
|

Figure 22: Find/Replace window

At the bottom of this window, you will notice that you have some options to select from, for example,
search only in certain columns, etc. You want to find the first occurrence of PRJIAPL and replace it

by the word PRQJAPL.

3. Inthe Find field, enter PRIAPL.
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10.

11.
12.

Press the tab key to move to the Replace field and type PRQJAPL.

Uncheck the Case sensitive check box.

Click Next (or Press Ctrl+F)

The Editor moves the active line, to line 194, which contains the first occurrence of PRIAPL in
the file.

Click Replace to replace PRJAPL with PRQJAPL then click Next to go to the next location of
PRIAPL in the file.

Click Replace all to replace all occurrences of PRIAPL with PROJAPL.

Double-click member PAYROLLC tab in the Editor window to return the PAYROLLC Editor
window to its original size.

Close the PAYROLLC Editor window.

A window will appear asking you to save the latest changes.

Click the No button.

From the Remote Systems view, double-click PAYROLLC to reload the COBOL original source.

Filtering Lines by string
The editor allows you to filter or subset your source so that you see only lines containing a given

string. Filtering lines makes it quick and easy to find lines without having to scroll through your
source.

To filter source by string:

1.
2.

Double-click MSTDSP in the Edit window to select it.

Select Edit > Selected > Filter Selection from the workbench menu bar.
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tﬁ: Remote System Explorer - PAYROLLC - WebSphere Development Studio Client Advanced Edition for iSeries = |EI|5|

File Edit Source Compile Mavigate Search Project Run Window Help

|IF-DR&[F]s-%-&%-[[s]|cc-2-[[a6|ampr|AL?"
B || welcome | ZAmstose x]
’% Row 27 Colurmn 14 Replace
= ————+-*4-1-B-Q+-—--2 =3 . 4 f———-5 =6 T ——
= [=]
l-—ih E aoooz=9 * are: — maintenance display file W
aoo0os37 SELECT M3TD3IP-FILE
B Q00038 AIITIGH T WORKSTATION-MSTDEP-3T
a0006s FI. HM3TDSP-FILE.
aooo&s 01 HM3TDSP-REC.
E aooo7a COPY DD3-ALL-FORMATS OF MSTDSP.
M 000132 01 M3TDSP-IND-USAGE.
M 000154 COFEN I-O MSTDEP-FILE
M 000160 IMITIALIZE M3TD3P-REC.
M 000167 CLOSE M3TDSP-FILE
B 000179 WRITE MSTDIP-REC FORMAT IS 'SELECT!'
: 000153 READ M3TDSP-FILE FORMAT I3 'SELECT!
: aoozz=0 INITIALIZE MSTDSP-REC
: 00294 WRITE M3TD3P-REC FORMAT I3 'EMPSEL'
E O00z98 READ M3TDSP-FILE FORMAT I3 'EMPSEL'
| 000343 WRITE M3TD3P-REC FORMAT IS 'EMPMNT'
| 00347 READ M3TDSP-FILE FORMAT IS 'EMPMNT'
M 000354 WRITE M3TD3P-REC FORMAT IS 'PRJIZEL!'
M 000358 REALD MSTDSP-FILE FORMAT IS 'PRJSEL!'
M 000443 WRITE M3TD3P-REEC FORMAT IS 'FRJIMNT'
M 000447 REALD M3TDSP-FILE FORMAT IS 'PRJIMNT'
H 000454 WRITE M3TDIP-REC FORMAT IS 'RINSEL'
: 000498 READ M3TDSP-FILE FORMAT I3 'RSN3EL' b
E 000543 WRITE M3TD3P-REC FORMAT I3 'ERSNMNT' ;I
|

Figure 23: Editor window showing all lines with MSTDSP

3. Move the cursor down a few lines, to line 294

4. Click the plus beside line 294 to expand this section
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tﬁ: Remote System Explorer - PAYROLLC - WebSphere Development Studio Client Advanced Edition for iSeries = |EI|5|

File Edit Source Compile Mavigate Search Project Run Window Help

|IF-DR&[F]s-%-&%-[[s]|cc-2-[[a6|ampr|AL?"
B || welcome | ZAmstose x]
’% Row 292 Column 1 Replace
— +-*Ah-1-E-—+ -Z t———=3 4 -& —-=7-—| -
m’ -
l-—ih E aoooz=9 * are: M3TD3P - maintenance display file it I
aoo0os37 SELECT M3TD3IP-FILE
B Q00038 AIITIGH T WORKSTATION-MSTDEP-3T
a0006s FI. HM3TDSP-FILE.
aooo&s 01 HM3TDSP-REC.
aooo7a COPY DD3-ALL-FORMATS OF MSTDSP.
000132 01 M3TDSP-IND-USAGE.
000154 COFEN I-O MSTDEP-FILE
000160 IMITIALIZE M3TD3P-REC.
ooo1a7 CLOSE M3TDSP-FILE
ooo17se WRITE MSTDIP-REC FORMAT IS 'SELECT!'
000153 READ M3TDSP-FILE FORMAT I3 'SELECT!
aoozz=0 INITIALIZE MSTDSP-REC
DDDZQ‘}I WRITE M3TD3P-REC FORMAT I3 'EMPSEL'
000295 INDICATORS ARE IND-TAELE
000296 EMD-WRITE.
aooz97?
000295 REALD METDSP-FILE FORMAT IS 'EMPIEL'
000343 WRITE MSTDSP-EEC FORMAT IS 'EMPMNT!'
o034 RELD M3TDSP-FILE FORMAT IS 'ENFMNT' |
000354 WRITE M3TD3P-EEC FORMAT IS 'PRJSEL'
ooo039s5 REALD METDSP-FILE FORMAT IS 'PRJSEL'
aoo0443 WRITE M3TD3P-REC FORMAT IS 'PRJIMNT'
00447 READ M3TDSP-FILE FORMAT IS 'PRJIMNT' ;I
|
Figure 24: Section expanded

Now you want to show the entire source again.

5. Select Edit > Show all from the workbench menu or press Ctrl+W.

Your cursor is still positioned on the same line that you moved the cursor to, even though all lines
are now showing.

Filter lines based on type

To help you navigate quickly through your ILE COBOL source the Editor allows you to filter lines
based on the line type. Imagine you want to see where all the divisions are defined in your source:
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| cﬁ: Remote System Explorer - PAYROLLC - WebSphere Development Studio Client Advanced Edition for iSeries - |EI|1|

File Edit Source ©Comple Mavigate Search Project Run  Window Help

IS-DE.&| 8% -%-%- |a6|mmw|Af "

| oo @~ -

|| wekcome | ZmsTose x]
’% Row Z92 Column 1 Replace
e e T T 4 } 5 " I3 " ey 8
(|| ooozso END-IF. N
I-—i}l O00zE1
00025z 0zZ00-EXIT.
000253 EXIT.
o00zs4
O00zZ55
000286 O0300-EMPHST-SFELECT.
oo0zs7 Synkax Check Selection
000288 e ] T &
000259 * Employee n outine. *
oagz9a0 e — CDDY ________ *
000291 Paste -
aoozoz * Display en Seleck line st .
000293 Seleck character
DDDZQ‘}I WRITE Select rectangle 5 'EMPIEL'
0a0z95s F3 LRE IND-TAELE
Selecked 3
000z96 END-WE Deselect
ooozsw
oo0z9s RELD By Date
ooozas Shiov &l Comi
oao3oo END-EE
000301 JaVE
— MOVE 1§ Add Breakpoint Embedded SQLCICS
000303 MOVE A
Errors
000304 |
|
T P S S TR O, |

Figure 25: Editor pop-up menu with Filter sub menu
1. Right click in the Editor window
2. Select Filter view > Divisions.

All divisions are displayed allowing you to move quickly and easily to the area in your file where the
desired division is.

.ﬁ: Remote System Explorer - PAYROLLC - WebSphere Development Studio Client Advanced Edition for iSeries - IEIIﬂ

File Edit Source Compile Mavigate Search Project Run  Window Help

|S-HRal8|s % -

|2lle e~ -

o6 mmr Ay E

B || Owelcome | Zmstose X ]
% Row 145 Colurn 1 Eeplace
—— +-*L—1-F + -Z t————3 + 4 +-——--5 + -6 t———=T——] -+ -g
r 000003 IDENTIFICATICN DIVISION.
s 0o000as PROGRAM-ID. PAYROLLC.
000015 ENVIRCWNMENT DIVISICN.
000064 DATAL DIVISICON.
DDDlSDI PROCEDURE DIVISION.

Figure 26: Division filter in action
3. Move your cursor to the line with the procedure division. (line 150)

4. Click the plus sign beside the declaration to show all lines in this division
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Now you can work with the source inside this division.

Searching multiple files

If you would like to search through the members in a source physical file or through the files in a
local directory, you can use the Search tool. The Multi-File Search utility allows you to search for a
particular string of text in many members on the host. This function can also be used on local files.

To search multiple files:

1. Select Search from the workbench menu bar.

‘ﬁ' Remote System Explorer - PAYROLLC - WebSphere Development
File Edit Source Compile Mavigate | Search  Project Rum Svindow

Jlf? - E & J Jii’r » <f Search... CtHH | -

lWelcome | #/MSTDSP
Fow 145 Col

B---+-"4-1-F "7 Help... -

|| ]| B

The Search window appears.

2. In the Search string field type ENHRS
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o o ko

search x|

B iseries Search |%> File Search | L2 Help Search | 45 1ava search | &2 Plug-in search I

Search strindid ENHRS_ j [T Case sensitive
Connection: |54EIIIIa j Mew. .. |
—Target
Library: jj Browse... |
File: LODS5R jj Browse, .. |

Memb@

¥ | Source members

jj Browse, .. |

[T mata members

— Columns

|l columns

" Between |1 and | 20

™ Between(iz) I 1 and end of line

Cuskomize. .. |

‘.ﬁ-' Zancel

Figure 27: File Search window

In the Target area:

Enter RSELABxx in the Library field.

The Connection entry field should contain your iSeries server name, otherwise enter it there.

Enter QDDSSRC in the File field, to search all members in this source physical file.
Enter * ALL in the member field
Click Search.

The Multi-File Search window lists all the lines in all the files that reference ENHRS.
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¥ Remote Search ("ENHRS" - 3 Occurrences in o~ x
B- [13 RSELAEL0/QDDSSR.C(EMPMST) (1 match)
------ B EMHRS R (line 18)
E| [13 RSELAB10/QDDSSRCMSTOSP) (1 match)
------ a EMHRS R B 11 37REFFLO(R.CEMP/EMHRS *LIBLIEMPMST) (line 99)
E| [B RSELARINODMNSSE(DEERST (1 gk
—_— i EMNHR.S 31 TEXT{'EMPLOYEE NORMAL WEEK HOURS" (line 22

Figure 28: Search result

7. Double-click the last line in the list

A ENHRS 31 TEXT(EMPLOYEE NORMAL WEEK HOURS')
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Cweleome | ZMsTDSP | ZPavRoLL X
Fow 27 Column 1 FEeplace

I....A ............ Name++++++ELen++TDpE. . .. .. Functions+++++
000020 i1 COLHDG [ 'EMP' |
0oooz1 i1 EDEPT 5 TEXT[' EMPLOY
oooozz2 i1 COLHDG | ' EMPL
000023 i1 ELOCH 30 TEXT ' EMPLOY
000024 i1 COLHDG | ' EMPL
000025 i1 EUSRI g TEXT ' EMPLOY
000026 L COLHDG | 'EMPL
il eara NI ENHES 301 TEZT [ LNCLITe

ooooze b COLHDG [ "NOEM
ooooz9 b EPHEC 5 1 TEXT (' PROJEC
oooo3o b COLHDG(['PRJ
oooo3l b EPHET 7 1 TEXT (' PROJEC
oooo3a b COLHDG(['PRJ
oooo3a b EPHEP 7 1 TEXT (' PROJEC
oooo3 g b COLHDG(['PRJ -
- | of
|

&? Remoke Search ("ENHRS" - 3 QOccurrences in 3 Members) g

P A EMHRS R (line 18)

El [l'g RSELAB10/CDDSSRC(MSTDSR) (1 match)

. b EMHRS R B 11 37REFFLD{RCEMP/ENHRS *LIELJEMPMAT) (line 997

=8 [l'g RSELAB10/CDDSSRC(REFMST) (1 match)

------ ) EMHRS 31 TEXT{EMPLOYEE MORMAL WEEK HOURS' (line 273

Remate System Details | Tasks |iSeries Table Yiew |iSeries Commands Lag |Remu:ute Search |

The member REFMST is automatically loaded into the editor and the cursor is placed on the correct
line. Wow !

Comparing file differences from the Remote Systems view

If your product undergoes many changes, you will find the Compare utility useful. It allows you to
compare different versions of a program and find the differences. There are two ways to do a
compare: use the Compare utility in the workbench or use the Compare utility in the CODE tool. The
compare in the CODE tool is more intuitive but requires you to start the CODE Editor outside of the
workbench.

Using the compare utility in the workbench you can view the differences between two files by
comparing them. You can compare different files, and you can compare versions in the Workbench
with versions in the repository or with the local edit history. In some cases you can compare three
files (when a common ancestor exists).
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After a comparison is carried out, the Compare Editor opens in the editor area. In the compare
Editor, you can browse through all the differences and copy highlighted differences between the
compared resources. You can save changes to resources that are made in the comparison editor.

Using the compare utility in CODE you can also view the differences between two files by comparing
them. You enter a name of a file to compare against the file in the CODE Editor view. You can type
the name of a file, or you can select one from the list of files already open in the editor. If you type
the name of the file that is not already open in the editor, it is loaded into the editor. If no file is
specified, the current file is compared against a new, untitled file. The current file appears on the left
side of the Compare view, and the specified file on the right. You use the Compare menu to view the
next and previous mismatch and to select options such as ignore case, font, protect view and show
mismatches only.

To compare files in the workbench:

1. Select Window > Preferences from the workbench menu bar
2. Expand LPEX Editor from the tree view in the Preferences window
3. Select Compare under LPEX Editor
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_ioix

i Logain ﬂ Compare
= LFEXE
- ADpEArance [ Ignore case

gniore leading blanks

gniore trailing blanks

- Find Text Ignore all blanks
[+]- Parsers [ Ignore comments

- Prink

- Save

- Tabs

- User Actions

- User Commands

- User key Actions

- User Mouse Actions

- User Profile

- ChDaocuments and Sekk
- ChDaocuments and Sekk
- ChDocuments and Sekk
il Plug-In Development

il Profiling and Logging

t- RAD

-]~ Remate Syskems |-
- Cammunications

- Files

=- iS_eries

=...[=...[+]

ingl

Comnmand Executio
Comnmand Subsyste
Job Subsystems

-- LPEX Editor Parsers

i Obijects -
1 | | 3 Resek | Restore Defaults | apply |
Impott... | Export. .. | Ok, I Cancel |

4. In the Compare window make sure that the Ignore blanks check boxes are selected

5. Click OK in the Preferences window

Back in the Edit window of the PAYROLLC member:

6. Double-click the PAYROLLC tab.

7. Make sure all lines show in PAYROLLC (Right-click and select Show All from the pop-up menu).
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&k Remote System Explorer - PAYROLLC - WebSphere Development Studio Client Advanced Edition for iSeries

File | Edit Source Compile Mavigate Search  Project Run Window  Help

| 25| @ Unds Chrltz vfjgvjﬁu G- -||a6 | @B me | Al E
|| e i v x || wekome | ZmsTDsP X | 7/ reFmsT
% as(, A k| Fow 145 Column 1 Feplace
— ;e e - - B+ A 1-B— 4Bt —F g ——4——
| 2 ! - 000145 01 WS-ACODE PIC 4. -
l_—h E Paste (ZEE{ - " ooo146 01 WE-ACREC PIC .
i, aoo147 01 WS-EMESS PIC Z(50). _j
# Delste i 000146
Select Al Chrl+i oooi49
. die DDDlSDI FROCEDURE DIVISTION.
andll'Replace. » Ctl-'I+F :..Igle 000151
e Shift-+F4 e ono15z 0000-MATH.
Find Previous Chrl+U chike 000153 -
Find Cther + | 1| | b
Shewy 4l e
F-src
Add Bookmark. .. Hta I
fdd Task. .. f-dta
= F [ Remote Search ("ENHRS" - 3 Occurrences in 3 Members)
Seleck L4 nf @ RSELABLOQDDSSRCEMPMST) (1 match)
Selected F Hka A ENHRS R (line 18)
Deselect AlEHL pf-stc ( RSELABL0/QDDSSRC(MSTDSP) (1 match)
{ A EMHRS R B 11 37REFFLD(RCEMPJENHRS *LIBL/EMPMST) (line 99)
necl Ao iodannegn T REEMST) (1 makch)
c 5 | TEXT{EMPLOYEE MORMAL WEEK HOURS' (ine 277
Keystroke Recorder » " -
-ontert ASSi_St ChrH+-SPACE Previous Mismatch Crr-Shift+P
w5 QCMDSRC *ile,  Refresh Compare Chrl4-Shift+R
£ Ely QDDSSRC.Hfile. Clear
H H ., [l EToT N Pk R

8. Select Edit > Compare > Compare from the workbench menu bar
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x

Select a member

| PavROLLCE

=59 *LIEL |
sl 25vs.Hib.prod-sys
=il svaz Mib,prod-sys
il QHLPSYS, *ib,prod-sys
-l QUSRSYS.*ib,prod-sys
@u}f“ RSELAE10.*ib. bast-cur
-5y COMPARE. *file, pf-ste
-[E EMPMST. *file.pf-dta
-5 EVFEVENT. *file. pf-dta
(-5 PRIMST *file,pf-dta
QCELLESRE., *file. pF-sre
- Iy PAYROLLC.chlle
Iy pay

RO blle

. .."
- El) QCLSRC ke pf-sre
-y QCMDSRC, *file, pf-src

-y QDDSSRC. *file.pf-sre
m [Ehs Anne eone #6ile oF ce- ;I

r@_, Cancel |
| 9]

In the Compare window:

9. Expand your connection

10. Expand *LIBL

11. Expand RSELABxx

12. Expand QCBLLESRC

13. Select member PAYROLLC2

14. Click OK on the Compare window

The editor now will show the differences of these two members PAYROLLC and PAYROLLC2
You can move from mismatch to mismatch by going back to the Compare menu option under the
Edit menu option or by using short cut keys CTRL+Shift+N .

Mismatches in PAYROLLC and PAYROLLC2 are highlighted in different colors so that you have an
indication which file the mismatched lines belong to.
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tﬁ: Remote System Explorer - PAYROLLC - WebSphere Development Studio Client Advanced Edition for iSeries - IEIIﬂ

File Edit Source Compile Mavigate Search Project Run  Window Help

|S-2Rale]t- % -

|2l e~ -

|as | 2mr | AF R

|| welome | Zmsose | _ZReFmsT x]
’% Row 87 Column 1 Replace
LS B-—-+*a-1-B——+ z } 3- } 4 } 5- } I } 7| -4 8
B || ooooas N
r 000086 01 ERROR-MESSAGES.
0000E7 05 Mo Tibp
D( 10 M5G-1 PIC X(50) WVALUE
] 10 MSG-1 PIC ¥50) WALUE =
000oss T = kit =
000090 10 MSG-2 PIC ¥({50) WALUE
000091 'MORE THAN ONE APPLICATION SELECTED FOR MATNTENAMCE' .
000092 10 MSG-3 PIC ¥(50) WALUE
000093 ' HO APPLICATICH SELECTED FOR MAINTENANCE [
000094 10 MSG-4 PIC ¥(50) WALUE
000095 ! LCTION CODE MOT EQUAL TO ™A™, "Cr QR "Dr [
000096 10 MSG-5 PIC ¥(50) WALUE
000087 ' LDD REQUESTED BUT RECORD ALREADY EXISTS IN FILE '.
000098 10 MSG-6 PIC ¥(50) WALUE
00ooss 0 WARNING - RECORD WAS PREVIOUSLY DELETED Os
000100 10 MSG-7 PIC ¥({50) WALUE
000101 ' CHANGE REQUESTED EUT RECORD DOES NOT EXIST [
000102 10 MSG-8 PIC ¥(50) WALUE
000103 ' CHANGE REQUESTED EUT RECORD IS DELETED [
000104 10 MSG-9 PIC ¥(50) WALUE
000105 ' DELETE REQUESTED EUT RECORD DOES NOT EXIST [
000106 10 MSG-10 PIC ¥(50) WALUE
000107 ' DELETE REQUESTED EUT RECORD ALREADY DELETED [
000108 05 ERRMSG REDEFINES MSG-TAELE OCCURS 10 TIMES PIC X(50). hd
One or more mismatches found.
|
|

Next, end the compare session.

15. Select Edit > Compare > Clear from the workbench menu bar

Comparing file changes from the CODE Editor (optional)

The CODE tool provides a side by side view of the members being compared. If you prefer this type
of view follow the steps described next. You might want to skip this section if the Compare Tool you
just used provides sufficient information for you.

Now you will open a couple of files and edit them and use the CODE compare utility.

In the Remote systems view:

1. Right-click member PAYROLLC in QCBLLESRC

2. Select Open With > CODE Editor from the pop-up menu
This opens the CODE Editor window with the PAYROLLC member. It will come up in browse
mode since it is locked by the LPEX Editor session.
In the CODE Editor, open the PAYROLLC2 member:

3. Select File > Open option from the CODE Editor menu bar
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ESelect file - Open for Edit |
File name [<RORASE44> RSELABX/ACBLLESRCIPAYROLLC2) | Saumeeig: | v|

[~ Contains sequence qumbers

Subset by source type |< Al Files > 'I

|<F|DF|.-’-'«SE§44>"LIBL |

- <LOCAL> L
B <RORASE44>

7 QDEYTOOLS
- QGPL

- OHLPSYS

- QSYS

- Q552

- OTEMP

- QUSRSYS

(- <RORASE44/AD M3

i

-

Eefresh | Srarf | Glzes: | Eird: | I

Open | Stop | Eancell Helpl

In the Open window:

4. Change PAYROLLC to PAYROLLC2 in the File name field.

5. Click OK on the Select file - Open for Edit window.

6. From the Actions menu, select Compare. The Compare window appears.

x

{BORASBA4>R5ELABXQCBLLESRC[PAYROLLC?Z]

Select or enter a file name

(Fll]FlASEdd)FlSELAE}OQ'QCBLLESHC PAYBOLLC

{BOBASBA4>B5ELABX>QCBLLESRC[PAYROLLC

L4 | i
¢] Compare } Cancel Help |

All entries are preloaded

7. Click Compare.

©Copyright IBM Corporation 2003

Course material may not be reproduced in whole or in part

without the prior consent of IBM




Page 61 of 162

The editor now has the PAYROLLC2 member loaded on the left and member PAYROLLC loaded on
the right. In between the two members are two long vertical blue lines with horizontal yellow and red
bars highlighting the differences in these members.

3] CODE - <RORASB44>RSELABXX,/QCELLESRC(PAYROLLC2): 2 o [w] 4|

File Edit View Actions Campare Options  Windows Help

<RBR936uu)HSELnB\\!uEBLLESRB(Pn?HnLchj' 2 (HBH986uu>RSELHB\\IQBBLLESRE(PH?RDLLB)' 2
Row 1 Column 1 Replace Row 1 Column 1 Replace
B--—+-*A-1-B——+———-2————4————————4-— I B--—+—%A-1-B——+-———2————+———-F————4—-

aaaaa PROCESS APOST. = aaaaa PROCESS APODST. [
SLSLS LT P aaaaaz

aeaaa3 IDENTIFICATION DIUISIOHN. — aa8a83 IDENTIFICATION DIVISION. L
aaaaAL aaaany

aaaaas PROGRAM-ID. PAYROLL . aaaaas PROGRAM-ID. PAYROLL .
000a06 AUTHOR . Programm aa0aas6 AUTHOR . Programm
aaaaay IHSTALLATION. IBM Toro aaaaa7 INSTALLATION. IBH Toro
aaaaas DATE-WRITTEN. October aaaaas DATE-WRITTEH. October
LT b DATE-COMPILED. LT b DATE-COMPILED.

gaaa1a g@aa18

aaaat11 et aaaat1 B e R
aaaa12 * PROGRAM DESCRIPTIODH aaaatz2 * PROGRAM DESCRIPTIOH

888813 * — Time reporting master fi aaaa13 * - Time reporting master fi
806614 *  described workstation pr 89914 *= described workstation pr
aaaa1s et aaaa1s B R e e
8eae16 808816

aeae17 aaaa17

aaaa18 ENUIRONMENT DIUISION. aaaa18s EMUIROMHMENT DIVISIOHN.

aaaa19 aaaa19

gaaaza CONFIGURATION SECTIDH. aa862 0 COMFIGURATION SECTIOHN.

aaaez1 aaaaz1

aaaazz SOURCE-COMPUTER. IBH-ASY aaaazz SOURCE-COMPUTER. IBH-AS4B@
aeaaz3 O0BJECT-COMPUTER. IBM-ASY4 aa8a23 OBJECT-COMPUTER. IBH-AS4B8
aeaazy aaa82y

888825 INFUT-OUTPUT SECTIOHM. a88825 INPUT-OUTPUT SECTION.

a88a26 2888z 6

aeaazy e aaaaz7 ®
geea2g * This program uses all exte ga0a23 * This program uses all exte
aeap29 * are: MSTDSP - maintenance agapz29 = are: MSTDSP - maintenance
aanBa3n * EMPHST - employee mas agae3a * EMPMST - employee mas
000631 * PRJHST - project mast aa0631 *® PRJHMST - project mast
ge0832 * RENHMST - reason code gaeg32 = RENHMST - reason code
a88a33 et aaaa33 B R e e
aeaa3L aaaa3 4

888835 FILE-CONTROL . - 888835 FILE-COMTROL. -
<] | v < | |
IBM Live Parsino Editor IBH Live Parsina Editor
G NG | 100% ;4 |5 B GLR
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8. Use the vertical scroll bars to move within the files. As you scroll, you will see where the
differences are in the members. COBOL experts will notice that PAYROLLC has some errors in
it. We will fix these in a few moments.

9. From the Compare menu (which was inserted while performing this action), select Exit
Compare to go back to the original view.

10. Close the CODE Editor. Select File > Exit from the menu bar. Continue working in the

workbench.

Checking Syntax

One of the powerful features that the LPEX Editor shares with SEU is its ability to syntax check your
source. Syntax checking can be done either when the cursor leaves each line of source or all at
once on either the currently selected source or on the entire file.

Now create a syntax error and watch for the prompt to correct it:

1. Inthe PAYROLLC Editor window select Source > Syntax Check All.

An error message appears to draw attention to the error.

©Copyright IBM Corporation 2003
Course material may not be reproduced in whole or in part
without the prior consent of IBM



Page 63 of 162

¢§3 Remote System Explorer - PAYROLLC - WebSphere Development Studio Client Advanced Edition for iSeries = |EI|5|
File Edit Source Compile Mavigate Search Project Run Window Help
|IF-DR &8s -%-&%-|[d]cc-2-[[26|ampr|AY?"
B || welcome | Zmstose | Zrermst x]
% Fow 76 Column 40 Eeplace
e f—%4—1-B——+ z } 3- } } 5- } 6 } 7--
|| ooooTs COPY DDS-ALL-FORMATS OF PRINST. || |
P aooove
L aooosa FI R3NMST-FILE.
00051 01 R3NMST-REC. _I
aooosz COPY DD3-ALL-FORMATS OF RSHMST.
Q00053
000054 WOREING-STORAGE SECTICN.
00aoss
0ooose 01 ERROR-MESZAGES.
oooosT? 05 MSG-TAELE.
0o000ss5 i0 M3G-1 VALTE
LINCE2530E Unmatched right parenthesT=s Pight parenthesis ignored.
LMC12453E PICTURE =string 'X50)' does not describe walid data category.
aoooss ! MAINTENANCE SELECTICON CODE NOT EQUAL TO M"X™ 0
aooosa 10 M3G-2 PIC Xi50) VALUE
aooo91 'MORE THAN CONE APPLICATICN 3ELECTED FOR MAINTEMNAMNCE'.
aooos:z 10 M3G-3 PIC Xi50) VALUE
aooo9s3 ! MO APPLICATICN 3IELECTED FOR MAINTENANCE !
[n[ufuluf=F: 10 M3G-4 PIC X(50) WVALUE
0oooss ! ACTICON CODE NOT EQUALL To far, "Cr QR !
oooos6 10 M3G-5 PIC X(50) WVALUE
oooosTy ' ADD REQUESTED EUT RECORD ALREALDY EXISTS IN FILE '.
ooooss 10 M3G-6 PIC X(50) WVALUE
aooo9s ! WARMING - RECORD WAZ PREVIOUSLY DELETED !
aooiog 10 M3G-7 PIC Xi50) VALUE ;I
Figure 29: Editor window with syntax error
2. Move the cursor onto the pink error message.
3. Press F1.
&P Help - WebSphere Development Studio Client Advanced Ed -0l x|
Search: | |m Search scope: All bopics
Contents & o @l S

% iSeries application developer informati C 0 B 0 L M essag es

% iSeries programming information

2 pemote System Explorer Developer Gu
% WehSphere Application Server Networl
% J25E SDK 1.3.1 APIs

L Application developer information

LNC23530

% Tool developer information
% J2EE SDK 1.3.1 APIs 30

@ Remote System Explorer User Guide Cause
L Support information

Unrmatched right parenthesis. Right parenthesis ignored.

Recovery . . . Remove extra right parenthesis or supply its matching left parenthesis.

Figure 30: Second level help for syntax error

[ Top of Page | Previous Page | Hext Page | Tahle of Contents ]
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This opens a window with second level help for the error.

4. Minimize the Help window.

5. Add the required left parenthesis to correct the error.

6. Move the cursor off the line you just fixed.

The error message is automatically removed from the editor.

Tip: You can toggle automatic syntax checking by using the Windows > Preferences option on the
workbench menu bar and Remote Systems then iSeries then LPEX Editor Parsers and then ILE
COBOL in the Preferences tree view.

Complete the checkpoint below to determine if you are ready to move on to the next exercise.

Checkpoint

1. The LPEX Editor has predefined settings, but also has an associated preference page
containing settings that you can define. (T, F)
2. LPEX Editor preferences are set in the:
A. Preferences window
B. Editor window
C. New wizard
D. Remote Systems view
3. You can configure the LPEX Editor to adopt the keyboard and command personalities of many
popular editors. (T, F)
4. If you want to undo a set of changes made to a file you must use the operation. Name
the operation.
A. Insert
B. Replace
C. Redo
D. Undo
5. You can also cancel the effects of an undo operation by using the operation. Name the
operation.
A. Insert
B. Replace
C. Redo
D. Undo
6. This help is invaluable if you cannot remember the syntax of certain statements. Name the help.
Choose the best answer.
A. Context sensitive help
B. Language sensitive help
C. Display help
D. Field help
7. To receive language sensitive help, press ___ key in an Edit window. Name the key:
F2
F3
F1
F4

Cow>
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10.

11.

12.

13.

14.

15.

16.

If the cursor is an operation code, you receive help for that operation code; otherwise,
you receive help for the current specification.

A. Before

B. After

C. On

D. Off
You use the window to search for an item. Choose the best answer.

A. Search

B. Find

C. Edit

D. Find and Replace
You can search for:

A. A word

B. A partial word

C. A sequence of words

D. A pattern if it follows the rules of regular expression

E. All of the above
The LPEX Editor allows you to ____ or subset your source so that you see only lines containing
a given string.

A. Search

B. Find

C. Sort

D. Filter
To help you navigate quickly through your ILE COBOL source the editor allows you to filter lines
based on the . Choose the best answer.

A. String

B. Line type

C. Line number

D. All of the above
If you would like to search through the members in a source physical file or through the files in a
local directory, you can use the tool. Choose the best answer.

A. Compare

B. Search

C. Find

D. Edit
The tool allows you to compare different versions of a program and find the
differences. Choose the best answer.

A. Convert

B. Migrate

C. Compare

D. Search
There are two ways to compare files. They are Compare tool in the workbench and the Compare
tool in the CODE Editor. (T, F)
Syntax checking can be done either when the cursor leaves each line of source or all at once on
either the currently selected source or on the entire file. (T, F)
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Practice

Given your experience in this exercise using the Remote Systems LPEX Editor, try these new tasks:
Check out how copy, cut and paste your ILE COBOL source. Block mark lines, and try move and
delete operations in your source. Filter source by comments. Set auto-uppercase on. Use the
Development Studio Client for iSeries online help to assist you in these tasks.

What you just did

In this exercise you opened the Remote Systems LPEX Editor and learned about these editor
features: SEU commands, undo and redo operations, language sensitive help, find and replace
option, filter lines by string, filter lines by line type, search files, compare files, and syntax checking.

In the next exercise you will verify your source to ensure you have a clean compile on the iSeries
system. This approach saves you iSeries cycles! And you perform both verify and compile from the
Remote Systems view!
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Exercise 5: Verify and Compile COBOL

In this exercise you verify and compile ILE COBOL in the Remote Systems LPEX Editor. The
program verifying and program compiling are the final steps in compiling a program or module.
When errors are found by either, the iSeries Error List appears. The iSeries Error List is a powerful
tool that manages errors found by verify and compile utilities in the Remote Systems LPEX Editor.
You will become familiar with these tools, the various capabilities of the iSeries Error List and the
COBOL program that you have created.

At the end of this exercise, you should be able to:

¢ Describe the purpose of the Program Verifier

* Invoke the Program Verifier

* Use the iSeries Error List to insert messages and to check that errors were fixed

* Use the iSeries Table view in Remote System Explorer to submit iSeries commands
* Use the Compile utility to select compile options and compile ILE COBOL source

¢ Explain the generated ILE COBOL program called PAYROLLC2

Invoking the Program Verifier

Now you get to play with one of the most powerful and unique features of the Remote System
Explorer — the Program Verifier. Before you compile your code on an iSeries, you can make certain
that there are no errors by invoking the Program Verifier. The verifier checks for semantic (compile)
errors on your workstation so that you can guarantee a clean compile on the iSeries. Think of the
host cycles you'll save. It is especially handy when you are writing code but you are disconnected
from an iSeries. You can do this because Remote System Explorer ported the parsing and checking
code from the iSeries system compilers to the workstation. The iSeries Error List window lists the
errors that are found and their severity, inserts the error messages directly into the source and helps
you to navigate between the errors.

To invoke the verifier:

1. Select Source > Verify from the workbench menu bar for PAYROLLC2

After a moment the verifier will display an iSeries Error List underneath the Editor window.
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%3 iSeries Error Lisk - <TORASOR (=== v
(] Message | Se... | Line | Locakion | _onneckion

@ LMC1904 Program PAYROLL svnkax checked. Errors Found, 40 1 RSELAB1OfQCEBLLESR. .. | s400a

@ LMC1529 Subscript vwalue '14' exceeds maximur occurrenc, ., 30 606  RSELABIO/OQCELLESR... s400a

'EMPMNC' is not unique in this conkext, Use canno,.. 30 302 RSELABIO/OQCELLESR...  s400a

@ LMC1325 'PRCD OF PRISEL-T' not defined name, Stateme... 30 402 RSELAB1OfQCEBLLESR. .. | s400a

@ LNC0407 AT EMD phrase missing from sequential READ, &... | 20 543  RSELAB1Q/QCELLESR...  s<400a

@ LMCD407 AT EMD phrase missing from sequential READ, &,.. 20 134  RSELABIOQ/QCELLESR... s400a

@ LMCD407 AT EMD phrase missing from sequential READ, &,.. 20 299 RSELABIOQ/OQCELLESR...  s400a —

@ LNCD407 AT EMD phrase missing from sequential READ, &... | 20 343 RSELABIO/QCELLESR... | s400a

@ LMCD407 AT EMD phrase missing from sequential READ, &,.. 20 399 RSELABIO/OQCELLESR... s400a _ILI

1 | B

Remote Swstem Details |iSeries Commands Log |Rem|:|te Search |iSeries Error Lisk

Figure 31: Verifier error list

The error list will show you:

1. The error message itself

a M 0D

Fixing errors

The severity
The line number
The source location

The connection name

Next you fix the errors in your source.

To fix an error in your source go the error list:

1. Double-click on the error LNC1463
You are automatically brought back into the Editor window to the line where the error occurred.
The error is caused by EMPNO not being uniquely defined. Go to line 302 where EMPNO is

defined.

EMPNO should really be EMPNO OF EMPSEL- | . Make the change.
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# Remote System Explorer - PAYROLLCZ - WebSphere Development Studio Client Advanced Edition For iSeries
File Edit Source Compile  Mawigate Search  Project Run Window  Help

S-BE&| 8|3 % -%-

|¢llewa-a-

|26 | mmw|Ag AR

|| 1@ Remote Systems v x || weome | Zmstose | Zrermst | Zraveouc B x\
% =H§ '5-;34"' | :D: =§= Ror SDHS — ﬂ-(j;:|li1.1.n]1311 ::— ZIHSEZ‘: 13 char:—ge. - —
., i}\‘, 0552, *ib. prad-svs ;I .
= : o 00030z BF ENPFSEL-I TO US-EMPHC«|
=iy QHLPSYS. *lib.prod-sys
: i 000303 MOVE ACODE OF EMPSEL-I TOQ W3-ACODI
L il QUSRSYS.*ib prod-sys —
=-Mi¥ RSELAB10.*lib.best-cur
I e ——. 000305 IF IND-OFF [ IND-MAINT] AND IND-OFF
CLR1 *pam.dli 0oo30e SET IND-OFF | IND-NOT-FOUND] TO “—
MYCOMPILE. *pgin.cli 000307 MOWE WS-ENPNO TO EMFHNO OF RCEHI
N ooo3os START EMPMST-FILE
PAYROLL, *pam.rple ooo3o0g INVALID KEY
PAVROLLC. *pam.cble ooa3 10 SET IND-CN (| IND-NOT-FOl
0 PAYROLLD. *pgm. chile Sl |;|
PAYROLL . *nam. ke 4| | L

Figure 32: Fixed EMPNO error

The next error is a LNC1326
2. Double click on it. Fix it in the editor.
3. PRCD should really be PRCDE. Make the appropriate change on line 402.

4. Double click on LNC1329. This error is because the array was declared with 4 elements.
Go to line 606.

5. Change the index of the array from 14 to 4.
6. The next errors are LNC0407. You can ignore these errors as they are severity 20.

You are now done fixing all needed error messages.

Saving a Source Member
Now before you loose any of your changes, it's a good idea to save them. Make sure the PAYROLL

member is selected. You then verify the source again to make sure that all the errors are fixed. You
can save the member using one of these ways:

1. The File option on the workbench menu bar
2. The workbench toolbar (click on =i )
3. Press Ctrl+S.

Changes are uploaded to the iSeries.

4. Verify your source again.
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%3 iSeries Error List - <TORAS = <O - x
1D Message | e, | Line | Lacation | Conneckion

@ LMCO407 AT EMD phrase missing from sequential READ, &.., 20 134  R3ELABIOJQCEBLLESR... s400a

@ LNC0407 AT EMD phrase missing from sequential READ, &.., 20 299 | RSELAB10/QCELLESR... | s400a

@ LNC0407 AT EMD phrase missing from sequential READ, &.., 20 345 | RSELAB1O/QCELLESR... | s400a

@ LNC0407 AT EMD phrase missing from sequential READ, &.., 20 399 | RSELAB1Q/QCELLESR... | s400a

@ LNCOo407 AT EMD phrase missing from sequential READ, A... 20 443  RSELABLIOSQCBLLESR...  s400a

@ LNC0407 AT EMD phrase missing from sequential READ, &.., 20 499 | RSELAB10/QCELLESR... | s400a

@ LNC0407 AT EMD phrase missing from sequential READ, &.., 20 545 | RSELAB1O/QCELLESR... | s400a
Remote Syskem Details |iSeries Commands Log |Rem|:|te Search liSeries Etror Lisk

Figure 33: Error list, only severity 10 and 20 are left and can be ignored

Everything should be ok. You are ready to compile the program.
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Invoking a remote compile

The remote compile capability is part of the Remote System Explorer. It gives you a workstation
interface to submit requests to iSeries to compile, bind, or build objects on the host. It allows for easy
access to all the compile options available for all the supported CRTxxx commands.

If you used the local program verifier, then your host compiles should be successful -- no wasted
iSeries cycles. However, if there are errors, the host compiler will send the error information back to
the workstation and they will be loaded into the iSeries Error List window, which behaves just as it
did when you did a program verify.

The default for compiling programs is to submit the compile to the batch job queue. Here in this
exercise you can run the compile interactive.

To change the preferences to compile in interactive:
1. Select the Window > Preferences from the workbench menu bar

g Preferences

-- Flug-In Development ;I Command Execution
[ Profiling and Logging _
H-RAD Command Execution Preferences

Preferences for compiles and user action variables

Object library: *SRCLIE

i Cache

Commang sunsyske

E| LPEX Editor Parsers
L a

COROL Preferences for bakch compiles, commands, and user action wariables

¥ Replace object

ILE RFG Jab description library: I *_IBL

: - RPG[400 Job description: I *LISRPRF

i Ohjects

=) Program Verifiers SBMICE additional parameters: I
- DD3 PRTF

[ ILE COBOL

Figure 34: Change Compile command default
Expand Remote Systems

Expand iSeries

Select Command Execution

De-select the Compile in batch check box

o o bk~ w N

Click OK to get back to the Remote System Explorer perspective

©Copyright IBM Corporation 2003
Course material may not be reproduced in whole or in part
without the prior consent of IBM



Page 72 of 162

Starting the compile

Starting a compile is like using any other command in the Remote System Explorer. The pop-up
menu for source members includes compile submenus. The compile submenus contain several
compile commands for various member types. A compile name is an identifier for a compile
command to run on a remote system. For example, the compile label CRTBNDCBL tells the iSeries
system to create a bound COBOL program. Compile names are only associated with source
member types: members (*MBR) and modules (“MODULE). For this reason, you will only see the
options to compile when you right-click these types of elements. There are two ways to compile:
prompted and non-prompted. Both compile actions invoke a submenu with a list of compile names.
In the Remote Systems view that shows your expanded library RSELABxx:

‘#' Remote System Explorer - PAYROLLCZ - WebSphere Development Studio Client Advanced Edition [

File Edit Source Compile Mavigate Search Project Fum Window  Help
|F-BRe||8|s-%-K-||J||Ca-2-]a6(mmp|
= ME remate Sy + x || ] Welcome |fM5TDSP |fREFM5T |‘:
l% | e =§= G0 To p |08 Column 36 Insert
— : =¥ h-1-F—Fmm——Z————f—-
- s¥s2 *ib.pro f
= & QHLF‘SVS *IFI; Cpem Ut ' WHEN — OTHER
-l @ I Browse with » SET II
L -y, QUSRSYS. it e
=-gi¥ RSELAE10. b,
W . B Rename END-EVALLULTE.
[+ CLCL. *pary C
CLR1 Fpon = P 0600-EXIT
MYCOMPIL 5 Move _EXIT'
PAYROLLY 99 [elete '
PAYROLLC
PAYROLLD Yerify |
PAYROLLG Yerify (Prompk) -
E] COMPARE. Compile . progratm action completed u

- EMPMST,

EVFEVENT. ser Ackions

Compile (Prompt)

| v B+ CRTBMDCEL. ..

-6 MSTDSP, *f

add To iSeries Project, ..

Make fvailable OFfline

Epr CRTCELMOD. .

P wiark with Compile Commands, .

- €TINS
- .y PAVROLLD.cblle
-l QCLSRC. *file. pF-sre
-5y QCMDSRC, *ile.pf-sre
m-E) QDDSSRC. *File. pF-src
==y QRPGLESRC. *file.pf-sre
- =) QRPGLESRCP. *file.pf-src
.= REEMST. *File. nf-rk & hd

Compare With y 7 AT EMD phrase missing from sequen
7 AT END phrase missing From sequen

gperties 7 AT END phrase missing From sequen
69 LNCO407 AT END phrase missing From sequen

i3 LMCo407
i3 LMCo407

AT END phrase missing From sequen
AT END phrase missing From sequen

Figure 35: Select member to compile

Remoke Systern Details | iSeries Commands Log | Remoke
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1. Right-click the PAYROLLC2 member in QCBLLESRC
2. Select Compile (Prompt) > CRTBNDCBL option from the pop-up menu

Compiling Your Source
You will now use the prompt for the CRTBNDRPG command to specify your compile parameters.

All entry fields pertaining to names are already filled in with the correct information.
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-#' Create Bound COBOL Program (CRTENDCBL) 5[

Program: PAYROLLCZ j Mame =
Library: RSELAE10 | Mame

Source File: QCBLLESRC Marme
Library: RSELAB10 | Mame

Source mermber: PAYROLLCZ j Marne

Cukput: FPRINT =]

Generation severity level; 3 0-30

Text 'description’: *SRCMBRTHT j Character value. ..

Advanced Parameters —

Compiler options: j add |
*EVEMTF REmoye |
[Mowe up |

Mave dawn |

Debug view:

-
4| | »

[ aAdvanced ) [T all Parametersi) [T KeywordsiZ)
CRTBMDCEL PGM{RSELABLD/PAYROLLCZ) SRCFILE(RSELAELOfQCELLESRC) SRCMBRIPAYROLLCE) QOPTICM{*EYEMTF) ;I
DEGYIEW(*ALL)

m_l Restore defaulks Cancel |

Figure 36: Prompt for CRTBNDCBL
1. Change the Debugging views parameter to*ALL.

If you want check out the other parameters available, click Advanced
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2. Click OK when you are done.

A window box will show that the compile started.

The progress bar on the workbench (bottom right corner) will indicate that the compile runs
then the error list will be shown, with no errors, just informational messages.

Make sure you have Information Messages selected as a type of message to show. You may have
unchecked this selection in a previous exercise topic.

If you are not sure that the compile was successful:

= Commands Log 7w %

CRTBMDCEL PGMIRSELARLO/PAYROLLCZ) SRCFILE(RSELARLOQCELLESRC) SRCMERI(PAYROLLCE) OPTIONC*ENENTF) ;I
DEGVIEW(*ALL)

Program PAYROLLCZ created in library RSELAEL0 on 11/08/03 at 14:31:37,

Zause , . ... The program has been compiled and translated successfully and placed in the indicated library on the

stated date and time,

>

Command IN:::rmaI j I j Brompt... | R
Remate Systemn Detail Remate Search iSeries Errar List

Figure 37: iSeries Commands Log

3. Click the iSeries Commands Log tab at the bottom of the workbench.

This log shows a list of all commands run on the remote system and the messages that have been

returned for each command.

Submitting iSeries Commands in the iSeries Table view

You can use the iSeries Table view inside the Remote System Explorer to submit commands to the
iSeries. You can run commands in the Commands field beneath the iSeries Table view, and view
messages in the Messages field. After you populate the table, you can enter a command and select
either Prompt to specify parameters and then Run, or just select Run (which prompts and runs the
command as normal). When you run a command, the Messages drop-down field is populated with
the messages from the command. When you select a message, the Details button is enabled. When
you press this button, the message and its help is displayed.

Also note that you can use the iSeries Table view or the Remote Systems view to run commands
and programs. In the iSeries Table view, you can see the properties of all items at the same time;
they are displayed as rows across the table. In the Remote Systems view, you have greater ease of
navigation; you can work from your Library list in the iSeries Objects subsystem, and you can see
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the contents of many items before selecting the one you want to run.

To change your library list:

=€>E~L{>¢3‘ [ = X

B, iSeries Table view
IJse this wiew bo display a list of items, for example, members or objects, ina

table Format similar ko POM, ¥ou can also perform actions against these ikems such as editing
and compiling,

You can populate this view by either clicking the solid black triangle at the top of
this view and selecting Work with = Members or Wark with = Objects, etc., or by
right-clicking a parent object from the Remote Sywstems view and selecting Show in Table,

In general, to perform actions against items, right-click the item for a lisk of options.

i Y
Command IN:::rmaI “HGCURLIB RSELABDS j Prompt. .. | Fun |

j Details, .. | Show Log... |

Messages I

Figure 38: iSeries Table view with command entry
1. Select the iSeries Table View from Window > Show View.
2. Enter in the Command field: CHGCURLI B RSELABxx for example. Note: Use a library that is on

your iSeries system.

3. Click Run.

If you haven’t used the iSeries Table view to show iSeries objects in this view you will get this
error message because the table view is not linked to an active connection.

dF EVFM1025E x|

Q Mo iSeries connection exists For the view. Specify a conneckion using the

view's menu,
Details == |

Figure 39: Error message when using iSeries Table view without active connection

If you get this message, click OK and go to the Remote Systems view
4. Right-click QCBLLESRC
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.@: Remote System Explorer - PAYROLLCZ -

File Edit Source Compile Mavigate Search

H-EE&|H

—_—

EE Remoke S

EE
i}'{., Q532 *b. prod-sys
i}'{., QHLPSYS, *lib.prod-syws
i}'{., QUSRSYS. *ib. prod-sys
--I}z. RSELAE10, *ib, test-cur
- [®] CLC1 . *pam.clle
(& CLR1.*pgm.clle
<[] MYCOMPILE. *parn. o
-[#] PAYROLL. *pam.rpgle
[ PAYROLLC  *pgr. cblle
[ PAYROLLD . *pgr.cblle
Ed [ PAYROLLG. *pgr.rpgle
l E] COMPARE. *File. pf-src
-[E] EMPMST.*File.pf-dta
-3 EVFEWENT *File, pf-da
i & MSTDSP. *file. dspf
ﬁfﬁ MSTDSPZ. *Flle dspf

N | || &

IIIIIH

IEih F
Go To k

J ﬁﬁr . * . ﬁxzﬁ? Refresh

Expand
Collapse

R Rename

Copy

E Paste

+ Move

% Delete

Shy in Table

Zache File Descriptions
Change. ..
Save...

Restore...
User Ackions L4

Add To iSeries Project. ..
Make Available OFfline

Propetties
I | ST O g,

Figure 40: Select Table view to connect it to iSeries

Select the Show in Table option from the pop-up menu

The table view is now populated with the member in the selected source file.

Run the CHGCURLIB command again

The command will run on the iSeries and after completion you will see the completion message
on the bottom of the iSeries Table view.
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B, Fil= RSELAB10/QCELLESRE § =% o ) * X
Marme Tvpe | Attribute | Texk | Skatus |
MipayroLLC CELLE SR with svnkax & verify errors O

M payROLLCP ZBLLE SRC with synkax & werify errors (4

M payroLLCZE ZBLLE SRC with verify errors (4

M pAYROLLD CELLE SRC Mo errars [0]:4

4| | |
Command IN:::rmaI j I j Brompt. .. | Eunl

Messa Zurrent library changed to RSELABDS, j Details. .. | Show Log... |

iSeries Table Wigw ]iSeries Commands Log

Figure 41: Completion message for command
Tip: You can also connect to other than iSeries systems with the Remote System Explorer and

Launch commands for these systems as well, for example, your local system, or LINUX.

Running Commands and Programs
You can run programs and commands from the Remote Systems view or the iSeries Table view in
three ways:

1. Inthe Remote System Explorer communications server job. This is the one you are using

currently.
2. Inabatch job
3. In an interactive job (to test 5250 applications)

Using the first option lets you run the program in the same job as the communications server. With
batch and interactive jobs, you cannot monitor the status as easily, however, you do not tie up your
communications server and you are notified when the program command ends. Batch jobs work as
you would expect and do not require any initial setup. Interactive programs require a 5250 emulator,
so you need to first run a STRRSESVR <connectionName> command to associate the emulator with
a particular connection in the Remote System Explorer communications server.

Starting an interactive connection

To start an interactive connection:
1. Start a 5250-emulation session.

2. Sign on to the iSeries with your User ID and password
Note: Instead of the Enter key, you may have to use the Ctrl key in your 5250-emulation

session.
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=l Session A - [24 % 80] [ 4
File Edit Yiew Communication Actions Window Help
B o 2= = s 2 8 @l
057400 Main Menu
System: TORASOTHM

- e
= O

90.

W oW~ 0O L W =

User tasks

Office tasks

General system tasks

Files, libraries, and folders
Programming

Communications

Define or change the system
Problem handling

Display a menu

Information Assistant options
Client Access/400 tasks

Sign off

Selecti
€E=> STRRSESVR NAME (s400a) RMTLOCNAME (*RESOLVE) _—‘_“HS
_=/

[ i3 [Connected to remote server/host toras07m using port 23

Figure 42: Start Remote System Explorer interactive connection

3. In the emulator, enter the command
STRRSESVR <connect i onNane> RMILOCNAME( * RESOLVE)

The connect i onName parameter is the name of your connection defined in the Remote

Systems view. This associates the interactive job with the Remote System Explorer

communications server. The *RESOLVE keyword will get the IP address of your workstation

and with this information the Remote System Explorer communications server will communicate

with the Remote System Explorer daemon that runs on your workstation.

without the prior consent of IBM
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Note: The connection name is case sensitive and must already be defined in the Remote
System Explorer.

You should see a screen as shown in Figure 43.

1l Session A - [24 % 80] =10l x|

File Edit Yiew Communication Actions ‘Window Help

[y

B | || BE| w8 e[| 2| & @€

IBM RSE Communications Server

Connection Name: s400a

(c) Copyright IBM corp., 2001. All rights reserved.

@ |C0nnected ta remaote serverfhost toras07m using port 23 4

Figure 43: Remote System Explorer connection screen
Note: This screen will stay this way. Don’t wait for it to finish. This session is the interactive

session for interactive commands started from the Remote System Explorer.
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Running the PAYROLLC2 Program
Now you are ready to run the PAYROLLC2 program that you just compiled.

Return to the workbench, and in the Remote Systems view:

@ Remote System Explorer - PAYROLLCZ - WebSphere Development Studi

File Edit Source Compile Mawvigate Search Project

Run window Help

—_—

B -EHE

JJ%&v:tva-vJ@J G-

IT[E Femake S -

i Welcome ! Ams

B

E&@Iﬂ

- [ffl, QHLPSYS. *lib.prod-sys ]
l i]':., QUSRSYS. *lib.prod-sys

L——_I---I}z, RSELAELD. *ib, test-cur

- [ CLC1 *pgmucle

CLR1 . *pgm.clle

MY COMPILE, *pgm.clle
PayYROLL, *parn, rpgle

Bow &035 Z
____+_1rj

oooa04

ooose05

ooOoe06

ooos07

oooa0s

ooos09 [

ooosl0

ooosell

p PE12

PAYROLLG,
7 Show in Table

rifv program

7-Ey COMPARE

T EmpmsT *F
o

-- EYFEVENT.: ir5 Refresh

‘g’fﬂ MSTDSP i Expand

-8 msTpspz ¢ Collapse

brary RSELAELD 2+

I

PRIMST. i
El E] QCELLESRC 4B Rename
[y pavrOl 55 Copy

Py pavRol * Move
- +-E) QULSRCHF 9 Delete

-l

F1
COMPILE
YROLL
YROLLC
WROLLCE

E] QRPGLESRL RuniPrompt)
#- Sy QRPGLESRt  Update...

. [5 oEEmsT [ —

Figure 44: Run program interactive

PN~

Switch to your 5250-emulation session.

m-Ey QMpshe, _———
= £ coossrc, NN Vo

3 Bakch

Locate the PAYROLLC2 program that you created
Right-click the PAYROLLC2 program in the Remote Systems view

Select Run > Interactive from the pop-up menu
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You will see the Start Menu of the payroll program.

= ¥ Session A - [24 % 80] i [=]

File Edit WYiew Communication Actions Window|HeIp

B[ | || | b e[| [t B @€

PRGO1 Time Reporting System 2/08/2003
Maintenance Selection 22:05:53

Enter an X beside the application you want to maintain

Employee Master Maintenance
_ Project Master Maintenance
Reason Code Master Maintenance

© N o u»

9.

10.
11.
12.
13.

Figure 45: Payroll Start Menu

Place an x’ beside Employee Master Maintenance.

Press Enter.

Type 123 for the Employee Number.

Type A for the Action Code to add employee 123.

Press Enter.

Type any information you like about the employee.

Press Enter.

Play in the application as much as you like.
Press F3 to end the PAYROLL program.

Complete the checkpoint below to determine if you are ready to move on to the next exercise.

Checkpoint

The tool checks for semantic (compile) errors on your workstation so that you can
guarantee a clean compile on the iSeries.

1.

Cow>

Compile

LPEX Editor
Program Generator
Program Verifier
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10.

The view identifies each error with an icon that identifies the severity level of the
error, the ID of the error, the message, the severity, the line in the source member that caused
the error, the location of the source member that produced the error, and the connection name.
A. Remote Systems

B. Outline

C. Navigator

D. iSeries Error List

You can sort the entries in the iSeries Error List view by:

ID

Message

Severity

Line

Location

Connection

. All of the above

If you used the local program verifier, then your host compiles should be successful; no wasted
iSeries cycles. (T, F)

A compile command can be run on an iSeries server from the Remote System Explorer, and you
can retrieve error feedback from the compile. (T, F)

Each profile in the Remote System Explorer has a set of source member types, and each source
type has a set of compile names associated with them. (T, F)

There are several ways to compile. They are:

A. Prompted

B. Non-prompted

C. Interactive

D. Batch

E. Remote System Explorer communications server

F. All of the above

The iSeries Table view displays the same information as the view, with the ability to
sort items and perform numerous actions.

A. Remote Systems

B. Outline

C. Navigator

D. iSeries Error List

From the iSeries Table view you can:

A. List and sort libraries, objects, and members

B. Copy, rename, delete, edit, compile and run any item in the view from the pop-up menu

C. Transfer files from one system to another

D. All of the above

You can run programs and commands from the Remote Systems view or the iSeries Table view
in:

@mMMmMOO >

A Remote System Explorer communications server job
A batch job

An interactive job

All of the above

oCow>
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11. The view identifies each error with an icon that identifies the severity level of the
error, the ID of the error, the message, the severity, the line in the source member that caused
the error, the location of the source member that produced the error, and the connection name.
A. Remote Systems
B. Outline
C. Navigator
D. iSeries Error List

12. Interactive programs require a 5250 emulator, so you need to first run a STRRSESVR
<connectionName> command to associate the emulator with a particular connection in the
Remote System Explorer Communications server. (T, F)

Practice

Given your experience in this exercise using the Program Verifier and Compile command, and that
you have your own COBOL source on your own iSeries system try these new tasks: Check out
Compile (Prompt) Work with Compile commands. Assuming you receive errors in your source (add
some errors into your source if you don’ t have any) when you verify your source, choose insert all
error messages into the editor from the Error list. Use the Development Studio Client for iSeries
online help to assist you in these tasks.

What you just did

In this exercise you verified your source by invoking the Program Verifier from the Remote Systems
view. You then reviewed the Error List, fixed some errors and saved the source. Next you ran a
remote compile from the Remote Systems view. You used the iSeries Table view to enter a
command. Finally you started an interactive connection to the iSeries and ran your program all from
the Remote Systems view.

In the next exercise you will use the CODE Designer tool to visually work with DDS source to design
a screen for the COBOL payroll program.
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Exercise 6: Design Screens and Reports

In this exercise you will become familiar with the various aspects of the CODE Designer while
modifying a display file to add a screen.

At the end of the exercise, you should be able to:
* Describe the features of the CODE Designer
¢ Start the CODE Designer

* Open, modify and save a display file

e Addagroup

* Add arecord

* Add, delete and modify various DDS fields

* Verify DDS

* Compile DDS

Using an editor to create and maintain DDS source for your display and printer files can be a
frustrating and difficult task. What would be great is a graphical design tool that let's you design your
screens and reports visually and then generate the DDS source for you. Well, that’s exactly what
CODE Designer does for you.

The CODE Designer helps the novice DDS programmer create screens, reports and databases
quickly and easily without worrying about the details of the DDS language, while at the same time
letting the expert DDS programmer get access to all the features and power of the language. Let’s
now step through each part of the interface and update some DDS as well.

In the workbench, in the Remote System Explorer perspective use the connection that you used in
the exercise before.

Opening a DDS member in the Remote Systems view

To open a DDS file member in the Remote Systems view:

1. Expand the Library List filter or if it is still expanded use it as is
2. Expand the QDDSSRC file in library RSELABxx

3. Right-click MSTDSP member

4. Select Open with > CODE Designer

The member MSTDSP will be downloaded to the workstation and loaded into CODE Designer.
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Viewing the DDS Tree

What you are looking at now is basically an explorer view of the DDS. The DDS Tree view on the
left-hand side of the Designer displays the DDS source in its file, record, field, and keyword
hierarchy. Itis a familiar and intuitive way to see the overall structure of the DDS source and to
navigate through it quickly. Don’t worry if you’re not a DDS expert, we’ll explain everything you need
to know.

The DDS Tree is located on the left-hand side of the CODE Designer window. This view presents
the loaded DDS source as a tree structure, showing the hierarchy of files, records, fields, help
specifications, keys, and keywords in each selected DDS object. The DDS Tree shows groups of
records, which represent the screens or reports you are designing, as peers of the file in the tree
hierarchy.

In this view, you can create groups, and copy or move keys, keywords, fields, and records. If any
DDS object contains an error, the icon representing it displays a red X.

To open selection in the DDS tree to see file-level keywords and the record SELECT:

Click the plus sign beside the folder <Servername>RSELABxx/QDDSSRC(MSTDSP).
Click the plus sign beside the folder File Keywords.

Click the plus sign beside the record SELECT.

Click the plus sign beside the folder Record Keywords.

Click the plus sign beside the field EMESS.

SO
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The DDS Tree now shows you a summary of the file-level keywords and of the record SELECT.

Selecting the DDS object

In the upper right-hand side of the Designer is the Workbook with several different tabbed pages.
The Workbook is the area of the CODE Designer where you design display files or printer files. You
can view this notebook on the top right-hand side of the CODE Designer window. The top page is
called Details and it provides a detailed view of the DDS objects selected by the DDS Tree. You can
view this page in either details mode or list mode.

In details mode, columns display information about each DDS object. You can use this mode if you
want to know more about each DDS object (record, help specification, field, keyword, or keys).

In list mode, the DDS objects appear as columns of named icons. You can use this mode if you want
to see more DDS objects within the page.

In the bottom right-hand side of the Designer is the Utility notebook. It lets you view specific
elements of the DDS source such as errors and selected objects. The notebook contains several
views: Selected DDS page, Error List page, Create keywords page, and Comments page. The
Selected DDS page in the notebook shows the actual DDS source for the currently selected item.
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To work with the DDS record SELECT:
In the DDS Tree click the record SELECT. The Details page lists all the fields in the record
SELECT and summarizes some of their properties. The Selected DDS page shows the DDS for

1.

the SELECT record.

Field | Puosition | Length | Type | S hift | Usage | Sample
APRGOT 2.5 5 Text constant PRGOT
A Time B, System' 2,30 21 Test congtant Time Reparting System
@ *DATE 2.70 B [ ate constant AR ADD
A Mainte..ection’ 3.20 21 Text congtant Maintenance Selection
{5 -TIME 3.70 B Time consta... HH:MM: 55
A Enter ...intain' 6. 14 R4 Text congtant Enter an ¥ beside the application pol
3 EMPAFL 9.25 1 Alphanumenc A - Alphanumenc Both B
A Employ.. enance' 9, 28 27 Test congtant Employes Master Maintenance
1 PRJAPL 10,25 1 Alphanumenc A - Alphanumenc Both B
A Frojec. enance' 10,28 26 Test congtant Project Maszter M aintenance
I R5SMHAFL 11.25 1 Alphanumenc A - Alphanumenc Both B
A ‘Reason. enance' 11,28 30 Text congtant Reazon Code Master Maintenance
EJEMESS 21,16 AN Alphanumerc A - Alphanumerc Output 000000000000000000000C
A F3End of Job' 23.7 13 Text congtant F3-End of Job
1| ]

In the DDS Tree click Record keywords immediately below SELECT. The Details page shows
the current record-level keywords. The Selected DDS page still shows the DDS for the SELECT
record.

In the DDS Tree click the field EMESS. The Details page shows its field-level keywords. The
Selected DDS page now shows the DDS for the EMESS field.

Selected DDG | Create keywords | Web Settings | Comments | Emor st |

(]

EMESS 504 0O 21 16 :I

A
& a0 DSPATE(HI)
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Even this relatively small and simple DDS source member demonstrates how much easier it is to
use the Designer to navigate through your DDS source. The syntax is being interpreted in intuitive
graphical ways making it an ideal tool for learning DDS. But to get orders of magnitude
improvement in your productivity what you really need is to work with your screens and reports in a
WYSIWYG fashion, completely oblivious to the DDS required to make things appear the way they
do. You need the Design Page.

Designing your DDS Screen

You will spend most of your time creating, updating, and designing your DDS screens and reports in
the Design page. The Design pages allow you to design your screens or reports visually using an
intuitive graphical user interface. The Design page shows the DDS source as it would appear on
either a screen (for display files) or a printed page (for printer files). It allows you to design your
application's screens or reports by laying out records and fields in a graphical user interface.

On the Design page, you can easily create, edit, resize, and move DDS objects graphically. Create
new records, fields, and constants directly on the Design page by using the palette push buttons to
the left of the Design area or from the pop-up menus. The toolbar above the Design area allows
quick access to many of the editing features as well as information about the currently selected
object.

Click the tab MAIN_MENU in the workbook.
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In order to understand where MAIN_MENU came from, we need to describe the concept of a group.
A group is simply a collection of one or more DDS records that represent how a screen or report
would be assembled at runtime. It allows you at development time to work with screens or reports as
they would appear when they get assembled by your programs at runtime. To work with groups in
CODE designer you need to tell CODE designer which record formats make up a screen. In this
case we have done this for the screen you see in the design page. We have created a group
MAIN_Menu and CODE designer saved this information in the DDS source in comment lines. Any
groups that you create are persisted as comment lines in the DDS so you can re-use these groups in
subsequent CODE designer sessions.

The groups you create will appear in the tree view as well as in the workbook as a Design page tabs
for each group defined, to allow quick access to each group of records.

Creating Groups from Existing Records

If you are working with existing DDS, you will want to create groups that will correspond to how the
records are being used. In this example you will create a group for the next screen, where the user
selects which employee in the payroll database to maintain. The screen is made up of the record
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format EMPSEL.

To create a group:
1. Scroll to the bottom of the DDS Tree and click the plus sign beside the MAIN_MENU group.
The SELECT record appears as the only record in this group.

P FoMNMMNT
=

[+-48% SELECT r
al [ w

Right-click on the MAIN_MENU group.
From the pop-up menu, select Insert group. A Group Properties notebook appears and a blank

Design page for the group SCREEN1 also appears.
The Properties notebook lets you view and update the properties of the currently selected DDS
object. You can open this notebook from any view, pop-up menu, or menu bar of the CODE
Designer. The properties notebook is modeless. When you change an object’s properties, the
selected object changes immediately.

4. On the Group Properties notebook, click the record EMPSEL in the Available list box and click

the 2] button. For simplicity this is the only record you will add for now. The Design page now
shows us what the record EMPSEL looks like.
5. Name the group by typing over SCREEN1 with EMPL_SELCT

roup properties

Bazics | Styles I

Group IEMF'L_SELI:T
Ayailable Selected
SELECT ERMFSEL
EMPMMNT
FRJSEL
PRJMHT B |
FRSHSEL
RSHMHNT
L |
] I o | 3

6. Click the X in the top right corner to close the Group Properties notebook.
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You are done creating a group. You could now work in the Design page with the record formats
contained in this group. Now you’ll go to create a new record format.

It appears that this is one of those unusable applications where you have to know the employee
number ahead of time instead of being able to browse what is in the database. What we really need
is a subfile. But aren’t those difficult to code, you ask? Not with CODE Designer.

Creating New Screens
To create a new screen on the Design page you need to create a group that will create an empty

page you can work with. To create a new group:
Right-click the new EMPL_SELCT group in the DDS Tree.

2. From the pop-up menu, select Insert group. A Group Properties notebook appears and a blank
Design page for the group SCREEN1 also appears.
Rename the group to EMPL_LI ST and close the Group Properties notebook.
You can create things on the Design page by selecting the appropriate tool from the palette on
the left-hand side and then click on the Design page where you want it to be created. Right now,
most things are disabled in the palette because there is no record in which to create fields. The

only two tools available are Create standard record and Create subfile record. If you leave the

mouse over a button for a second or two, flyover help will appear describing the indicated button.

5. Click the Create subfile record button and then click in the dark gray area. A subfile and a

subfile control record pair are created.

Adding fields to the subfile record
Now you add some columns to the subfile using the Design page. The subfile should be positioned

on row eight. You can use the mouse cursor to specify the location of the part you want to put on the

screen, in this case your subfile.
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Now click the Create named field button ! and then click somewhere on row 8. Six fields
appear in a vertical column. This is because the subfile you created, currently specified a
SFLPAGE (visible list size) of six.

Click the top field and hold the mouse button down and move it to row 8, column 5. Note the

current row and column appear just above the field as you move it.

Move the mouse over to the right edge of the field. It turns into a double-headed arrow.

Hold down the mouse button and move it to the left. The size of the field will be reduced. The
current size will appear just above the field. When the size is 3, let go of the mouse.

The toolbar at the top of the Design page is a very convenient place to monitor and manipulate

the currently selected part.

B RS ER = ] B | orooce ER= (=] ¢
[

'Qﬂ% - [ 7 B ElEl ] BlE Al
E4rc TEname recar

Rename the record from RECCORD1 to EMPLSTSFL and the field from FI ELD1 to OPCCDE by

typing over the text in the drop-down list box.

Click the Color palettel button and select pink to change the color of the field. Click the EI button
to change the usage of the field to input.

Now you will create an additional column in the subfile:
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10.

11

13.

14.
15.

16.

Position the cursor at row 8, column 9. Note that the bottom right of the Designer frame shows
| 83

screen, click the Maximize button in the top right corner. You can use the cursor keys or the

the current cursor position If you can’t see the field with the cursor position on your

mouse to move the cursor.

If you are creating a long field with an exact length, the SDA syntax can be easier. Type:
+((30)

and then press the back arrow (not Backspace!) to select the text you created. Notice

from the Selected DDS page that you have created a text constant containing ‘+O(30)’.

Click Convert string to field @ button on the toolbar or press F11 to convert the SDA syntax
into a character output field of length 30.

Rename the new field to ENAVE using the toolbar. This will show the name of the employee.

. Position the cursor to 8, 41.
12.

Now you will add a field for the employee’s salary. Now wouldn'’t it be better if we could just tell
the Designer what we wanted the number to look like and then have Designer generate all the
cryptic EDTCDEs to make it happen? Type

$666, 666. 66

and then press the back arrow.
Press F11 to convert this field into an output numeric field with comma delimiters, two decimal
positions, a currency symbol and no sign. Look at the Selected DDS page to see what was
generated for you. Impressive!
Rename the field to SALARY and change its color to yellow, using the toolbar.

Your subfile seems compacted to the left. It would be better to space it out evenly. Just select

IIHQ
the field and click 17Pace horzantally] o the far right side of the toolbar. The other alignment buttons

will align fields, left, right, center and top.
Just below the palette there are three spin buttons. The top one, Subfile size, specifies the total

number of entries in the list that will be filled in by the application. The second one, Subfile
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page size, is how many entries appear on the screen. Set the Subfile size to 300 (by over typing)

and the Subfile page size to 9. The Design page is updated accordingly.

Switching between Multiple Records

Now let’s fix up the Subfile control record. The group you created contains 2 records. You can
verify this by dropping down the record drop-down list box in the toolbar:

1. Change the current record by selecting RECORD1CTL from the drop-down list box or click

or press Alt+End. The fields in the subfile still appear so that column heading can be

lined up, but they appear at half-intensity so that they can be distinguished from the fields of the
current record.
2. Rename the record to EMPLSTCTL using the toolbar.

Let's provide a ‘position to’ entry in the subfile control header.
3. Position the cursor at 4, 9 and type:
Position to:

4. Now you need an employee name field. You could create a named field with the right
characteristics like you did in the subfile, or you could create a source reference using the EI

button in the palette or you could reference the original database field using one of the EI @
buttons. But there is an even simpler way. Use copy and paste! In the DDS Tree expand (click
on the plus sign) the EMPMNT record.

5. Click the ENAME field and press Ctrl+C. (The pop-up menu or Edit pull down would give the
Copy menu item as well).
Position the cursor to 4, 23 and press Ctrl+V. Now that was easy!

7. Rename the field to POS_TO.
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Adding field error handling

Let’s put in some error handling for the ‘position to employee name’ field. If the employee name is
not found in the database, the program will turn on indicator 60. An indicator is a two digit variable
(01, 02, 03, ... 98, 99) to signal whether or not certain events have occurred during processing.
Using indicators enables program events to control screen displays. These indicators are set 'on' or
'off' in one part of the program while their status is referenced in another part of the program. By
setting the indicators 'on' or 'off', you can associate fields with indicators to control whether or not a
field will appear on the screen.

The screen should turn the field red, reverse image and position the cursor to it. Now wouldn’t it be
better if we could work something higher level and easier to remember than some arbitrary number
from 1 to 99.

To set indicators:

¥
1. Click on the button on the Design page toolbar (or press F7). The Named indicator sets
window appears.

In the Settings name field, type: Not Found

Click Create.
Mamed indicator sets |
|ndicators

w0l 2 ) el i el v
S S 2 e s e e e S
T2 220 220 42 0 52 B2 72 a2 | 5E
R i el e e e el S R
2 el e e e el
F o 16 &5 & 5 5B e A & 9%
e BT 28 B & e e el ee e
NS S e e i s e s s
R S R e et i s S R
R R D e N e e R R

Checked indicators are: & On & OfF

Settings name: |Nnt found

Ignore all indicators Eemanme |
All indicators are off
Welete |

{1] | gppl_l,ll Ear‘n::ell Help |
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Click the check box next to 60 and click OK. The Not found indicator set is now in effect.
The Design area is shown as if indicator 60 was on and all other indicators were off. The Design

page toolbar shows the current indicator set in the drop-down list box on the bottom left.

i|[Efemrstere =[]«
.Nl:ut fnL}d J

— !Select narned indicataor sets! I
Now select the POS_TO field.

On the toolbar, select the color red and the display attributes reverse image and position

cursor.
(The set of toolbar buttons representing the current display attributes is found just below the

color button). The toolbar should look as follows:

@EMF‘LSTETL JlF‘DS 0 =[=E] El= E v
P ] A= B e .

Examine the DDS generated in the Selected DDS page.

Selected DDS I Comments | Ermor list |

A POS_TO ] B 4 23 |
4 &0 COLOR (RED)

& REFFLD{ RCEMP ENAME *LIEL-EMPHST)

4 90 DSPATR(PR)

4 60 DSPATR(RI)

4 &0 DSPATR{PC)

Notice that all the new keywords were created with a condition of 60. (The DSPATR(PR) was
pasted in with the field originally).
Now let’s try it out! From the Select named indicator sets drop-down list box, select All

indicators are off.
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© = e =] 2 =
..-'1‘-.II indicators are off _j

Wow! This really works!
9. From the Select named indicator sets drop-down list box, select Not found. The field appears

red and reverse imaged.

Accessing field properties

Second to the direct manipulation and the toolbar on the Design page, the easiest and quickest
ways of getting access to the properties of a field, record, or entire file is a Properties notebook.

The Properties notebook lets you view and update the properties of the currently selected DDS
object. You can open this notebook from any view, pop-up menu, or menu bar of the CODE
Designer.

The Properties notebook is modeless. When you change an object's properties, the selected object
changes immediately.

You can get to a Properties notebook from the Selected menu, by pressing F4, or double-clicking on

anything in the DDS Tree or the Details page or Design page.

To open the Properties notebook:

1. Inthe DDS Tree, click the record SELECT and press F4 to see the Record properties. As you
select different items, the Properties notebook will continuously update itself to show you the
properties of the selected item.

2. Now click the *DATE field in the SELECT record. (You may have to move the Properties
notebook out of the way.) This field has a different set of pages describing its properties.

Let's say we had to change the year from 2 to 4 digits. Click the Length of year check box.
Select 4 digits from the drop-down list box. Notice how the sample is updated on the Properties

notebook.
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5. To test the Design page, click on the MAIN_MENU tab in the workbook and look at the upper
right corner of the screen. The date now has 4 digits.

6. Now click on the EMPAPL field in the SELECT record. On the Field Properties notebook click
on the Basics tab. On this page you can change the field’s name, usage, length, type, and

screen position. The other pages give you quick access to other properties for this field.

Field properties

Field Tvpe
[EMPAFL

TioleHEM -

Length — Dlroibice
Total i Program-to-zustem usageh,:,w Columin

| == EEE I ES
[T Continued [CNTFLD) I_EI I—E.I
"Wwidth I 1 E S = =

Drezcription |
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Adding New Keywords

“OK”, you might think, “I can see where CODE Designer helps me manage the visual aspects of my

displays and reports. But | have real work to do. | need access to the full power of DDS. | need to

access keywords.”

To add keywords:

1.
2.

Click EMPAPL field in the DDS Tree.

Press F5 or select Insert keywords from the pop-up menu.

You are taken to the Details page for the EMPAPL field and the Create keywords tab is
selected in the Utilities notebook. This page shows you the subset of keywords that are allowed
for the selected file, record or field and it takes into account the field’s type, usage, shift and what
record itis in. It is very powerful to know exactly what your options are. This information cannot

be quickly ascertained from the Reference manual.

Selected DDS  Create keywords | Eommentsl Error IistI

Inzert I Subzet IAII j
(S pLIAS @ CHECK[ME) s CHECK[RL) Z]COLOR: > S ERRAMSG > S OVRATR

(S BLANKS G CHECK[MF) s CHECK[RZ) G COMP S« ERRMSGID: > S~ OVRDTA

[ CHAMGE S CHECK[M10) e CHECKN) S DFT S« FLDCSRPRG S PITRETAIN

S+ CHECK[4E) G CHECK[M11) S CHECK[YNE] G DFTVAL S |GCALTTYP G BAMGE

[+ CHECK[ER) G CHECK[M10F] S CHGIMFDFT Z]DSPATR > S INDTRT 30 Gt LIES

%+ CHECKJFE] G CHECKM11F] S CHKMSGID S DIP S MEGID: > S ROWRAP

%+ CHECKILC) @ CHECK[RE] s CHRID S« ENTFLDATR s NOCCSID G MENOWHS >

#
3. With the EMPAPL Properties notebook at the Basics page, click the button to change the

field to numeric type. Notice that the list of keywords in the Create keywords page has changed.

4. Click the button to change the field back to alphanumeric. Notice that the list of keywords in
the Create keywords page has changed.
5. Click the ALIAS keyword and press F1.

The DDS Reference help for the ALIAS keyword appears. It is important to mention that the

CODE Designer has lots of on-line help. Press F1 anywhere you want to see help for an item,

icon or notebook. You will get help relevant to what you are currently trying to do. From the

without the prior consent of IBM
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Help menu you can get quick access to the DDS Language Reference as well as several other

useful sources of information.

6. Minimize the Help window

7. Double-click the INDTXT keyword. (You may have to scroll to the right to find it). The keyword
is created with default values which can be changed when you want.

8. Double-click on the INDTXT keyword again. The keyword is created with the same default

values creating a conflict.

Verifying Your Source

You have just added a new record and some new fields to our DDS source. Everything that the

CODE Designer adds to your DDS source is certain to have the correct syntax. Now you need to

make sure that there are no semantic errors. You just introduced one in the last section by creating

two INDTXT keywords describing the same indicator.

To verify your source:

1. From the Tools menu, select Verify file (or click on the button on the main toolbar). The
DDS source is checked using the same verifier that the CODE Editor or LPEX Editor uses. A

message appears on the status line at the bottom of the Designer stating that the verify process

completed with errors. = [ <03400>CODELABXA/ODIA
2. Inthe DDS Tree, there is a trail of red x’s leading to the @ File Kepwords
=43 SELECT
problem. The file icon has a red x, as does the SELECT record, 'E Fecord Keywards
the EMPAPL field and finally the second INDTXT keyword. A PRGOT
FH-A Time R...System’
3. Click the MAIN_MENU tab in the workbook. The EMPAPL field -5 "DATE
T : #-A ‘Mainte..ection’
is highlighted in red. @) TIME
4. Click the Listing tab in the workbook. This page shows you the [+ ‘Enter intain'
- _ _ -3¢ EMPAFL
listing generated by the most recent program verify. A warning o INDTKT
message is buried somewhere in the listing but it's not easy to i O INDTRT [
, 1 | d
find.

5. If there are problems, they will show up in the Error list page in
the Utility notebook. It behaves exactly like the Error list in the CODE Editor or LPEX Editor.
Click the Error list tab.
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6. Double-click the warning DDS7861 in the Error list.

(Press F1 to see detailed help on the message). The Source page appears and the cursor is

placed exactly where the error is in the source. The Source page is a tokenized read-only view

of the current state of the DDS source. Read-only? Wouldn't it be great if you could just clear the

error right here. There are some things that are just plain faster in the editor and many others that

are faster in the visual environment. It would be great to switch between the two modes at the push

of a button. Well, let’s just do that.

Details | MAIN_MENU | EMPL_SELCT | EMPL_LIST Saurce | Listing|

=

.... A ﬂ1Hﬂ.‘2I‘Iﬂ3 e eececceccecececcececeee-Functions++++++++rt+tt+tt+t++t++++++00
A you want to maintain'
A EMPAPL 1 B 9 25IHDTAT{81 'Default")
A INDTRT{81 ‘Default')

DDS7861W Text already assigned to indicator.

| 1>

A 9 28'Employee Haster Maintenance’
A PRJAPL 1n B 18 25
A 18 28°'Project HMaster Haintenance’
A RSHAPL 1 B 11 25
A 11 28'Reason Code HMaster HMaintenance'
4| |

Selected DDS | Comments  Emor izt

i [ =05400-CODELABXXMRDDSSROMSTDSER)

IDSYEETY Text alread igned to indicatar

3k

Switching between Designing and Editing your screen
To switch between the Design mode and the Edit mode:

1.

Click the button or select File-> Edit DDS Source from the Editor menu. You now have
access to the full power of the editor.
Explore the Edit and View pull downs.

Press Ctrl-F to bring up the Find/Replace window

©Copyright IBM Corporation 2003
Course material may not be reproduced in whole or in part
without the prior consent of IBM




Page 103 of 162

4. Type in | NDTXT and click Find.

Editor - Find and Replace

Find INDTXT

=

m
k

p with
|destmy

#~ Replace this occurrence
 Replace, then find next

" Replace all occurrences

FEind I

Replace

Options...

¥ Case sensitive
[~ Pattern match
I Wrap

Cancel

Help

5. Press Ctrl-N to find the next occurrence.
6. Delete the second INDTXT line.

¥ <05400>CODELABXX/QDD SSRCIMSTDSP) - CODE Designer

Wiew  [reert

Selected Tools

Help

M= E3

hd [etrlz T
} mfLu
Cut Chrl+
LCopy Cir+C
Easte [Sir] )
Replace
Dielet Clrl+Del g g
Ezeliceate Et:I:De me++++++RLenf+ TOpELinPosFunctions +H+++0 nts
829 o 6 14'Enter an ¥ beside the application - -
030 Select 4l Chrl+dy you want to maintain’
031 poienial PAPL 1 B 9 25INDTXT(81 *Default) —
832 INDTXT{81 ‘Default”)
833 Find andreplace..  Chl+F 9 28'Employee Master Maintenance’
034 Find newt ShitsF4  J/AFL 1 B 18 25
835 Fogun Chilsll 18 28'Project Haster Haintenance’
836 Lo ection NAPL 1A B 11 25
837 = : 11 28'Reason Code Master HMaintenance'
038 ark line Alt+L 10 16
g39 Locate ¥ Mark character  Al+B DSPATR({HI)
4@ Setguick mark Chil+( Mark rectangle  Alt+R 22 7'F3-End of Job®
a1 p F4 Unmark. Al
gyz Promot Qverlay ltZ REL-RO1MB2 5728-PW1
gy3_ Insert prompt CtilsF4 Maove altsM FTION OF THE EMPLOYEE TO BE
a44 88 A* MAINTAINED - HTENANCE TO BE PERFORHMED
ay5e8 A R ER Cops AT =
Error list |
i DDSTEE1W Text already assigned to indicator.
The verify of '<05400: CODELAEXX/QDDSSRCMSTDSP] completed with erars. j I a
%

Compiling Your Source
Now you will compile the source on the iSeries just as you did in the Remote Systems LPEX Editor:

1.

From the File menu, select Save to save your source to the iSeries.
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2. From the Tools menu select Compile and then select No prompt (or click the E button on

the main toolbar).

3. A message will tell you when the compile is complete. Click OK in the Message window.

If you run the PAYROLL program, you will see the 4 digit year change you made to the opening
screen of the program.

Closing CODE Designer

From the File menu, select Exit.

Complete the checkpoint below to determine if you are ready to move on to the next exercise.

Checkpoint

1. There is a graphical design tool that let’s you design your screens and reports visually and then
generate the DDS source for you. This tool is named:

A.
B.
C.
D.

Page Designer
CODE Designer
Screen Design Aid
None of the above

2. The DDS tree view presents:

A.
B.

C.

D.

The loaded DDS source as a tree structure

A hierarchy of files, records, field, help specifications, keys and keywords in each selected
DDS object

Groups of records, which represent the screens or reports you are designing, as peers of the
file in the tree hierarchy

All of the above

3. Match the item with its correct description.

A.

B
C
D
E
F
G
A.
B
C
D
E
F
G.

Workbook
Details page

_ Utility notebook
. Design page

Properties notebook

- Group
. Indicator

View specific elements of the DDS source such as errors and selected objects
Lists the contents of the currently selected item in the DDS tree

. Contains several different tabbed pages
. For visually designing screens and reports
. A collection of one or more DDS records that make up a single screen or report

Access properties of a field, record, or entire file
Two digit variable to signal whether or not certain events have occurred during processing

4. The Utility notebook contains:
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Selected DDS page

Error List page

Create keywords page

Comments page

. All of the above

5. There are two modes in the Details page: Details and List. The Details mode shows more about
each DDS object while the List mode shows more DDS objects in a page. (T, F)

6. On the Design page, you can easily:
A. Create DDS objects

Edit DDS objects

Resize DDS objects

Move DDS objects

Create records

Create fields

Create constants

. All of the above

7. Grouping records together allows you to work on one record while still seeing the related records
in the background. (T, F)

8. The Properties notebook is modeless. When you change an object’s properties, the selected
object changes immediately. (T, F)

9. The DDS source is checked using the same verifier that the LPEX Editor or CODE Editor uses.
(T, F)

10. You can switch between design mode and edit mode in CODE Designer. (T, F)

11. You can compile sources on the iSeries just as you in the LPEX Editor. (T, F)

moowp

IOMMOOW

Practice

Given your experience in this exercise using the CODE Designer from the Remote Systems view, try
creating a printer report. You can use the physical file specification REFMST in member QDDSSRC
in library RSELABXxx. Take time to explore the fields and information for this physical file. You may
want to refer back to this information as you create your report. When you are familiar with the file
REFMST, you can create your printer file. Use the Development Studio Client for iSeries online help
to assist you in this task.

What you just did

In this exercise you: You used CODE Designer to modify a display file to add a screen. You learned
how to add groups, records and fields. You saved your DDS and then verified it for compile errors.
When you had no compile errors you then compiled your DDS.

In the next exercise you will learn how to debug and test an application running on an iSeries
system.
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Exercise 7: Debug an ILE COBOL Program

The goal of this exercise is to review the Debugger features. You then start the debugger, set
breakpoints, monitor variables, run and step into a program, view the call stack in the Debug view,
remove a breakpoint, add a storage monitor, and set watch breakpoints and all from the Debug
perspective.

At the end of the exercise, you should be able to:
* Describe some of the features of the Debugger
¢ Start a Debug session

* Add and delete line breakpoints

¢ Display a variable

* Change a variable

¢ View the call stack

* Run, Step and Step into a program

¢ Switch between Source and Listing view

* Add a storage monitor

* Add a watch breakpoint

Debugging iSeries programs from the Debug perspective
The Integrated Debugger is a source-level debugger that enables you to debug and test an

application that is running on an iSeries system. It provides a functionally rich interactive graphical

interface that allows you to:

* View source code or compiler listings, while the program is running on the iSeries system.

» Set, change, delete, enable and disable line breakpoints in the application program. You can
easily manage all your breakpoints using the Breakpoints view.

» Set watch breakpoints to make the program stop whenever a specified variable changes.

» View the call stack of your program in the Debug view. As you debug, the call stack gets updated
dynamically. You can view the source of any debug program by clicking on its call stack entry.

« Step through your code one line at a time.

» Step into or step over program calls and ILE procedure calls.

» Display a variable and its value in the Monitors view. The value can easily be changed to see the
effect on the program’s execution.

» Locate procedure calls in a large program quickly and easily using the Programs view.

» Debug multithreaded applications, maintaining separate ctacks for each thread with the ability to

enable and disable any individual thread.
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» Load source from the workstation instead of the iSeries — useful if you don’t want the source
code on a production machine.

» Debug client/server and distributed applications.

The Debugger supports RPG/400 and ILE RPG, COBOL and ILE COBOL, C, C++ and CL.

In the following exercise you will be given the opportunity to learn about some of the basic features

of the Debugger. For the purpose of this exercise you will debug an ILE COBOL/400 program. Don’t
worry if you don’t know COBOL.

Starting the Integrated Debugger
You will be working with the ILE COBOL program PAYROLLD.

Note: PAYROLLD is the same COBOL program as PAYROLLC but without compile errors. You are
using it instead of PAYROLLC in this exercise, to accommodate anyone who decided to skip right to

this exercise without completing the editor exercise.

You can start the Debugger in several ways: directly from the pop-up menu of a program or service
program in the Remote Systems view, or from the Launch Configurations window. Starting directly
from the Remote Systems view doesn’t allow you to specify parameters to be passed to the
program. The Launch Configurations window allows you to modify how the program is invoked and
to specify parameters. To make the exercise interesting you will use CL program CLC1 to call
PAYROLLD and you will pass one parameter to CLC1. This means you will use the Launch
Configurations window.

In the Remote System Explorer perspective, open the Debug Launch Configurations window:
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Create, manage, and run configurations

Configurations:

----- E &ttach to a Running Proc
By Debug a Compiled Applic.

iseries: Debug Inkeractive Application
----- i 11 10h

E;;: izeries: Debug Mulki-Thre

-2 Java Applet

----- £J Java Application

----- @ Java Application in iSerie
----- F4, Java Bean

----- ff_i Remote Java Application
----- & Run-time Workbench

----- Ok server

% S0L] Application

----- Stared Procedure Debug
----- @ wehSphers Application <
% ‘Websphere +5 Applicatic

1| | |

Tt | [Delete |

Figure 46: Start the Launch Configurations window
In the Remote Systems view:
1. Expand the Library list filter, if it isn’t expanded already
2. Expand library RSELABXX, if it isn’t expanded already
3. Select program CLC1 in library RSELABxx

On the workbench toolbar:

4. Click the menu drop-down arrow beside the DEBUG icon as shown in Figure 46

5. Select Debug from the drop-down menu
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The Launch Configurations window appears:

x

Create, manage, and run configurations

LS

Configurations: 6 ame: I CLC1 ¥

----- 53 Attach to a Running Proc

- Fy Debug a Compiled Applic.
_____ (ﬂ) T HTML Seript &pplication What To Debug | I Advanced I :ﬁ Comman I
----- S iSeries: Debug Batch Apr
[—]% iseries: Debug Interactiv .
[ % New._canFiguration Connection: |s4IIIIZIa j NEL'
----- @% iSeries: Debug Job
Eﬁ: iSeries: Debug Mult-Thre

--ZM@ Java Applet —Praogram or Service Program

..... £J Java Application Library: |R5EL.ﬁ.E=1|:| jJ Browse. .. |

----- @ Java Application in iSerie

..... ;:*% Java Bean o Prograrm:

..... *_IU IRk ICLCI jj Browse.,. |
----- [T;{ Remaote Java Application

..... & Run-time Workbench ™ Service Program:

----- AW Script Host Application |
..... & = I jj Erowse, .,
B3 50LI Application

----- Stored Procedure Debug )
----- @ ‘WehSphere Application < IV stepinta
% Websphere v5 Applicatic i

Mew | Celete | Apply | Revert

Debug I Close

Figure 47: Launch Configurations window

In the tree view:
1. Select iSeries: Debug Interactive Application

2. Click New.

The Debug Interactive Application pane appears on the right side of the window:

Figure 48: Debug Interactive Application
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3. Enter the program name CLCL1 in the Name field
4. Select the Update production files check box
5. Click the How To Start tab

On the How To Start page:
|

Create, manage, and run configurations

Configurations: Marne: | CLC1

..... A HTML Script Applcation What ToDebug | HowToStart | advanced | %§ Common |

----- :'ﬁk iSeries: Debug Bakch App

[—]% iSeries: Debug Interactiv
- % Mew_configuration

_____ {3% iSeries: Debug Job CALL PGM{RSELABL0/CLCL) ﬂ

{Eﬁ: iSeries: Debug Mulki-Thre

- Java Applet

----- =) Java Application

----- @ Java Application in iSerie

----- £, Java Bean

----- Ju Uit

----- E Remote Java Application

----- 2 Run-time Warkbench

Comrmand to start application:

----- AW Seript Host Application =i
----- B server

% S0LI Application m |
----- Stored Procedure Debug u

----- t \WebSphere Application =
% \WebSphere v5 Applicatic

KN — i

Mew | Celete | &pply | Rewert |

Debug I Close |

Figure 49: How to Start page
6. Click Prompt.

The Prompt window opens.
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&8 Call Program (CALL) |
Praogram: L1 Mame
Library: RSELAB10 | Name
Pararneters: | ;I
[~

Eemove

[Move up

Mave down

il

[T Adwanced [T all Parameters [T keywords

CALL PGM{RSELAB10/CLCT) PARM(EN) N

| Restore defaulks Cancel |

Figure 50: Prompt window
7. Enter XX’ in the Parameters field

Click Add.

The parameter value will appear in the lower list box.
9. Click OK.

The complete start command for the program appears in the window:
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& Launch Configurations

Create, manage, and run launch configurations

Launch Configurations:

By Debug a Compiled Applic.
----- % iSeries: Debug Batch App
[—]% iSeries: Debug Interactiv
- CLR1
B New_ronfiguration
----- 'ﬁ% iSeries: Debug Job
E&k iSeries: Drebug Mulki-Thre
----- £J lava Application
----- @ Java Application in iserie
----- £}, Java Bean | Applet

----- a Remoke ava Application
----- 2 Run-time Warkbench

----- B server

----- g-l] Stored Procedure Debug
----- @ websphere Application =
% Websphere 5 Applicatic

WWhat To Debug

Command ko start application:

Advanced I :ﬁ COmrmon |

CALL PGMIRSELABRAICLC L) PARMO KR

Prampk. ..

KN I 2
Hew | Delete | apply Revert |
IWI Close |

Figure 51: Ready to debug

10. Click Debug

If an error message like this appears:
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&b EYFC50011 x|

Mo interactive job associated with this connection. Associate an inkteractive
job with this connection o continue.

{ Cancel Y| <<Details |

A request ko run an interactive command or program was received for the RSE
connection s400a, but no inkeractive job is currently associated with this
connection. To associate aninteractive job with this conneckion:

1. Start the iSeties camnmunications dasmon if it is not already running.
Select the pull dawn i ct iSeries - >
Skart

2, Open a 5250 emulator,
3. Run the CL command STRRSESYR MAME(s400a)
4, This will associate the interactive job with this connection, causing this

Figure 52: Error message if interactive session doesn't exist

The Remote System Explorer communications server has been shut down in the meantime. Go to
your 5250 emulator and restart the Remote System Explorer communications server following the
instructions in the message.

You don’t have to cancel the message. It will be removed as soon as the connection between the
Remote System Explorer communications server and the interactive session has been established.

Now the Debug perspective is loaded in the workbench:
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tﬁn Debug - CLC1.CLLE - WebSphere Development Studio Client Advanced Edition for iSeries

" Fil= Edit

Mavigate Search Projeck

Profile  Run  Window  Help

H-HB &S| F|F-% - K- ||[K-|®S|CE-2-]/a6 | =
! = % Debug il (= | Sl | | Y, w o X || 9= Variables
| % =@y Thread:1 {stopped) all J SLOCALYA
----- = L1 LTl CLCl
lg ----- = _CL_PEP:cCLCIL:CLCL
1 = QUMDEXC : QCMDENC : QEMDERC
----- = executeCommand ; QRSEMAIN ; RSEMAILN
----- = main : QRSEMAIN : RSEMAIN bores
----- = _C_pep: QRSEMAIN : RSEMAIN
----- = QUICMD : QUICMD : QUICMD
----- = Ol MMEFLYW 2 O TMEFL W 2 O TMGFL W a (KX
DebugJServers ‘ariables | Breakp, .
ClWelcome | ZMSTDSP | ZREFMST | ZPAYROLC | ZPAYROLLC? E
Fow 11 Column 7 Eeplace Erowse
————+—=——1————+————2————+————3————+————4————+————5————+————E————+——-
7 LOOP: chowar war [ &count) walue [ L&count+1)
g if [&count *lt 100) theni(goto loop)
= CHGVAR VAR [ £MNAME)] VALUE('Claus')
10 chowar var (£1ibh) walue (' RZELAEB' *CAT £nw
14 C L], PEMi£lib/PAYROLLD)
1 Edit. ..
B Console PADEVOOOP Program: CLC1]
———  Run To Locakion
Manitor Expression
Manitor Storage
A Change Text File. ..
. Consaole [Ta  Swikch Yiew »

Figure 53: Debug perspective, adding breakpoint

Now that the program is active on the iSeries and stopped at the first executable statement, the

debugger displays the source.

Setting Breakpoints

You can only set breakpoints at executable lines. All executables lines are displayed in blue.
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The easiest way to set a breakpoint is to right-click on the line in the Source pane:

1. Right-click anywhere on line 11

2. Select Add breakpoint from the pop-up menu.

A dot with a checkmark in the prefix area indicates that a breakpoint has been set for that line. The

prefix area is the small grey margin to the left of the source lines.

To add a conditional breakpoint in the loop when it loops the 99" time:

&P Debug - CLC1.CLLE - WebSphere Development Studio Client Advanced Edition for iSeries

File Edit Mavigate Search Project Profile Run  Window Help

~=1o

BN-BRE||F#-%-%-||F-|®s]ces-2-]|as | mmr|A

E%Dehug = (] |/f~‘3."‘:i‘? ’|=!.§\ Q?O'X %{EHJQ -
% El-@y Thread:1 {stopped) -
I_ 2 O At @ Line [CLCL.CLLE:8]
% _CL_PEP :CLCE i CLCY
- QCMDEXC : QCMDEXC | QCMDEXC
executeCommand | QRSEMAIN : RSEMALN
main : QRSEMAIM : RSEMAIN b
_C_pep : QRSEMAIM | REEMATN
QUICMD : QUICMD : QUICMD
L= OLITMGEL S CLITRMGELY 2 OLITMEE] W h
Debug]Servers Variableﬁgakpmxpres... |Registers | Storage |Storag... |Monitors |M0dules | 4
B
Cwekoms | ZMSTDSP | ZREFMST | ZRAWROLC | ZPavROLLC? [ﬁCLCLCLLE X ] 2= Outling
Fow & Column & Replace Browse AN outline is not available,
g1 f———Z f———n3 g f———=5 6 7 I M-
7 LOoP: Cchoniar S lErOunt] glue (gcount+1) ;I
5] if (&count *1t 100) thenlgoto loog
] CHGVAR VLR [ENANE] VALUE('Claus']
10 chorrar war [ &£lib) walue (' RSELAE' *CAT &num)
L3 11 CALL PGM | £1ik/PATROLLD)
1z e
[
B Console [Process: 025822 /\WDSCLAB10/QPADEYOOOP Program: CLC1] | & * 8 4
: i

Console |Tasks |i5eries Commands Log

Figure 54:Adding a break point and selecting the breakpoint view
3. Right-click on line 8

Select Add breakpoint from the pop-up menu.

Select the Breakpoints tab in the upper right pane of the workbench as shown in Figure 54

In the Breakpoints view:
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BN Ereakpaints

= =m0~

/@ Line [CLC1.CLLE:11]

== Go ko File

add BreaEnint 3

Select Al

Il Enzble

Wariables |Bre [= Disable

ﬁCLCI = Remove
= = Remove Al

ers | Storage |Storag... |Manitors |M|:||:Iules |

5% Outling

an outline is nat available,

Figure 55: Edit breakpoint in Breakpoint view

© ® N o

Right-click on the breakpoint.
Select Edit Breakpoint from the pop-up menu.
Select *SOURCE as the listing view.

Click Next in the Edit a line breakpoint window

You only want to stop in the loop when it executes for the 99th time or more. You can do that by

setting the From field of the Frequency group to 99.
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4F Edit a Line Breakpoink x|

Optional parameters

Make the breakpoint conditional upon the following parameters ﬁ
Thread: IEver';.f j
Frequency

Frarm:
To: Infinity

Every: |1

110

Expression: I

< Back | Mewxt = | Finish I Cancel

Figure 56: Specify condition for breaking

10. Enter 99 in the From entry field
11. Click Finish.

Monitoring Variables
You can monitor variables in the Monitors view. Now you will monitor the variable &COUNT.

In the Source view:
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Cwelcome | #MSTDSP | ZREFMST | ZPAYROLLC | Z/PAYROLLCZ X
Fow & Colwmn 34 Eeplace Erowse
s B T it — L T ] T
7 LOOP: chowar war [&count) wvalue [ gcount4+1l)
L3 =] if Tre Aot o deme oy Joop)
= CHGVLE Bt Flaus'
10 chorar Edit Breakpclint. " RELAE' #*CAT &rnwunm)
i 11 CALL

Remove Breakpoink
Disable Breakpoink
#dd Watch Breakpoink, ..

12

B console [Process: 025622WDSCLABL0/OPADEYOD  Pun To Lacation

Mnnikor Exoress

Manibar Storage

Change Text File. ..

| Switch Yiew r

e |-r-“-|.-.- e T o I

Figure 57: Select variable to be monitored

1. Double-click on the variable &COUNT
2. Right click &COUNT

3. Select Monitor Expression from the pop-up menu.

Monito W @ @b | xJ | % lﬂ

Yariables |Breakp... |Expres... |Registers |Storage |Storag... wrﬂndules | L |

Figure 58: Monitor view with variable &COUNT
The variable appears in the Monitors view.
Its current value is zero.
Tip: If you quickly want to see the value of a variable without adding it to the Monitor, leaving the

mouse pointer on a variable for a second or so will display its value in a pop-up window.
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Now that some breakpoints are set, you can start to run the application:

tﬁ‘-' Debug - CLC1.CLLE - WebSphere Development Studio Client Advanced Edition For i5
File Edit Mavigate Search Projeck  Profile Bun  Window  Help

|F-EBE|8|%H-%-%-|[%-||®F|% -

CIEERIEEE-EAN

L1 ¢ il

= _CLPEP:CLC1:CLCL
= QUCMDERC : QUMDEXC ; QCMDERC
----- = executeCommand ; QRSEMALM : RSEMATRN

=30 i

main : QRSEMAIN : RSEMAIN -
_C_pep : QRSEMAIN : RSEMAIN

QUICMD : QUICMD ; QUICMD

OLTMGEL WY 2 Qi ITRGEL Wy Gl ITRUSEL W hal

Debug | Servers

Figure 59: Resume icon on Debug toolbar

4. Click Resume Efrom the Debug toolbar.

The program starts running and stops at the breakpoint at line 8. (Be patient, the Debugger has
to stop 98 times but because of the condition continues to run until the 99th time.)
Notice in the Monitors view, that &COUNT now has the value 99.

5. Click Resume again.

The program stops at the breakpoint at line 8 again and &COUNT now has the value 100.
6. Click Resume once more so that the program runs to the breakpoint at line 11.

Stepping into a Program

The Debugger allows you to step over ﬂ a program call or step into it . When you step over
a program call, the called program runs and the Debugger stops at the next executable statement in
the calling program. You are going to step into (Step into) the Payroll program.

t#v Debug - CLR1.CLLE - WebSphere Development Studio Client Advanced Edition for iSerie
File Edit Mawigate Search Project Profile Run  Window Help

IF-HREE||B|H -X-%-||&K-||® |- -]

> 0 | | / A @
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Figure 60: Debug toolbar with Step Debug icon

—

1. Click Step into |j}'| on the Debug toolbar. The listing view of PAYROLLD is displayed.
Depending on the option you used to compile the program (*SRCDBG or *LSTDBG for COBOL,
or *SOURCE, *LIST, or *ALL for ILE COBOL), this window displays either the Source or Listing
View.

t#' Debug - PAYROLLD.CBLLE - WebSphere Development Studio Client Advanced Edition for iSeries
File Edit Mavigate Search Project Profile Run Window  Help

—_—

H-HRES||B|-*-F%-|[R-|[®I||Cc-2-]]a6]0

iz :ﬁ;ﬁ Debug o= | | AL @ | A | Y, w x || B Monitors
% Elﬁ- CLC1 [iSeries: Debug Interactive Application] =B B BCOUNT =
EI-- State: «<stoppedx Connection: iSeries (RORASOTM;SOGE)
lg If_l---f‘i‘“ Thread:1 {stopped)
D | R, = PAYROLL : PAYROLLD : PAYROLLD
----- = _Cln_pep: PAYROLLD : PAYROLLD s
""" = CLC1:CLCl:CiCl
----- = CL_PEP:CLCI:CLCH
----- = QCMDEXRC : QCMDEXC @ QCMDERC
----- = pxerutenmmand @ ORSFRATR : RSERATR hd
Debug I SErvers Wariables |Breakp
Cwelcome | ZMSTDSP | ZREFMST | ZFAYROLLC | #PAYROLLCZ W
Fow 151 Column 31 Feplace Erowse
e | et T T
» 150 FROCEDURE DI‘IESIDI‘-I.
151 Edit. .
152 0O00-MATH.
153 fdd Ereakpaint
154 OPEN I-0  AddMWatch Breakpoint. ..
155
B T Location
Monitor Expression
B Console [Process: 025522 "WDSCLABLO)QPADE!  Monitor Starage
«k File...
3 v Show ¥*SOLURCE
4 5 Mis
4

Figure 61: COBOL source view

2. Right-click anywhere in the Source view
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3. Select Switch view > Show *LISTING from the pop-up menu.

1

Cwelcome | #mstose | Zrermst | Zpmmolc | #pavrolice X ]
Fow 392 Column 1 Feplace BErowse

i B e T e . i T— e e e S
392 000152 0000-MAIN. -]
393 000153
394 z0z 000154 OPEN I-0 MSTDSP-FILE —
395 000155 EMPMST-FILE
396 000156 PRIMST-FILE

| B Consale [Process: 025822 '"WDSCLAEL0)QPADEYOOOP Program: CLC1]

4. Page down in the source and take a look at the expanded file descriptions.

You don’t have any /Copy member in our PAYROLL program but these would also be shown in

a Listing view. Switch back to the Source view.

Right-click anywhere in the Source view.

Select Switch view > Show *Source

Listing Call Stack Entries

The Debug view in the upper left pane, lists all call stack entries. It contains a tree view for each
thread. The thread can be expanded to show every program, module, procedure and method that is
on the stack at the current execution point. If you double click on a stack entry you will display the
corresponding source if it is available. Otherwise the message No Debug data available appears in

the Source view.

In the Debug view, expand the stack entry of Thread1 if it is not expanded already, by clicking the

plus sign in front of it.

3‘;’5 Debug ]2 ] | T T4

&

% v x

Elﬁ CLiZ1 [iSeries: Debug Interactive Application]
EI Stake: <stopped: Connection: iSeries (RORASOTM:S066)
E---@JJ Thread:1 (stopped)
= PAYROLL ; PAYROLLD : PAYROLLD
_Cln_pep : PAYROLLD ; PAYROLLD
CLC1 L s CLCL
L PEP L1 LT
QEMDERC  QCMDERC @ QCMDEXC
exerute ammand @ ORSFMATR : BSERATRH

Debug | Servers

Figure 62: Call Stack in Debug view
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It allows you to work with and switch between different programs and/or ILE modules.

Setting Breakpoints in PAYROLLD
Now you add some breakpoints in PAYROLLD.

To add breakpoints:

1. Select PAYROLLD in Thread1.

2. Scroll to line 201

3. Double click the prefix area of line 201.

A breakpoint icon is added to the prefix area of this line to indicate that a breakpoint is set.

4. Repeat the above step for line 206.

5. Repeat the above step for line 218

To view all breakpoints, select the Breakpoints tab from the top left pane. This view shows all
breakpoints currently set in your Debug session.

EE:rE-al::pn:nints = B 2= | JE -
A Line [CLC1LCLLE: 1]

¥ 3ine [CLC1CLLE:S]
A Line [PAYROLLDCELLE:201]
A Line [PAYROLLD,CBLLE: 206]
A Line [PAYROLLD.CBLLE:218]

'-.-'arial:uleslﬁreakp.D]Expres... |Registers | Storage | Storag... |Monitors |M|:u:|ules | k|

Figure 63: Breakpoints view

This is a convenient place to work with breakpoints. You can remove, disable/enable, add or edit a
breakpoint. These tasks are available from the pop-up menu when you right mouse click in the view
area. Double click any entry to show the source where the breakpoint is set.

Removing a Breakpoint
It is also easy to remove breakpoints from the Source view:
1. Right click line 206

2. Select Remove Breakpoint

The blue icon is removed from the prefix area indicating that no breakpoint is set on that line.
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Owelome | Zwmstose | Zrermst | Zpavroie | Zpavrolice X ]
Fow 206 Column 7 Feplace Erouwse
e B e e e A - S
205 ELSE af
» zof IF (PRJAPL OF SELECT-I = 'X'j
zo INITIALIZE PRISEL-O —
20i PERFORM 0400-FRIMST-SELECT THRU 0400-EXIT

I UNTIL IND-OCN{IND-MAINT) OF IND-CH{IND-ECJ)
EL3E

Add Watch Breakpoint, ..

= Console

Fun To Location DADEYOOOP Program: CLC1]

[Manitar Expressian
[Manitar Starage

Kl

Change Text File...
Switch Migw »

Figure 64: Remove breakpoint

Now you are ready to run the PAYROLLG program:

3. Click Resume ﬁfrom the Debug toolbar.

The program waits for input from the 5250-emulation session.

4. Type an X beside the Project Master Maintenance option

5. Press Enter in the emulation session.

The program runs to the breakpoint at line 201.

Monitoring Variables in PAYROLLD
Now let’s monitor variables and change them in PAYROLLD.

In the Source view:
1. Double-click the variable EMPAPL on line 201
2. Right click the variable

3. Select Monitor Expression
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Oweleome | Zwstose | Zrermst | Zpavrouc | Zeavrouce BT X

Row 201 Column 36 Replace Browse
————+————1————+————2————+————3————+=———4————+————5————+————E————+————T————+
197 * reason code maintenace. The programm branches to section
195 * O0500-RE8NMST-SELECT.
199
200 IF IND-0O ND-ERROR)
£ 201 IF @m‘ SELECT-T = 1X')
20z i Edit..,
Edit Breakpoink. ..

Remove Breakpoint
B Console [Process: 025822 \WDSCLAELD)QPADEVOOOR | Disable Breakpoint

Add Wakch Breakpaint., ..

Fun To Locakion

Monitar Expression

Figure 65: Add variable to monitor

4. Click the Monitors tab in the upper right pane
The variable appears in the Monitors view. Its value is blank because you did not select the
Employee Master Maintenance option.

5. In the same way add the variables PRIAPL on line 206 and RSNAPL on line 244 to the monitor.
Variable PRJAPL equals ‘X’ because you did select the Project Master Maintenance option.

In the Monitors view:

Monitars W = % | xl—:‘ | [?"E '5

Wariables |Eireakp... |Expres... |Registers | Storage |Storag... IM-::nitu:urs IMDduIes | L |

Figure 66: Change variable content
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6. Double-click the variable RSNAPL.

The value changes into an entry field.
7. Type in the new value X for the variable.
8. Press Enter.

The variable is successfully changed.

Adding a Storage Monitor
Adding a storage monitor for a variable allows you to view the storage starting with the address

where the variable is located. The storage is displayed in hexadecimal and text format.

Cwelcome | Zwstose | Zrermst | ZpavRouc | ZPavRoLLCE X ]
Bow 219 Column 47 Beplace Browse
e e T e — i el et S = B
214 END-IF o]
215 END-IF
Z2lae END-IF. I
217
L 213 IF IND-ON(IND-MALINT
219 ZET IND-OFF T T
mﬁ [
#dd Breakpoint
B Console [Process: 025822 WDSCLAB10)QPADEYODOP Program:  Add 'Wakch Breakpoint..,
Run To Location
Monitor Expression
< Monitor Starage

Figure 67: Adding a Storage Monitor
In the Source window:
1. Double click the variable | ND- ERROR in line 219
2. Right click and select Monitor Storage from the pop-up menu

A new page is added to the Storage view. The tab shows the name of the variable.
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IND-ERROR : Thread 1

Lddress I = I
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COCZ4C7DG <L
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':l:ll:ql:'_l" Fece able to Monitored Sddre 1 oooooo0g oc
COC4CTD34  conpert Style » [0 0DOOOOOOO o,
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IE Copy MWiew bo Clipboard
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Figure 68: Change storage monitor

Use the scroll bar on the right of the Storage view to scroll down. You can see the content of the
memory.

Right-click in the view area

Select Reset Table to Monitored Address to get back to the starting address.

Right click the view area

Select Remove Storage Monitor to remove the storage monitor.

Setting Watch Breakpoints

A watch breakpoint provides a notification to the user when a variable changes. It will suspend the

execution of the program until an action is taken.

In the Source view go to line 118.

1.

Click somewhere in the Source view and press Ctrl+L. An entry field is added to the bottom of
the source area. In this entry field enter 118 to go to that line.

Double-click variable | ND- TABLE to highlight it.

Right-click and select Add Watch Breakpoint from the pop-up menu.

The Watch Breakpoint window appears. The Expression field is pre-filled with the highlighted
variable | ND- TABLE. By default the Number of bytes to watch is set to zero, which means the

variable will be watched in its defined length.
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4k Add a Watch Breakpoint x|

Required information

Sets a breakpoint to stop execution when data changes at a specific address ﬁ

Address or expression: I {MD-TABLE

Mumber of bykes ko wakch: IIII j

= Bach | Mext = | Einish I Cancel

Figure 69: Add Watch Breakpoint
4. Click Finish.
The watch breakpoint is now set.
5. Click Resume on the Debug toolbar.
The application waits for input from the 5250-emulation session.
In the 5250-emulation session:
Type 123 for Project Code and D (for delete) in the Action Code field.

7. Press Enter.

A message is displayed indicating that the variable | ND- TABLE has changed.
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x

Yariable IND-TABLE has changed in program PAYROLLD, module P&YROLLD,
which is running in job QPADEYODORWDSCLABLD /025822,

Figure 70: Watch breakpoint message
8. Click OK
The program stops at line 307. This line is located immediately after the statement which caused
the variable | ND- TABLE to change.

Closing the Debug Session
1. Click Resume on the Debug toolbar.

The application waits for input from the 5250-emulation session.
Switch to the 5250 emulation session.
Press F3 to end the job.
A message Program terminated comes up.
4. Click OK

Close the Debug perspective by performing the following steps:
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5. Right click the Debug icon lﬁ

@ Debug - WebSphere Deve

File Edit Mavigate 3Search

|5 - HE & || %

Debug |SErvers

Figure 71: Close debug perspective

on the left hand frame in the workbench

6. Select Close from the pop-up menu

Complete the checkpoint below to determine if you are ready to move on to the next exercise.

Checkpoint

1.

wn

You can start the debugger:

A. From the Remote Systems view

B. Launch Configurations window

C. Both

You can only set breakpoints at executable lines. (T, F)
The easiest way to set a breakpoint is to:

A. Right-click on the line

B. Right-click after the line

C. Right-click before the line

D. All of the above

You can change variables and indicators in the:
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10.

From the Remote Systems view

Debug view

Monitors view

Storage monitor

. All of the above

The debugger allows you to:

A. Step over a program call

B. Step into a program call

C. Both

The Debug view lists all call stack entries. It contains a tree view for each thread. (T, F)
You can perform which actions on breakpoints:
Delete

Add

Disable

Enable

Edit

. All of the above

Adding a storage monitor for a variable allows you to view the storage starting with the address
where the variable is located. (T, F)

The Storage monitor supports these display formats:
Hexadecimal and character

Character only

Decimal

All of the above

A and B

moow>

TmMoow>

breakpoint provides a notification to a user when a variable changes. It will
uspend the execution of the program until an action is taken. You can start the debugger:
Watch

Support

Java Exception

Type

¢ >mMoOm»

Cow>

Practice

Given your experience in working with the debugger features, in your own source, try setting,
changing, deleting, enabling, disabling line breakpoints, setting watch breakpoints, displaying and
changing variables and viewing the call stack as you debug. Use the Development Studio Client for
iSeries help to assist you in these tasks.

What you just did

In this exercise you learned about the Debugger features. You then started the debugger, set
breakpoints, monitored variables, ran and stepped into a program, viewed the call stack in the
Debug view, removed a breakpoint, added a storage monitor, and set watch breakpoints and all from
the Debug perspective.
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In the next exercise you will learn how to create filters and actions to manage your iSeries objects all
from the Remote Systems Explorer. In short, you'll see how Remote System Explorer can organize
and integrate your work and make that work easier.
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Exercise 8: Exploring Remote System Explorer

In this exercise you will use the Remote System Explorer perspective to work with the iSeries
objects that you used in the previous exercise. You will also see how easy it is to define filters,
perform actions and define your own actions. In short, you’ll see how Remote System Explorer can
organize and integrate your work and make that work easier.

At the end of the exercise, you should be able to:

¢ Describe Remote System Explorer

* Describe Remote System Explorer, filters, user actions and running commands
* Open Remote System Explorer

¢ Create filters (library, object)

* Change the library filter

¢ Create a user-defined action

* View properties

* Run commands from iSeries Table view

Introducing the Remote System Explorer

Most of the function of the CODE Project Organizer has been replaced by WebSphere Studio
function with the exception of accessing ADM parts.

The Remote System Explorer is replacing PDM (Program Development Manager) on the
workstation. It currently doesn’t have all the function of PDM but will be a full replacement for PDM.

Remote System Explorer allows you to:

»  Simplify your work by giving you quick access to lists of iSeries libraries, objects, members,
IFS files, UNIX files, and local files.

« Use the context-sensitive pop-up menus on these lists to perform actions such as start the
LPEX Editor, CODE Designer, or Integrated Debugger or other common iSeries actions.

» Use the Work with User Actions option to create and manage your own user-defined
actions and have them appear in the pop-up menus.

* Use the command support to increase your productivity by allowing you to enter and repeat

iSeries or local commands without switching to an emulator session.

Creating a library filter
In the Remote System Explorer perspective, you now want to work with specific iSeries objects.
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t@' Remote System Explorer - WebSphere Devel

File Edit Mavigate Search Projeck Rum WWindo

8% - % -]
w
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S
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+-F Work with libraries. ..
o _'f:{> Wark with objects. ..
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]iﬁb Liser libraries

Figure 72: Expand Work with Libraries

L O |

In the previous exercises you have worked with the Library list. Now you will create your own library
filter. Library filters list a set of libraries from your iSeries system in the Remote Systems view. But
first let’s understand what filters are all about.

As a user, you want a flexible user interface that allows for integration between systems. As a
developer, you often need to create libraries, source files, and source members.

The Remote Systems view exposes subsystems, filters, and items specified by each filter. This view
lets you organize your filtered information in an easy-to-understand tree view. You can create filters
for collections of libraries, objects, and source members.

The Remote System Explorer provides iSeries native file system (QSYS) support. The iSeries native
file system lets you query what objects are on your iSeries host and perform actions against those
objects. Filters allow you to easily organize elements within your system. Use the filter function to list
iSeries native file system objects (such as libraries, objects, or members).

An initial library list filter also displays by default. It shows the initial libraries defined in your user
profile on the iSeries host. You can manipulate this list to add or move libraries within the list.

The Remote Systems Explorer supports the Native File System (QSYS) and allows you to query the
objects that are on your iSeries host. Using filters, you can easily organize how you wish to view the
objects within your system. When you access the list by expanding the filter, you will see the Native

File System objects (such as libraries or files) and can perform actions against these remote objects.

If you have been using the Remote Systems Explorer for some time, your workspace may contain
too many filters to easily navigate. In this case, filters can be partitioned into pools, where one pool
contains filters for many different elements. For example, one filter pool may contain filters for your
accounts receivable program while another contains filters for your payroll program.
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The Remote Systems Explorer supports the Native File System (QSYS) and allows you to query the
objects that are on your iSeries system. Using filters, you can easily organize how you wish to view
the objects within your system. When you access the list by expanding the filter, you will see the
Native File System objects (such as libraries or files) and can perform actions against these remote
objects.

First you will need to specify the library you want to work with directly:

1. In the Remote Systems view expand the connection that connects to your iSeries system, by
clicking on the plus sign beside it.

2. Expand iSeries Objects
To create a new library filter:

3. Expand Work with libraries. (You can also right-click iSeries Objects and select New > Library
Filter).
Expanding Work with libraries corresponds to the WRKLIBPDM command, plus creates and
expands the filter in the Remote Systems view. You see this window open:

x

Library Filter =
R , i

Create a new iseries library filker :{>

|

Librar@ jJ Browse, .., |

e,

= Back J Fimist Cancel

Figure 73: Specify a filter string
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You are going to create a filter to specify the libraries you want to work with, so they will show in
iSeries Objects. You want to create a filter that shows all libraries on the iSeries with the name
RSExxxxxx and WDSCxxxxx, xxx being any character.
Note: You may need to select different libraries that appear on your system if libraries with the
above names do not exist.
Specify the first filter string that selects the libraries starting with Remote System Explorer:
1. Type RSE* into the Library field, using the * wild card character.
2. Click Next

The following window will show:

x

Library Filter

Marne the new filker %D
=

Filters are saved for easy re-use. Specify a unique name for this filker, This name will
appeat in the Remaoke Systems view, and will be expandable.

Filter namt: | &l RSE and WDaC libraries p ]

< Back Mext = | [] Cancel |

Specify a name for this filter:

3. Type All RSE and WDSC | i brari es into the Filter name field.

You give your filters a name because the Remote System Explorer saves them for future use, in

opposition to PDM, which does not save filters.
4. Click Finish
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Back in the Remote Systems view under iSeries Objects you will see the new filter expanded,
listing all RSE* libraries. Now you need to add the WDSC libraries:

# Remote System Explorer - PAYROLLD.CBLLE - ¥WebSp

File Edit Mavigate Search Project Run Window  Help

H-HEE || F|s-k-&%-|| ¢

v M |

—_—

s
il 5 QRPGLESRC. *file.pf-src 4 | =
-y QRPGLESRCP. *file. pf-src 2
-5 REFMST. *file. pf-dta
RSMMST, *File. pF-dta

- MYCOMPILE *crnd

“(B) STRCODE *usrspe,usrdft
-, RSELAB10.*lib,best-usr

-, YARLAB10, *lib kest-usr

-, WFLABLO0.*iib, test-usr

-, WSSLABLO. b, test-usr

User libraries

My source files I

: m M [
- I, RSELA GE”;" ,
-l RELA 0 T

m-jf reELa SO T
-, RSELA
-, RSELA
i}"& RSELA, Show in Table
-, RSELA
i}""; RSELA t'é:[; Refresh
-, RELA|  Expand
-, RSELA  Collapse

-, RSELA
Figure 74: Select the Change option

5. Right click the filter All RSE and WDSC libraries and select Change.
The Change Library Filter window appears:

N | gt | 2

|

I+

|

-y
=
i

=8

% Open in Mew Window
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&k Change Library Filter x|

Filter narme: &l RSE and wWhSC libraries
Parent filter poal; Msteckh?tp Filter Pool

Mew Filker skring:

o e
Library: @ Eru:uwse...l
Test | Rewert |

Figure 75: Add second filter string

() |_om |
: 5]

6. Click New filter string in the list box

7. Enter WDSC* in the Library field

Click Create

The WDSC* filter string is added to the list box.
9. Click OK.

You are now back in the Remote Systems view. You will see the list expanded to include your filter.
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EE Remoke Sys v X

| ® &

- i, RSELAE.*lib.prod |
-, REELABMIS1, *fib.prod
-, REELABOLD . *iib. prod
-, REELAEEY. *ib. prod
-, REELABOO.*ib. prod
-, REELABOL. b, test
-, REELABOZ b, test
-, REELABOZ *ib. test
-, REELABO4, b, test
-, REELABOS . *ib. test
-, REELABOG, *ib. test
-, REELABO7 *ib.test
-, REELABOS *ib. test
-, REELABOD, b, test
-, REELABLD. b, test
-, RSESERVER . *ib.prod
-, RSETEST.*ib.prod
-, REEWLILKAM, *lib. best
-, REE100.*lib.prod
-, REE1000.*fib. prod
-, RSE10000.*ib. prod | |
-, RSES000. b, prod
-, WODsC Hib.prod

-, WODSCLAE *lib.prod
-, WDSCLABS. *lib.prod
-, WODsCLABOD, *ib.prod

| - ik WDSCSE]LIF‘.*IiI::.Dde _Iﬂ
4 »

Figure 76: Expanded filter

Now you can work with the libraries directly and can drill down to the object you want to work with
directly.

]l ] ) - - R R < - - - - -

Now create an object filter. Object filters list a set of objects from your iSeries host in the Remote
Systems view.

Creating an object filter
1. Inthe Remote Systems view, expand your connection and then expand iSeries Objects.
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t@' Remote System Explorer - WebSphere Develo

File Edit Mavigate Search Project Run  wWindo
|H-H8 &8 |8 |[%-%- |
=] v x
| &5
'ﬁ}@ =§ Mew Connection -
i BB Local
= =118 s400a
@ Elgn iSeries Objects
TR ; El:%:& Wark with libraries. .,
— e [ Filter created successfully
=¥ Work with objects...
Worl, with members. ..
F-J Library list o
E—]

Figure 77: Create object filter

filter.

Expand Work with objects. You can also right-click iSeries Objects and select New > Object

Note: Expanding Work with objects corresponds to the WRKOBJPDM command.
This will show the New Object Filter window

Now create a filter to show all your source files in your RSELABXxx library.
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Object Filter

Create a new iSeries object Filker

H
il

Library: [ RSELABx B Browse. .. |
Objeck: I * jJ Browse.,
Ohiject bype: I* JJ ml

Object attribuke: I * JJ Browse.,

More Types:= |

= Back I Mexk = I Fimist Zancel

Figure 78: Specify filter string
3. Enter RSELABXX in the Library field
4. Click Browse beside the Object type field
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-#' Select Object Type

Select an object bvpe:

*CMD
FCRIML
*COSD
*CS]
*CSPMAP
*CSPTEL
*CTLD
*CRE
*CROD
*DEYD
*0C
*OTAARA
*OTAG
*EDTD
*ERTTRG

#*
1: FILE )

*ENTTEL
*ENTSRC
*FORMDF
*ETR

#1555
HTG (S

s

12

Figure 79: Select Object Type
Select the *File object type from the list
Click OK.

Back in the Object filter window:
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Object Filter

Create a new iSeries object Filker

Ht
il

Librarsy: I RSELAE:x jj Browse, ., |
Ohiject: I * jj Browse. .. |
Chijeck bype: I*FILE jj Browse, .. i

=14

More Types»= |

Ohiject attribute: I *

Erowse, ..
—

Einish Cancel

= Back I Mext = I

Figure 80: Browse for Object Attribute
7. Click Browse beside the Object Attribute field
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dp select Object Attribute

Select an object attribute:

BSCF3E
CMMF3E
DOrMF

DFU
DFUERZ
DFUMNOTERC

Figure 81: Select filter Object Attribute
Select PF-SRC from the Object Attribute list
Click OK

10. On the Object Filter window click Next.
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x

Object Filter

Mame the new filker %{>
=1

Filters are saved for easy re-use. Specify a unique name for this filker, This name will
appeat in the Remaoke Systems view, and will be expandable.

Filker nam§i My source files j'

< Back | Mext = | Einish I Cancel

Figure 82: Specify filter name

11. Specify the Filter name: My source files

12. Click Finish.
Note: You give your filters a name because the Remote System Explorer saves them for future
use, in opposition to PDM, which does not save filters.

The new object filter now displays in the Remote Systems view under iSeries Objects:

. - »
B ¢ s
- -l WDSCSUBF.*lib.prod |
- B-Jgf, WDSCSUBFCE, b, prod
EE‘%F’ My source Files

[#-15]) COMPARE. *File pF-src
-y QCBLLESRC.*file pF-src
-y QCLSRC #file pf-src

- Ely QUMDSRC, *file pf-src
w-Ey QDDSSRC #file.pf-src
m-E) QRPGLESRC *file.pf-src
-5y QRPELESRCP *file pf-src

hom

Figure 83:0bject filter shows all source files in library
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Now you know how to create filters and tailor your development environment. Filters can also be

specified for non iSeries servers and your local system.

Tip: If you have been using the Remote Systems Explorer for some time, your workspace may
contain too many filters to easily navigate. In this case, filters can be partitioned into pools, where
one pool contains filters for many different elements. For example, one filter pool may contain filters
for your accounts receivable program while another contains filters for your payroll program.

Now you can work with the objects you have in your Remote Systems view like you worked in PDM
with libraries, objects, or members.

Assuming you want to edit the member PAYROLLC in QCBLLESRC you:

1. Expand QCBLLESRC

2. Right-click member PAYROLLC

3. Select Open With > Remote Systems LPEX Editor

This will download the source member and open the editor with this member

After you have edited the member you could save it and then compile it from the Remote Systems
view by using the pop-up menu options on this member.

You can also create your own actions in addition to the default actions.

Creating a user action

In PDM you can create user actions in addition to the pre-supplied system actions. In Remote
System Explorer you can do the same. So what are actions? Actions are host commands that you
define on the Work With User Actions window, and will run against iSeries libraries, objects, jobs,
and members. They can also be defined for folders and files in any remote UNIX, Windows, Linux,
Local, or IFS system.

To create a user action:

1. Expand your iSeries connection and expand iSeries Object.
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Figure 84: Work with user actions

2. Expand Library list filter

Right-click RSELABxx
4. Select User Actions > Work with User Actions

You will see the Work with User Actions window:
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&b work With User Actions

Parent profile: Imsteckh?tp

i o[BS Tember action

E
...... % Ohijeck

Close |

Figure 85: Work with User Actions window

5. Expand New in the list, if it is not expanded already
6. Click Object action

The Work with User Actions window appears
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&b work With User Actions

Parent profile: Imsteckh?tp

E‘ﬁ} e

[y object action
{;h\ Member action
..... % Ob]EEt

Action name:
Comment: opy source File with dat
Command: Ir'-.h:urmal cornmand j
c CRTDLIF‘OBJ' ) :I
-
< _>I_I

Edit... |

Insert variable, .. |

™ Prompt first [ Refresh after [v Show action
™ single selection only [ Invoke once

Browse, ..

Resource bypes For which this action will appear

Defined Types Selected Types
add =

MO

FILE < Remave

FILE_DATA :

FILE_DSPF Edi...

FILE_MERS

FILE_ FRTF  =|

aLL: *

| Creake I Rewvert |

Close |

9|

Figure 86: Create an Object action

Now you want to create a user action that copies a source file with data to a new source file called
QJUNKSRC in the same library.

7. Enter a name for the user action in the Action field: Copy source file

8. Enter a comment in the Comment field
9. Key in the command to execute CRTDUPCBJ
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10. Click Prompt to get the command prompter for this command

tﬁ‘-' Create Duplicate Object {CRTDUPDEI) 5'

Fram object: ‘m ~ | Mame, generic*
Frarn libraty: 0 * | Mame
Object tvpe: aT ) j | Add I

Remove

[Mowve up

Mave down

To library: *FROMLIE j Marme

Mew ohjeck:

il

Duplicate data:

[T advanced v all Parameters [T kewwords
CRTDUPOED OBJEMN) FROMLIE(SL) OBIT¥PECET) NEWOEIQIUNKSRC) |
DATAMYES)
[l
oK Restore defaults Cancel |

Figure 87: Prompt for CRTDUPOBJ command

This is the command you will be running:
CRTDUPOBJ OBJ(&N) FROWMLI B(&L) OBJTYPE(&T) NEWOBJ( QIUNKSRC) DATA( * YES)

11. Enter &N in the From Object field, to indicate to use the name of the selected object in the
Remote Systems view
12. Enter &L in the From Library field, to pick up the library name form the selected object
13. Enter &T in the Object Type field, to pick up the object type from the selected object
14. Enter QQUNKSRC in the New obiject field
To see the additional Duplicate Data parameter:

15. Select the View option on the menu bar of this window
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16.

17.
18.

19.

Click All parameters check box.

Now the Duplicate Data parameter is also shown on the prompt window.

Select *Yes from the pull down menu of the Duplicate Data parameter

Click OK

You will be back at the Work with User Actions window

To refresh the Remote Systems view after the action has been run:

Select the Refresh after check box

Tip: Press Insert variable to bring up a list of valid replacement variables with the explanation of

what they do.
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Figure 88: Limit user action to source files

This user action is only valid for Source physical files. You need to specify this restriction so this

user action will only show in pop-up menus when you right click on a source physical file.

To specify this restriction:

20. Locate the Defined Types box

21. Select FILE_SRC in the list

©Copyright IBM Corporation 2003
Course material may not be reproduced in whole or in part
without the prior consent of IBM



Page 153 of 162

22. Click Add beside the list

FILE_SRC is now one of the selected types. Actually since you only selected this one it is the

only one.

23. Select the Refresh check box to refresh the Remote System view after the user action has been

performed
24. Click Create then Close.

Now, only when you right-click on a source file, will this user action appear on the pop-up menu

selected. For any other object type it will not appear.

Back in the workbench and the Remote System Explorer perspective, give it a try. Note:

Remember to close the PAYROLLC member if you opened it earlier.

e Remate Sy v x || weloms | #ms.. X | ZREFMST | #pa
Bow 1 Column 1 Repl:
- . P - D
000001 A*%%T% DD 1999030
000002 A% §9/04/10 16:28
..... [h PAYROLLC cl e 3 AFEFE TR TR EEREELEES
8 rawoucs, @ | T e
- &y pavROLLCZ, &5 Refresh an
- @ PAYROLLD.cl Expand an
g] QCLSRCI*FI'EIF'F- |: " Atttttttttttttttttt
w-Ep gompsr Al STERSE .
=1 El QDDSSRC. *file.g - STIIE
=-Ey QRPELESRC, *#ile |
w-Ely qrPaLESRCP,*i 55 Copy
-k iseries Commands E Faste
Sy iseries Jobs
% IFS Files + Move B QCELLESRL (4 Members)
E--% karascgm & Delete I Type I Aktrib
Eléﬁj iSeries Objects CELLE SR
j‘f:b work with libraries. .. Showt in Table ] CELLE SR
}:p work with objects. .. Cache File Descriptions > I e
- Work with members, Change... CELLE SRC
=4 Library list Save..,
- (@ Operation cancel Restore. ..

#-gh User libraries

: User Ackions
#-gh &l RSE and WDSC lib

source il

Add Tao iSeries Project. ..
Make Available Offline

g My source files T wiork With User Actions. ..

+-mf iSeries Commands
F+-#h i3eries Jobs

bjects duplicated, 1 objects nak duplics

Propetties(E
1 | | P - ®) iEa |iSeries Commands Log

Figure 89: User action shows in pop-up menu
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25. Locate your filter My Source files

26. Expand the filter, if it is not already expanded
27. Right click on the QCBLLESRC file

28. Select User Actions > Copy source file

The file gets duplicated and the list gets refreshed. Your new source file will show in the list.

T% iseries Commands Log Jow o x

s400a |

?;05:1 OBI{QCELLESRC) FROMLIE(RSELABLO) OBITYPEC*FILE) MEWOBIQIUMNKSRC) DATAYES)
AT Object QIUMNKSRC in RSELAB 10 byvpe *FILE created,

Fd

1 objects duplicated,
ause . ., ., ... &l the objects with supported object bypes specified on the Create Duplicate Object (CRTDUPOE]
ol were duplicated, See law level messages to determing if any objects were not duplicated.
=]

Carmmand INu:urmaI j I j Brampt, .. | R

iSeries Table Hiewm

Figure 90: CRTDUPOBJ command in user action ran successful

You can check the messages of the CL commands you are running in the Remote System Explorer

job by looking at the Commands log in the right hand side bottom pane of the workbench.
To delete the source file QJUNKSRC that you just created:

29. Right-click QJUNKSRC
30. Select Delete from the pop-up menu.

Running commands from the Remote System Explorer
The Command entry is part of the Remote Systems view.

1.

2.
3

Check if you have an iSeries Table View tab in the bottom right pane where your command log
appeared in the previous task.
If you have it click on it
If you don’t have it
a) Inthe Remote Systems view, right-click on my source files filter
b) Select Show in table from the pop-up menu

Now in the iSeries Table view you can run commands on the iSeries server that the table is
connected to. You can run commands in the Commands field beneath the iSeries Table view, and
view messages in the Messages field. After you populate the table, you can enter a command and
select either Prompt to specify parameters and then Run, or just select Run (which prompts and runs
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the command as normal). When you run a command, the Messages drop-down field is populated
with the messages from the command. When you select a message, the Details button is enabled.
When you press this button, the message and its help is displayed.

I, Filter Ty fecks) 256 o o
Marne Type | Attribute ] Text 1 Skatus I Last modified | Created I Size
B qcaLLeshC *FILE PF-SRC 0K February 14, 20... | June 5, 2001 10... 3072
Ejqcisac *FILE PFE-SRC oK February 14, 20.., | May 10, 2001 4:... 9420
Ehqcmosrc *FILE PF-SRC 0K February 14, 20,.. | May 10, 2001 4:... 2457
EhQDDSSRC *FILE PF-SRC QK February 14, 20..,  May 10, 2001 4:... 2088
ELIQRPGLESRC *FILE PF-SRC QK February 14, 20,., | June 5, 2001 10... 1802
[ hQRF‘GSFlC *FILE PF-5RC QK February 14, 20,,, | May 10, 2001 4:,,. 6583
SOLIRCE *FILE PF-5R.C QK February 14, 20,,, | May 10, 2001 4:.,, 6346
i —————

Command INormd @LIBLE ’ j Brom
Messages |Object QIUNKSRC in RSELABuxtype *FILE deleted. | petak.. |
Tasks |iSeries Commands Log |iSeries Source Frompter | iSeries Error List |iSeries Job Log IiSeries Table Yiew

Figure 91: Table view with command entry
In the command field:
4. Key in an iSeries command for example ?ADDLIBLE

The question mark is there to display a prompt screen

Tip: Instead of specifying a question mark you could use the Prompt push button
5. Click Run

The Command Prompt window for the ADDLIBLE command appears:
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tﬁr Add Library List Entry (ADDLIBLE) ﬂ

Libary: | RSELAEOO Mame
Library lisk pasition:
List pasition: *FIRST j
Reference library: Mame
[T advanced [ &l Parameters [ kewwords
ADDLIELE LIB(RSELABOO) ;I
[e

QI I Restore defaults Cancel |

Figure 92: Command prompt window
In the Prompt window:

6. Keyin RSELAB0O. That will add this library to the library list of your Remote System Explorer
job on the iSeries server.
The messages field will confirm the successful completion of this command.
To get to the command history, similar to F9 on the green-screen, press the down arrow on the
Command field.
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"i‘ﬁ_ Filker "My source Files' (7 Objeck =fa -5;§T‘3' ] w =
Marne Tvpe | Attribuke | Text | Stakus

E] COMPARE *FILE PF-3R.C Ok

E] QCBLLESRC *FILE PF-SR.C 0] 4

E] QCLSRC *FILE PF-3R.C Ok

E] CQCMDSRC *FILE PF-SR.C 0] 4

E] QDDSSRC *FILE PF-3R.C Ok

E] QRPGLESRE *FILE PF-SR.C 0] 4

E] QRPGELESRCP *FILE PF-3R.C Ok

Command INDrmaI

=

£
| u Eru:umpt...l Eunl

Messages ILiI:urar';.-' RSELABON added to library

?ADDLIELE ht
CRTDUPOE] OBIQCELLESRC) FROMLIBRSELABYY) OBITYPE(*FILE) r\S_I —Iih':"“"' g

Figure 93: Command history

Tasks |iSeries Commands Lag | Search |iSeries Errar List liSeries Table Yiew

You could also use the iSeries Commands subsystem in the Remote Systems view underneath the

iSeries Objects subsystem and run predefined commands or define your own commands.

Complete the checkpoint below to determine if you have mastered the content in this exercise.

Checkpoint

1. The Remote System Explorer is a replacement for:

A
B

. PDM
. SDA

C. CGU

D
2. A

moowy

. DFU
filter:

. All of the above

Queries objects on your iSeries system

Easily organizes how you wish to view objects within your system
Shows the native file system objects (QSYS)

Allows you to perform actions against these remote objects

3. Expanding Work with libraries corresponds to the:

A
B

. WKRLIBPDM
. WKROBJPDM

C. WRKMBRPDM

D

. All of the above

4. You give your filters a name because the Remote System Explorer saves them for future use.
This is different from PDM that does not save filters. (T, F)

5 Y

oSow>

ou can create:
Library filters
Library list filters
Object filters
Member filters
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E. Job filters
F. All of the above

6. In PDM you can create user actions in addition to the pre-supplied system actions. In Remote
System Explorer you can do the same. (T, F)

7. You can run commands on the iSeries server that the iSeries Table view is connected to. (T, F)

Practice

Given your own libraries on your iSeries system, create a member filter and a job filter. Then move
libraries up, down and within your library list. Finally create a filter pool. Use the Development
Studio Client for iSeries online help to assist you in these tasks.

What you just did

In this exercise you used the Remote System Explorer perspective to work with the iSeries objects
that you used in the previous exercises. You also learned how easy it was to perform actions and
define your own actions. In short, you saw how Remote System Explorer can organize and integrate
your work and make that work easier.
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Maintaining an iSeries application: Introduction to Remote Systems
Explorer Tutorial Summary

See how easy it is to be more productive building new or traditional iSeries applications. The
Remote System Explorer gives you PDM-like access to OS/400 resources. The PDM like table view
meant you could right-click on objects to perform actions that are the same as PDM’s and use a
command line at the bottom of the table just like PDM. There were also user-defined actions that
supported all PDM substitution variables and of course the editing, verifying, compiling, running and
debugging tasks which were tightly integrated with the Remote System Explorer.

You have been introduced to a highly integrated and productive environment, offering a consistent
experience for all development work from RPG to Java. This new generation of tools offered rich
support for exploring the file system, compiling, building, editing, running and debugging. The new
tools allowed you to leverage the classic tools for extremely rich editing and DDS design support.
The Remote System Explorer tools offered a superset of functions over the classic, and feature
frozen ADTS tools. It offered significant productivity and usability gains, support for disconnected
and team development and a common harness for the tight integration of IBM and partner-supplied
tools for server application development. Using these new generation tools also implicitly increases
your skills and will make the transition into new programming models easier, such as the IBM
WebFacing Tool, Web, Web Services, Java and XML.

Step aside ADTS the traditional method for developing and maintaining server-side iSeries
applications. Here comes Development Studio Client which includes new highly integrated and
highly extendible tools for iSeries RPG, COBOL, C, C++, CL and DDS development. These new
tools offered you a development experience that is consistent with the experience for developing
Java, Web, Web Services, and XML applications, lowering the learning curve for all and making your
transition to these e-business application programming models that much easier.
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Exercise Checkpoint Answers
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Notices

This information was developed for products and services offered in the U.S.A. IBM may not offer
the products, services or features discussed in this document in other countries. Consult your local
IBM representative for information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or imply that only the IBM
product, program, or service may be used. Any functionally equivalent product, program, or service
that does not infringe any IBM intellectual property right may be used instead. However, it is the
user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter in this document. The
furnishing of the document does not give you any license to these patents. You can send license
inquiries, in writing, to:

Director of Licensing

Intellectual Property & Licensing
International Business Machines Corporation
North Castle Drive, MD — NC119

Armonk, New York 10504-1785

U.S.A

The following paragraph does not apply to the United Kingdom or any other country where
such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS
IS” WITHOUT WARRANTY OF ANY KIND,K EITHER EXPRESS OR IMPIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OR NON-INFRINGEMENT, MERCHANTABILITY
OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could contain technical inaccuracies or typographical errors. Changes are
periodically made to the information herein; these changes will be incorporated in new editions of the
publication. IBM may make improvements and/or changes in the product(s) and/or the program(s)
described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do
not in any manner service as an endorsement of those Web sites. The materials at those Web sites
are not part of the materials for this IBM product and use of those Web sites is at your own risk.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including
this one) and (ii) the mutual use of the information which has been exchanged, should contact:
IBM Canada Ltd. Laboratory

Information Development

B3/KB7/8200/MKM

8200 Warden Avenue

Markham, Ontario

Canada L6G 1C7
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Such information may be available, subject to appropriate terms and conditions, including in some
cases payment of a fee.

The licensed program described in this information and all licensed material available for it are
provided by IBM under terms of the IBM Customer Agreement, IBM International Program License
Agreement, or any equivalent agreement between us.

Programming Interface Information

This publication is intended to help you to create and manage applications and user interfaces on
the workstation, in a client/server environment. It contains examples of data and reports that are
used in daily business operations. To illustrate them as completely as possible, the examples
include the names of individuals, companies, brands, and products. All of these names are fictitious
and any similarity to the names and addresses that are used by an actual business enterprise is
entirely coincidental. This publication documents General-Use Programming Interface and
Associated Information provided by IBM WebSphere Development Studio Client for iSeries.

Trademarks and Service Marks

The following terms are trademarks or registered trademarks of the International Business
Machines Corporation in the United States or other countries or both:

Application System/400

AS/400

AS/400e

DB2/400

COBOL/400

e-business

IBM

iSeries

Integrated Language Environment

0S/400

RPG/400

VisualAge

WebSphere

Java and all Java-based trademarks are trademarks or registered trademarks of Sun
Microsystems, Inc. in the United States and/or other countries.

Active X, Microsoft, Windows, and Windows NT and the Windows logo are trademarks or
registered trademarks of Microsoft Corporation in the United States, or other countries, or both.
Other company, product, or service names may be trademarks or service marks of others.
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